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Preface

» About This Guide

» Change History

» Communications, Services, and Additional Information
» Field Alerts and Field Notices

» Documentation Feedback

» Document Conventions



Welcome to the Enterprise Chat and Email (ECE) feature, which provides multichannel interaction software
used by businesses all over the world as a core component to the Unified Contact Center Enterprise product line.
ECE offers a unified suite of the industry’s best applications for chat and email interaction management to
enable a blended agent for handling of web chat, email and voice interactions.

About This Guide

Enterprise Chat and Email Administrator’s Guide to Chat and Email Resources introduces you to chat and email
infrastructure within the application. It includes instructions on how to set up template sets, and entry points for
chats and set up aliases, delivery exceptions, blocked file extensions, and workflows for emails.

Change History

This table lists changes made to this guide. Most recent changes appear at the top.

Change

Update of Document

See

Date

June 2022

Listed requirements to configure email
accounts.

“Configuring Email Accounts” on
page 173

Update of Document

April 2022

Note added in reference to adding
specific URLs to communicate with
mailboxes while configuring Email

Accounts.

“About Email Accounts” on page 169

Update of Document

Updated details about adding Post
Chat Attributes for Docked and
Undocked Chat

“Adding Chat and Collaboration Help
Links to Websites” on page 128

August 2021

Update of Document for Release 12.0(1)

Email Accounts chapter added

ES6

“Email Accounts” on page 168

July 2021
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Change

Update of Document for Release 12.0(1)

See

ES1

New call variables for case data
added and the Object field added to
call variable creation.

Setting name changed from “Reason
for Chat Transfer” to “Chat - Reason

for Transfer”

Utility added to Data Masking
capabilities.

New chapter added regarding
integrating applications using APIs

Update of Document for Release 12.0(1)

Steps added for creation of queues

“Call Variables” on page 44

“Chat - Reason for Transfer” on
page 65

“Masking Content of Completed
Activities” on page 42

“Integration Using Chat Messaging
APIs” on page 137

“Creating Queues” on page 49

Date

April 2019

February 2019

Related Documents

The latest versions of all Cisco documentation can be found online at https://www.cisco.com

Subject

Complete documentation for Enterprise
Chat and Email, for both Cisco Unified

Link

https://www.cisco.com/c/en/us/support/customer-
collaboration/enterprise-chat-email-12-0-1/model.html

Contact Center Enterprise (UCCE) and Cisco
Packaged Contact Center Enterprise (PCCE)

Communications, Services, and Additional
Information

» To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.

» To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.

» To submit a service request, visit Cisco Support.

» To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit Cisco

Marketplace.

» To obtain general networking, training, and certification titles, visit Cisco Press.

» To find warranty information for a specific product or product family, access Cisco Warranty Finder.
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https://engage2demand.cisco.com/LP=6097?oid=pcuxa003033
https://www.cisco.com/c/en/us/services/overview.html
https://www.cisco.com
https://www.cisco.com/c/en/us/support/index.html
https://marketplace.cisco.com/home
https://marketplace.cisco.com/home
http://www.ciscopress.com/
https://connectthedots.cisco.com/connectdots/serviceWarrantyFinderRequest?fl=wf

Cisco Bug Search Tool

Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system that
maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST provides you
with detailed defect information about your products and software.

Field Alerts and Field Notices

Cisco can modify its products or determine key processes to be important. These changes are announced through
use of the Cisco Field Alerts and Cisco Field Notices. You can register to receive Field Alerts and Field Notices
through the Product Alert Tool on Cisco.com. This tool enables you to create a profile to receive announcements

by selecting all products of interest.

Sign in www.cisco.com and then access the tool at https://www.cisco.com/@isco/Support/Botifications.html.

Documentation Feedback

To provide comments about this document, send an email message to the following address:

contactcenterproducts_docfeedback @cisco.com

We appreciate your comments.

Document Conventions

This guide uses the following typographical conventions.

Convention Indicates
Italic Emphasis.
Or the title of a published document.
Bold Labels of items on the user interface, such as buttons, boxes, and lists.
Or text that must be typed by the user.
Monospace The name of a file or folder, a database table column or value, or a command.
Variable User-specific text; varies from one user or installation to another.

Document conventions
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Chat and
Email Basics

» Navigating the Enterprise Chat and Email Administration Space

v

Key Terms and Concepts

v

Configuring the System for Chat

v

Configuring the System for Email



This chapter deals with the basics of using the Enterprise Chat and Email Administration space to set up the chat
and email infrastructure.

Navigating the Enterprise Chat and Email
Administration Space

The Administration interface contains multiple areas, each containing different functions that follow a particular
logical process. These areas adjust and update as you navigate through the space and click different options in
the menus. Therefore, when navigating the space, it is important to keep a step-by-step approach in mind.

The image below marks the different functional areas of the space and the order in which they should be
accessed when making any modifications to the application.

hat and Ema Service 'I, LI>$2«"\.‘§&N~:M Business Rules  Language Tools Date Adapters  Business Objects )

RN oo o
"

Entry

Quick ks Enable department settings (g

Quick Responses Masking pattems.
Name
Settings
Email

Deseription
Settings

3 Enable Data Masking 4
o  the

1Options

Administration workspace

These items are displayed as follows:

1. Partition and Department menu: This dropdown menu permits switching between departments or global
space. You can choose manage common objects using the global space or administer individual departments.

2.  Top Menu: The top-level navigation menu. The options contained here change depending on the department
or Partition space selected prior. Clicking an option in the Top menu changes the available options displayed
in the Left menu.

3. Left Menu: Tools and settings contained within the Top menu options appear here. Once you have selected
an option from the Top menu, use this menu to navigate to through the different sections of the application
you can configure.

4. Workspace Area: Upon selecting an option from the Left menu, the space in the center of the screen
refreshes. Any modifications or changes can be made here.
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5. Workspace Toolbar: Permits you to save or cancel any changes that you have made. Note that there may be
other buttons available here, depending on the workspace options you previously selected. Remember to
save your changes before moving on.

In most instances, you start in the upper left section of the desktop to verify that you are working in the correct
department or at the global level. Next, you want to select an option from the Top menu and navigate the Left
menu to select the setting or configuration you wish to adjust. Doing so refreshes Workspace Area, where you
can select the individual functions of the configuration and make your necessary adjustments. When you are
finished with your changes, use the buttons in the Workspace Toolbar to finalize your modifications.

Key Terms and Concepts

For Chat and Callback

» Chat activity: An activity created for a chat session between a customer and an agent. A chat is a real time
interaction between an agent and a customer where they exchange text messages. As part of a chat, agents
can also push web pages to customers. The chat is routed to a queue, and a message is sent to Unified CCE.
Unified CCE processes the activity and assigns the chat to an available agent.

» Callback activities: An activity created for a web callback session between an agent and a customer. In
callback activities, the customer provides personal details (including the phone number) in a customized
web form, and the system automatically generates a call activity and assigns the activity to an agent.

» Delayed callback activities: An activity created for a delayed web callback session between an agent and a
customer. In delayed callback activities, customer provides the personal details (including the phone number
and a delay time, after which he wants to receive the call) in a customized web form, and the system
automatically creates a call activity after the specified delayed time and assigns the activity to an agent.

» Template sets: Template sets consist of HTML, CSS (cascading style sheets) and JS (JavaScript) files. The
CSS files control the look and feel of the customer’s chat and Callback area. The JS files contain the logic
used to render data in the chat and Callback area. Templates are also used to determine the type of
information collected on the web form and used to identify the customer (for example, name, email address,
phone number). You can also compose messages that the customer will see under certain circumstances (for
example, if they request a chat session out of hours). The system comes with two template sets, Aqua for
chats and Rainbow for callback and delayed callback activities. For more details, see “Aqua Chat Template
Sets” on page 72 and “Callback Template Sets” on page 101. Systems upgrading from ECE 11.6 also have
the Kiwi template set for chats. For more details, see “Appendix C: Kiwi Chat Template Sets” on page 242.

» Entry points: An entry point defines the starting point from which customers initiate chat and web callback
interactions. Every help link on a website is mapped to an entry point and each entry point has a queue
associated with it. Different template sets can be used with the same entry point. The queue is used to route
activities to agents while the template set determines the look and feel of the different pages displayed to
chat customers. For more details, see “Chat Entry Points” on page 118.
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For Emails

4

Aliases: Aliases are mapped to email addresses that customers use to contact your company—for example,

support@yourcompany.com or sales@yourcompany.com. They function as entry and exit points for emails
processed by the system. Once an alias is configured and made active, the Retriever Service retrieves emails
from the mail server on which the email address is configured. For more details, see “Aliases” on page 161.

Blocked file extensions: This is a security feature that allows you to selectively prevent certain types of
attachments, which may contain viruses, from entering the system. For example, files with extensions like
.exe, .vbs, .js, etc.

This feature works in conjunction with department settings for email attachments. Using settings, the system
can be configured to block all attachments, block incoming and outgoing attachments, and delete or
quarantine blocked attachments. For more information, see “Blocked File Extensions” on page 178.

Delivery exceptions: This feature allows you to handle emails that bounce back to the system.
Administrators can create a list of words and phrases that may appear in the email subjects and email
addresses of incoming emails. If any of these words or phrases are found in the subject or email address of
emails, they are treated as bounce backs, permanent or temporary. A permanent bounceback indicates that an
irreparable reason (such as invalid email address) caused the email to bounce back. A temporary bounceback
indicates that a temporary reason (such as out of office reply, destination server down, etc.) caused the email
to bounce back. For more details, see “Delivery Exceptions” on page 183.

The application includes 144 common delivery exception scenarios. Other exceptions can be created as
needed. The predefined exception scenarios are listed in “Appendix A: Predefined Delivery Exceptions” on
page 230.

Queues: Queues hold incoming customer service activities such as emails and chat sessions that are waiting
to be assigned to agents. Email activities are routed to queues by workflows, and then either pushed to, or
pulled by agents, depending on the configuration of the queue. Chat and call back activities are also routed
to queues, but by the External Agent Assignment service, and then either pushed to, or pulled by users. A
department can have any number of queues. A single queue can hold multiple activity types like email, chat,
and so on. For more details, see “Queues” on page 47.

Service levels: In order to provide quality customer service, most organizations measure the performance of
their customer service center against established service levels. Using service levels, administrators can set
up response time expectations for different types of incoming customer service interactions like email, chat
and so on. Once defined, service levels are used in workflows to set the due date of activities. Routing
decisions can also be made based on service levels. Service level performance reports are available in the
Reports Console. For more details, see “Service Levels” on page 187.

Transfer codes: While transferring chats, agents can assign transfer codes to chats, which typically identify
the reason why chats are being transferred. For more details, see Enterprise Chat and Email Administrator’s
Guide.

Workflows: Workflows provide a mechanism for applying a sequence of rules on activities. Flexible and
easy to use, they allow administrators to define rules to modify business objects, automate the progression
of activities through the system, raise alarms and send notifications about the status of activities, and so on.

There are three types of workflows:
O Alarm workflows
O Inbound workflows

O Outbound workflows
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For more details, see “Workflows” on page 190.

Configuring the System for Chat

This section describes the objects you need to create to set up your system for chat, callback, and delayed
callback activities.

For Chat Activities

4

An email address (a valid email address on your mail server): Contact your system administrator to get this
configured.

Quick Responses and Quick Links (from the Apps > Chat space): For details, see “Assets for Chat” on
page 62.

Users (from the User Management space): For details, see the Enterprise Chat and Email Administrator’s
Guide.

Queues (from the Business Rules > Queues space): For details, see the “Queues” on page 47.

Templates (from the web server): For details, see Chapter 6, “Aqua Chat Template Sets” or “Appendix C:
Kiwi Chat Template Sets” on page 242.

Entry points (from the Apps > Chat space): For details, see Chapter 8, “Chat Entry Points”.

Transfer codes (from the Business Rules > Codes and Classification space): For details, see the Enterprise
Chat and Email Administrator’s Guide.

Share chat transcripts with other departments (from the Administration Console, Departments node): For
details, see the Enterprise Chat and Email Administrator’s Guide.

Configuring the dynamic messages to be displayed for chats activities. For details, see “Configuring
Dynamic Messages for Chats and Callback™ on page 134.

Enable the website for chat by inserting a code snippet. The “Begin Chat” or “Chat with an agent” link is
here.

For Callback and Delayed Callback Activities

To be able to set up your system for these activities, you need to create the following objects:

4

Users (from the User Management space): For details, see the Enterprise Chat and Email Administrator’s
Guide.

Queues (from the Business Rules > Queues space): For details, see the Chapter 4, “Queues”.
Templates (From the web server): For details, see Chapter 7, “Callback Template Sets”.
Entry points (from the Apps > Chat space): For details, see Chapter 8, “Chat Entry Points”.

Enable the website for callback by inserting a code snippet.
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Data Masking for Chat

Data masking allows businesses to ensure that sensitive information, like credit card numbers, Social Security
Numbers, bank account numbers, and so on, is not transmitted from the system to the customers and vice versa.
If the customer and agent do add any sensitive data in the email content and chat messages, all such data is
masked before it is displayed to customers and agents and before it is stored in the system.

For chat, you have the option to allow customers to disable data masking for selective messages. The Off-the-
record feature allows agents and customers to exchange sensitive information as data masking rules do not apply
to these messages. Any information exchanged while off-record is not stored in the system. Off-the-record
conversations can be started and stopped only by customers.

For details about setting up data masking, see “Data Masking” on page 28.

7\ Important: Data masking rules also apply to the message typed by customers in the callback
'Y request form.

Secure Chat

Secure Chat allows chat entry points to transfer customer context information from the company website to the
application through SAML. This allows website visitors who are already recognized on the company website to
use a single sign-on enabled entry point to chat with an agent without having to provide redundant information.
Entry points can be configured to allow website visitors to log in to secure chat upon initially accessing the chat
entry point, or to allow agents to initiate the authentication process mid-chat.

To enable secure chat, the chat templates must be configured, an entry point must be configured to allow secure
chat, and customer single sign-on must be configured.

» To learn how to enable secure chat for aqua chat templates, see “Enabling Auto-Login” on page 87 and
“Configuring Aqua Templates for Customer SSO” on page 88.

» To learn how to enable secure chat for kiwi chat templates, see “Enabling Auto-Login” on page 257 and
“Configuring Kiwi Templates for Customer SSO” on page 257. (available only in systems upgrading from
ECE 11.6)

» For details about configuring entry points to use secure chat and mid-chat authentication, see “Adding Chat
and Collaboration Help Links to Websites” on page 128.

» For more details about configuring Chat Customer Single Sign-On, see Enterprise Chat and Email
Administrator’s Guide.

Chat Attachments

Customers and agents can send files to each other during a chat. Once configured by an administrator, customers
and agents can browse to a file and attach it to their chat messages. Customers can also drag and drop files into
the chat text editor. For more details about the types of files that can be allowed or blocked, or how to set up chat
attachments, see the Enterprise Chat and Email Administrator’s Guide.
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Services for Chat and Collaboration

Make sure that the following services are configured properly and are in running state. For details about
configuring these services, see the Enterprise Chat and Email Administrator’s Guide.

4

External Agent Assignment Service (EAAS) (For integrated emails, integrated chats, callback, and

delayed callback activities only.)

External Agent Messaging Service (EAMS) (For integrated emails, integrated chats, callback, and delayed

callback activities only.)

lIS Configuration

If your configuration is using Secure Chat, Docked Chat, or Cobrowse, the X-Frame-Options of the response

headers may need to be reconfigured.

Settings for Chat and Collaboration

Make sure that the following partition and department level settings are configured properly. For details about

these settings, see the “Assets for Chat” on page 62.

Settings at the Partition Level

4

4

»

Chat Watchdog Interval (Seconds)

Starvation Time for Activities

Chat Auto-Pushback Settings

O  Enable auto-pushback of chats

o  Expiry time for auto-pushback for chats (minutes)

O  Make agent unavailable on auto-pushback of chats

Settings at the Department Level

4

4

4

Chat - Agent availability choice enabled

Chat - Agent chat message maximum length

Chat - Auto block check

Chat - Auto spellcheck

Chat - Daily service level sample set definition

Chat - Disable typing area and page push area on customer exit
Chat - Display timestamp in agent chat console

Chat - Display timestamp in completed chat transcript

Chat - Disable typing area and page push area on customer exit

Chat - Enable Sound Alert
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Chat - Force activity categorization

Chat - Force resolution code

Chat - Inbox sort column

Chat - Inbox sort order

Chat - My Monitor - Activity refresh interval (seconds)
Chat - SLA for Response Time (seconds)

Reason for chat transfer

Configuring the System for Email

The following items must be configured before agents can begin replying to emails from customers:

4

Email aliases: These map to email addresses to which customers send emails. For details, see “Aliases” on
page 161.

Inbound workflows: Process the emails. See “Workflows” on page 190 for details.
Queues: A holding location for emails waiting to be routed to agents. See “Queues” on page 47 for details.

Users: Agents who reply to emails, supervisors who monitor and manage agents, and administrators who
create and administer workflow and routing. See Enterprise Chat and Email Administrator's Guide for
details.

Important Tasks on the Mail Server

Before you start configuring aliases, make sure that the following objects have been configured and are ready to
be used:

4

An email address with credentials on the company mail server.

Along with the email address, make sure you have the following details. You would need this information to
configure the alias.

For the incoming email server:

O  The server type, either POP3 (Post Office Protocol 3) or IMAP4 (Internet Message Access Protocol).
O  The server name or IP (Internet Protocol) address.

O A user name and password for the server.

For the outgoing email server:

O The server type, either SMTP (Simple Mail Transfer Protocol) or ESMTP (Extended Simple Mail
Transfer Protocol).

O The outgoing server name or IP address.

O A user name and password for the outgoing server (only if using ESMTP).

Refer to your IT department’s policies and decide whether or not to use SMTP if ESMTP authentication
fails.
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Configuring Spam Filters on Mail Server

You may wish to block emails from certain email addresses or domains from being processed by the system. To
do this, spam filters must be established on the IMAP or POP3 mail server to handle spam emails coming in the
system. Refer to your IT department for more information.

Data Masking for Email

Data masking allows businesses to ensure that sensitive information, like credit card numbers, Social Security
Numbers, bank account numbers, etc. is not transmitted from the system to the customers and vice versa. If the
customer and agent do add any sensitive data in the email content and chat messages, all such data is masked
before it is displayed to customers and agents and before it is stored in the application.

Data masking is the process of scanning the content for sensitive information and applying regular expressions
to mask the sensitive information and hide the original data with characters, like, * ~ #. Data is masked using
patterns, which are defined using Javascript and Java regular expressions.

Masking patterns are defined by the partition administrators and then are applied to the email and chat channel.
The partition administrator can decide to manage the channels for all departments at the partition level, or can
allow each department to manage their own configurations.

For email, you have the option to enable data masking for incoming and outgoing emails.

For details about setting up data masking, see “Data Masking” on page 28.

Services for Emails

Make sure the following services are configured properly and are running. For details on setting up these
services, see Enterprise Chat and Email Administrator’s Guide.

» Retriever service Gets incoming emails from configured aliases and parses them.

» Dispatcher service: Sends outgoing emails out of the system.

» Workflow cache service: Maintains information about objects used in workflows.

» Workflow engine service: Applies workflows on emails to automate their routing and handling.
» External Agent Assignment Service: Routes activities to agents integrated with Unified CCE.

» External Agent Messaging Service (EAMS): Initiates and maintains the channel of communication with
the Agent Peripheral Gateway (PG)/ARM interface of Unified CCE. Responsible for reporting all agent
events.

Settings for Emails

Make sure that the following global and department level settings are configured properly. For more information
about these settings, see “Assets for Email” on page 145.

Settings for Delivery Exceptions

These settings are available at the global level.
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4

Default SMTP Server Settings

Settings at the Partition Level

4

4

»

Alarm service delay
Auto response number

Auto response time (minutes)

Settings at the Department Level

4

»

»

Activities to pull first

Activity type for auto pushback

Include original message for auto acknowledgement
Maximum activities to pull at a time

Personalized activity assignment

Configuring the System for Email
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About Data Masking

Data masking allows businesses to ensure that sensitive information, like credit card numbers, Social Security
Numbers, bank account numbers, and so on, is not transmitted from the system to the customers and vice versa.
If the customer and agent do add any sensitive data in the email content and chat messages, all such data is
masked before it is displayed to customers and agents and before it is stored in the system.

Data masking is the process of scanning the content for sensitive information and applying regular expressions
to mask the sensitive information and hide the original data with characters, like, * ~ #. Data is masked using
patterns, which are defined using Javascript and Java regular expressions.

Data masking is available for emails and chats.

About Patterns

Patterns are definitions of data masking rules that you apply to the content of emails and chat messages to hide
sensitive data. Patterns are defined using JavaScript and Java regular expressions. In the pattern definition, you
also define the character to use for replacing the matching data (for example, *, X, #). You can enable the Luhn
algorithm for masking credit card numbers. This algorithm distinguishes the valid credit card numbers from a
random sequence of numbers.

You can either create a pattern from the user interface, or you can create patterns in an XML file and import the
file using the import feature.

Creating Patterns

To create a pattern:

1. In the partition-level Top menu, click the Security option.

2. In the Left menu, navigate to Data Masking > Patterns.

3. In the Patterns space, click the New button.

4. On the New Pattern page, under the General tab, set the following fields:
O Name: Type a name for the pattern.

O Description: Provide a description for the pattern that explains what type of masking is done by the
pattern.

O Active: Click the toggle to make the pattern active when it is ready for use. Only active patterns can be
applied to channels. Once a pattern is made active and used in channels, it can be made inactive only
after the association from the channels is removed.

5. Click the Masking Pattern tab and set the following:

o Masking Character: From the dropdown list, select the character to be used to mask the data. The
default value is *. Options available are: *, -, #, X, Xx.

o Javascript Regular Expression: Provide the Javascript regular expression for masking.
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o Java Regular Expression: Provide the Java regular expression for masking.

O  Number of characters to unmask from right: Provide the number of characters, from the right, that
should be ignored while masking. For example, if you are masking the social security number and you
do not want to mask the last 4 numbers of the SSN, the SSN shows as *****3545

O  Number of characters to unmask from left: Provide the number of characters, from the left, that
should be ignored while masking. For example, if you are masking a 10 digit account number and you
do not want to mask the first 4 numbers of the account number, the account number shows as

O Apply Luhn Algorithm: Click the toggle to apply the Luhn algorithms to credit card numbers.
Edit Pattern : Visa Credit Card
General Masking Pattern

Masking character # w

JavaScript Regular Expression

4(((\r)2\n):
Java Regular Expression o ;
e = {0,2)[0-9]
\nH0.2}[0-91}41}3} hd
Number of characters to unmask 0
from left
Number of characters to unmask A L\\)
from right
Apply Luhn's algorithm [ @)

Create a pattern

6. Click the Save button.

Creating Patterns in XML File

While preparing a file for importing patterns, keep in mind:
» Only XML files can be used to import patterns.
»  You can name the file anything you want.
» Elements should be defined in the order specified in the pattern file exported from the application.

» Elements and values of elements in the XML file are case sensitive.
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» For user created patterns, the isDefault element should be always set to no. Likewise, for default patterns,
the isDefault element should be always set to yes.

» If you are importing a pattern that already exists in the system, your existing pattern will be overwritten by

the import process.

The following table lists the names of the properties as they appear in the file and on the Ul For the description
of each field, see “Creating Patterns” on page 29.

Name on the Ul

Name in the file

Name name
Description description
Active isActive
Default isDefault

Masking character
Javascript regular expression

Java regular expression

maskingCharacter
javascriptRegularExpression

javaRegularExpression

Number of characters to unmask from right
Number of characters to unmask from left

Apply Luhn algorithm

numOfCharsToUnmaskFromLeft
numOfCharsToUnmaskFromRight

applyLuhnAlgorithm

A sample pattern looks like:

= new_pattem xml l

<?xml wversion="1.0" encoding="UTF-8" standalone="yes"?2>

E(patterns xmlns="http://bindings.egain.com/security/masking">

<pattern>

<ishctive>yes</islActive>
<isDefault>no</isDefault:

<name>Pattern for masking Visa, MasterCard, and American
Express credit card numbers</name>
<description>Single pattern for three cards</description>

<maskingCharacter>*</maskingCharacter>

<javascriptRegularExpression>
((2:(2:4\d{3}) | (2:5[1-51\d{2}) |6(?:011|5[0-9]1{2})) (?:-2|\0D40?)
(2:\d{4} (2:-2|\0402)) {3} (?:3[4,7]1\d{2}) (?:-2?|\040?)\d{6} (?:-?
I1\040?)\d{5})</javascriptRegularExpression>
<javaRegularExpression>
((2:(2:4\d{3}) | (2:5[1-51\d{2}) |6(?:011|5[0-9]1{2})) (?:-2|\0D40?)
(2:\d{4} (2:-2|\0402)) {3} (?:3[4,7]1\d{2}) (?:-2?|\040?)\d{6} (?:-?
I1\040?)\d{5})</javaRegularExpression>
<numCfCharsToUnmaskFromLefr>4</numCfCharsToUnmaskFromLeft>
<numOfCharsToUnmaskFromRight>4</num0fCharsToUnmaskFromRight>
<applyLluhnaAlgorithm>yes</applyluhnhlgorichm>

</pattern>

-</patterns>

A sample XML file
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Exporting Masking Patterns

Patterns can be exported in XML format to share them across installations or if you wish to edit the patterns
through an XML file. All the patterns configured in the system will be part of the exported XML file.

To export patterns:

1. In the partition-level Top menu, click the Security option.

2. In the Left menu, navigate to Data Masking > Patterns.

3. In the Patterns space, from the More button, select Export patterns.

The patterns file is downloaded on your machine.

Importing Masking Patterns

Only XML files can be used to import patterns.

To import a pattern:

1. In the partition-level Top menu, click the Security option.

2. In the Left menu, navigate to Data Masking > Patterns.

3. In the Patterns space, from the More button, select Import patterns.
4

In the Import pattern window, provide the location of the XML file. Click OK.

Import pattern )¢

File Name and Path | Browse |

| carcel J Upload |

Provide the location of the file

The system notifies when the patterns are imported successfully. You will also be notified if the import
process will over-write existing patterns.

If the file has any issues, the import process is aborted and the user is notified. Some of the issues with the file
can be:

» Type of file is not XML.
» Size of the imported file is more than 10 MB.
» XML is malformed.

» The values of the name, description, Javascript Regular Expression, Java Regular Expression fields are more
than the allowed size.

» A custom pattern is defined as a default pattern.
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» A default pattern is not defined as a default pattern.
» The Javascript regular expression defined in the file is not correct.
» The Java regular expression defined in the file is not correct.

» You are deactivating a pattern that is in use.

Copying Patterns

To copy a pattern:
1. In the partition-level Top menu, click the Security option.
2. In the Left menu, navigate to Data Masking > Patterns.

3. Locate the pattern you want to copy. Click in the Actions field for the pattern and select the Create Copy
button.

A copy of the pattern is created. All patterns are copied in the inactive state. You can make them active when
you are ready to use the pattern.

Deleting Patterns

Patterns cannot be deleted if they are associated with a channel. You must remove all associations before deleting
the pattern.

To delete a pattern:

1. In the partition-level Top menu, click the Security option.

2. In the Left menu, navigate to Data Masking > Patterns.

3. Locate the pattern you want to delete. Click in the Actions field for the pattern and select the Delete button.

Validating Masking Patterns

Validating Individual Patterns

After you create a pattern, test it by using the validation option available for each pattern.

To validate a pattern:
1. In the partition-level top menu, click the Security option.
2. In the Left menu, navigate to Data Masking > Patterns.

3. In the Pattens space, click the pattern you want to test.
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4. In the Edit Pattern page toolbar, click the Validate button.
5. In the Validate Pattern window, do the following:
a. In the Sample Data provide the text you want to use for testing the pattern and click the Show button.

b. In the Masked Data section, the Javascript regular expression and Java regular expression applied to the
sample data are visible. All the settings configured in the Masking Pattern tab will be applied to the
sample data.

Validate Pattern : American Express Credit Cards X

Sample Data American Express: 3461-421666-87940 | 346142166687940 | 3461 421666 87940
Visa 16: 4485-0713-3727-3343 | 4485071337273343 | 4485 0713 3727 3343
Master Card: 5227-6667-0186-2363 | 5227666701862363 | 5227 6667 0186 2363
Visa 13: 4222-2222-2222-2 | 4222222222222 | 4222 2222 2222 2
US Social Security Number: 555-55-5555 | 555555555 | 555 55 5555

| Show H Clear |

Masked Data

JavaScript Regular Expression AMENiCan EXDrEss: #H+# e svsbinrss | Serssaabhesssns | 48RRsrressthsines

Visa 16: 4485-0713-3727-3343 | 4485071337273343 | 4485 0713 3727 3343
Master Card: 5227-6667-0186-2363 | 5227666701862363 | 5227 6667 0186 2363
Visa 13: 4222-2222-2222-2 | 4222222222222 | 4222 2222 2222 2

US Social Security Number 555—55]—:5555 | 555555655 | 555 55 5555

Java Regular Expression AMerican EXpress: =+ asvmmsssnes | swwmswswaeruens | sesnsveesssvness

ek Visa 16: 4485-0713-3727-3343 | 4485071337273343 | 44850713 3727 3343

o Master Card: 5227-6667-0186-2363 | 5227666701862363 | 5227 6667 0186 2363
Visa 13: 4222-2222-2222-2 | 4222222222222 | 4222 2222 2222 2

US Social Security Number: 555-55-5555 | 555555555 | 555 55 5555

Validate patterns

Validating Masking Patterns Applied to Channels

In addition to validating individual patterns, you can validate the patterns selected for a channel and make sure
that they work properly as a group and the order of the selected pattens is correct.

To validate patterns applied to channels:

1. In the partition-level top menu, click the Security option. In the Left menu, navigate to Data Masking >
Chat or Email. If you are validating from the department level, go to the Apps section, and browse to Chat
> Data Masking or Email > Data Masking.

2. On the Data Masking page, click the Validate button.
3. In the Validate Pattern window, do the following:

a. In the Sample Data provide the text you want to use for testing the pattern and click the Show button.
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b. In the Masked Data section, all the selected patterns applied to the sample data are visible.

Validate Pattern x

Sample Data American Express: 3461-421666-87940 | 346142166687940 | 3461 421666 87940
Visa 16: 4485-0713-3727-3343 | 4485071337273343 | 4485 0713 3727 3343
Master Card: 5227-6667-0186-2363 | 5227666701862363 | 5227 6667 0186 2363
Visa 13: 4222-2222-2222-2 | 4222222222222 | 4222 2222 2222 2
US Social Security Number: 555-55-5555 | 555555555 | 555 55 5555

=

Masked Data

JavaScript Regular Expression American Express: 3461-421666-87940 | 346142166687940 | 3461 421666 87940

Java Regular Expression

Master Card: ****¥=**

Visa 16: HHFHRERRRRRIRRSARE | RERSERERRRRRRES | SRR AR
Master Card: *F e ssausmumsdhin | Whewvedshnenuess | Kesumennasbneses
Visa 13: 4222-2222-2222-2 | 4222222222222 | 4222 2222 2222 2

US Sacial Security Number: 555-55-5555 | 555555555 | 555 55 5555

American Express: 3461-421666-87940 | 346142166687940 | 3461 421666 87940
ViSa 167 FEEREARRRRER AR ARE | RRASERSRREOARRRE | RRARCRRRRSAAN

Visa 13: 4222-2222-2222-2 | 4222222222222 | 4222 2222 2222 2

US Social Security Number: 555-55-5555 | 555555555 | 555 55 5555

Validate the patterns selected for a channel

Applying Patterns to Chat Channel

At the Partition Level

What can the partition administrator do?

» Enable data masking for chat for all departments and manage all configurations from the global level.

» Give control to the department administrators to configure their own settings. At this point, department
administrators can choose to configure their own settings or can continue to use the settings configured by
the partition administrators. Once a department administrator decides to configure their own settings, they
are not affected by the changes made by the partition administrator.

To apply patterns to the chat channel:
1. In the partition-level top menu, click the Security option.

2. In the Left menu, navigate to Data Masking > Chat.

3. In the Data Masking: Chat page, on the General tab, set the following:

O Name: This field is read-only.
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Q

Q

Description: This field is read-only.
Enable data masking: Use the toggle switch to enable data masking. By default it is disabled.

Allow customers to send off the record chat messages: Use the toggle switch to allow customers and
agents to exchange off the record messages. Data masking rules do not apply to such messages. During
a chat, only the customer has the option to enable off-the-record feature. All messages exchanged in this
mode are not stored in the system.

Allow resetting at department level: Use the toggle switch to allow department level administrators to
set their own configurations and masking rules for the chat channel. When this setting is enabled,
department administrators get an option to either follow the global level settings, or to configure their
own.

Data Masking : Chat

Genera Masking Patterns Departments
Name
Description
Enable Data Masking [ @)
Allow customers to send off the a
recorded chat messages
Allow resetting at department level [ @)

Apply patterns to chat channel

4. Next, go to the Masking Patterns tab and select the patterns to be applied to the chat channel and define the
order of the patterns. While defining the order make sure that the longest pattern is on top followed by the
short patterns. This ensures that patterns that use smaller matches do not partially mask the text that would
match the longer text. For example, if you are selecting both Visa Credit Card 16 Digits and Visa Credit
Card 13 Digits, make sure the order is - Visa Credit Card 16 Digits and then Visa Credit Card 13 Digits. If
the order is not correct, and let us say you mask the following content: Visa 16: 4485-0713-3727-3343 and
Visa 13: 4222-2222-2222-2, it will be masked as Visa 16; kit x343 and Visa 13:
ookt You will notice that the 16 digit credit card did not get masked properly.

5. Next, go to the Departments tab to see a read-only view of the departments that are using the masking
patterns applied by the partition administrator.

6. Click the Save button.
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7.

After saving the changes, validate the patterns selected for the channel. For details, see “Validating Masking
Patterns Applied to Channels” on page 34.

At the Department Level

How much control do department administrators get?

4

If the partition administrator has not given control to department administrators to configure their own
settings, the department administrators get a read-only view of the settings configured by the partition
administrator.

If the department administrator has the option to configure their own settings, and they choose to do so, they
are not affected by the changes made to the configurations by the partition administrators.

To apply patterns to the chat channel:

1.
2.
3.

In a department, go to the Apps section.

In the left menu browse to Chat > Data Masking.

On the Data Masking: Chat page, in the General tab, set the following:

Q

Enable department settings: Departments automatically uses the data masking configurations
configured at the global level. Any changes made at the global level are applied to the department
immediately. Enable this option if you want to manage the data masking configurations on your own
and independent of the partition administrator. Any changes made by the partition administrator will not
be applied to your department. This option is enabled only if the partition administrator allows
department administrators to over-write the global level settings.

Name: This field is read-only.
Description: This field is read-only.
Enable data masking: Use the toggle switch to enable data masking. By default it is disabled.

Allow customers to send off the record chat messages: Use the toggle switch to allow customers and
agents to exchange off the record messages. Data masking rules do not apply to such messages. During
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a chat, only the customer has the option to enable off-the-record feature. Any messages exchanged in
this mode are not stored in the system.

Data Masking : Chat

Enable department settings c.

General Masking Patterns

Name
Description

Enable Data Masking [ @)

Allow customers to send off the
recorded chat messages

Apply patterns to chat channel

4. Next, go to the Masking Patterns tab and select the patterns to be applied to the chat channel and define the
order of the patterns. While defining the order make sure that the longest pattern is on top followed by the
short patterns. This ensures that patterns that use smaller matches do not partially mask the text that would
match the longer text. For example, if you are selecting both Visa Credit Card 16 Digits and Visa Credit
Card 13 Digits, make sure the order is - Visa Credit Card 16 Digits and then Visa Credit Card 13 Digits. If
the order is not correct, and let us say you mask the following content: Visa 16: 4485-0713-3727-3343 and
Visa 13: 4222-2222-2222-2, it will be masked as Visa 16 ###kkkskkdstrxxxx343 and Visa 13:

FhRdRR Rk Rk % You will notice that the 16 digit credit card did not get masked properly.

5. Click the Save button.

6. After saving the changes, validate the patterns selected for the channel by using the Validate button. For
details, see “Validating Masking Patterns Applied to Channels” on page 34.
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Applying Patterns to Email Channel

At the Partition Level

What can the partition administrator do?

4

Enable data masking for incoming and outgoing emails for all departments and manage all configurations
from the global level.

Give control to the department administrators to configure their own settings. At this point, department
administrators can choose to configure their own settings or can continue to use the settings configured by

the partition administrators. Once a department administrator decides to configure their own settings, they
are not affected by the changes made by the partition administrator.

To apply patterns to the email channel:

1.
2.
3.

In the partition-level top menu, click the Security option.

In the Left menu, navigate to Data Masking > Email.

In the Data Masking: Email page, on the General tab, set the following:

o

Q

Q

Q

Name: This field is read-only.
Description: This field is read-only.

Enable data masking in incoming emails: Use this option to enable data masking for incoming
emails.

Enable data masking in outgoing emails: Use this option to enable data masking for outgoing emails.

Allow resetting at department level: Use this option to allow department level administrators to set
their own configurations and masking rules for the email channel. When this setting is enabled,
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department administrators get an option to either follow the global level settings, or to configure their
own.

Data Masking : Email

Genera Masking Patterns Departments
Name
Description
Enable data masking in incoming
emails
Enable data masking in outgoing [ @)
emails
Allow resetting at department level [ @)

Apply patterns to email channel

4. Next, go to the Masking Patterns tab and select the patterns to be applied to the email channel and define the
order of the patterns. While defining the order make sure that the longest pattern is on top followed by the
short patterns. This ensures that patterns that use smaller matches do not partially mask the text that would
match the longer text. For example, if you are selecting both Visa Credit Card 16 Digits and Visa Credit
Card 13 Digits, make sure the order is - Visa Credit Card 16 Digits and then Visa Credit Card 13 Digits. If
the order is not correct, and let us say you mask the following content: Visa 16: 4485-0713-3727-3343 and
Visa 13: 4222-2222-2222-2, it will be masked as Visa 16: ####ksskixkix®x*343 and Visa 13:
wkEd ARk Rk R % You will notice that the 16 digit credit card did not get masked properly.

5. Next, go to the Departments tab to see a read-only view of the departments that are using the masking
patterns applied by the partition administrator.

6. Click the Save button.

7. After saving the changes, validate the patterns selected for the channel by using the Validate button. For
details, see “Validating Masking Patterns Applied to Channels” on page 34.
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At the Department Level

How much control do department administrators get?

» If the partition administrator has not given control to department administrators to configure their own
settings, department administrators get a read-only view of the settings configured by the partition
administrator.

» If the department administrator has the option to configure their own settings, and they choose to do so, they
are not affected by the changes made to the configurations by the partition administrators.

To apply patterns to the email channel:
1. In a department, go to the Apps section.
2. In the left menu browse to Chat > Email Masking.

3. On the Data Masking: Email page, in the General tab, set the following:

O Enable department settings: Departments automatically uses the data masking configurations
configured at the global level. Any changes made at the global level are applied to the department
immediately. Enable this option if you want to manage the data masking configurations on your own
and independent of the partition administrator. Any changes made by the partition administrator will not
be applied to your department. This option is enabled only if the partition administrator allows
department administrators to over-write the global level settings.

O Name: This field is read-only.
O Description: This field is read-only.

O Enable data masking in incoming emails: Use the toggle switch to enable data masking for incoming
emails.
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O Enable data masking in outgoing emails: Use the toggle switch to enable data masking for outgoing
emails.

Data Masking : Email

Enable department settings c.

General Masking Patterns

Name
Description

Enable data masking in incoming
emails

Enable data masking in outgoing [ @)
emails

Validate Cancel m

Apply patterns to email channel

4. Next, go to the Masking Patterns tab and select the patterns to be applied to the email channel and define the
order of the patterns. While defining the order make sure that the longest pattern is on top followed by the
short patterns. This ensures that patterns that use smaller matches do not partially mask the text that would
match the longer text. For example, if you are selecting both Visa Credit Card 16 Digits and Visa Credit
Card 13 Digits, make sure the order is - Visa Credit Card 16 Digits and then Visa Credit Card 13 Digits. If
the order is not correct, and let us say you mask the following content: Visa 16: 4485-0713-3727-3343 and
Visa 13: 4222-2222-2222-2, it will be masked as Visa 16; #¥kksksksksiitdkxxxx343 and Visa 13:

FkdRR Rk Rk % You will notice that the 16 digit credit card did not get masked properly.

5. Click the Save button.

6. After saving the changes, validate the patterns selected for the channel by using the Validate button. For
details, see “Validating Masking Patterns Applied to Channels” on page 34.

Masking Content of Completed Activities

The types of edits that can be made to completed activities is limited. For example, the content of an email or
chat cannot be changed or removed. However, there is a utility available to mask the content of activities if there
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was some personally identifiable information in the activity’s content that should have been masked but was not
due to an error or oversight of configuring masking conditions.

@ Important: This utility can only be used by a department administrator.

To mask content of completed activities:
1. While signed in to the Tools Console as a department administrator, click the Utilities button.
2. In the Utilities window, in the Mask Content of Chat and Email Activities field, click the Go button.

3. In Activity IDs field, provide the ID of the activity and click the Show Details button.

Mask Content of Chat and Email Activities R

This utility will mask emails and completed chat activities only.
The Data Masking Rules defined in the Administration Console will be used to mask the content.

Provide comma separated activity IDs to mask.

Activity IDs: [260158
Mask | Reset Show Details
No Activity ID  Activity Type Department Name Status Content
1 |260159 (Chat Service \Completed Show Content

Use the Show Details button to search for activities

4. Once the activity has been located and selected, click one of the following:

O  Mask: Masks the content of the activity using the data masking rules defined in the Administration
Console.

O Reset: Resets the search and clears the Activity IDs field.

O Show Content (link): This link, located in the Content column of the activity, displays the content and
details of the activity.
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Call Variables

» About Call Variables
» Creating Call Variables

» Deleting Call Variables



This chapter will help you configure call variables.

About Call Variables

While sending new activity requests from a queue to Unified CCE, EAAS sends call variables and ECC
variables to Unified CCE as task context. By default, the following activity attributes are sent to Unified CCE as
ECC variables.

» For inbound and outbound email activities: activity_id
» For chat activities: activity_id, customer_name
» For callback and delayed callback activities: activity_id, customer_name

If you need to pass on other attributes of the activity as call variables or ECC variables to Unified CCE, you need
to configure them in Enterprise Chat and Email. These variables can then be used in Unified CCE scripts to
configure conditions. For details, see the Unified CCE scripts documentation. If you plan to configure these
variables as ECC variables in Enterprise Chat and Email, you need to first create the ECC variables in Unified
CCE. For details, see the Unified CCE documentation.

The following attributes are available out-of-the-box: case_user_last_worked,
solution_description, case_description, case_subject, severity, customer_id,
owner, case_due_date, case_status, case_id, reroute_flag, contact_point_data,
delay_time_in_min, subject, is_escalated, conference_flag, case_type,
last_action_reason, queue_id, description, assigned_to, user_Llast_worked,
due_date, when_modified, when_created, activity_priority, customer_phone_no,
activity_id, customer_name

You can create additional variables for custom activity attributes. These custom attributes are created from the
Business Objects space in the Partition space. For details, see the Enterprise Chat and Email Administrator’s
Guide.

Creating Call Variables

To create a call variable:

1. In the top menu, click Business Rules.

2. In the left menu, click Call Variables.

3. In the Call Variables workspace, click the New button.
4

Set the following properties of the call variable:

O Name: Type the name for the call variable. The following characters are not allowed in the name: ~ ! @
#S$ B N&*()_-+2><{}]|[]1=\/, .(dot):;“” . Also, the name cannot start with a digit.

O Object: This field is automatically assigned and cannot be changed.

O Mapped Custom Attribute: From the dropdown list, select a custom attribute created for the Activity
Data from the Business Objects space in the Partition space.
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O  Description: Provide a brief description.

New Call Variable

"

Name Customer Status

Object*

Mapped Custom Attribute® Select Custom Attnbute v
L Enter Description

Description P

Create a call variable

5. Click the Save button.

6. From the Partition space, restart the EAAS service process and instance.

Deleting Call Variables

Default call variables and call variables used in queues cannot be deleted. To be able to delete the variables that
are in use, remove them from the queues first.

To delete a call variable:

1. In the top menu, click Business Rules.

2. In the left menu, click Call Variables.

3. In the Call Variables workspace, hover over the call variable you want to delete. Click the Delete button.
4

Click the Yes button when the system prompts you to confirm the deletion.
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Queues

About Queues

Creating Queues

Editing Queues

Deleting Queues

How Queues Assign Work to Agents

Changing the Status of Queues



About Queues

Queues hold incoming customer service activities such as emails and chat sessions that are waiting to be
assigned to agents. There is no limit to the number of queues that can be created in a department. A single queue
can hold multiple activity types like email, chat and so on. Agent access to queues is controlled through
permissions and the routing methods of the corresponding MRD.

After the necessary MRDs have been imported into ECE from Unified CCE, queues can be created manually
within ECE for all activity types. When creating queues in ECE, the MRDs and script selectors can be selected
for the queue to provide the extra necessary routing information for the queue.

ECE comes equipped with a Default Exception Queue already available. The routing of activities from this
queue is done by Unified CCE. More queues can be added to the application by importing MRDs. This creates a
Unified CCE type of queue and the routing of activities from this queue is done by Unified CCE. This queue is
mapped to a Unified CCE MRD and a script selector. When the MRD or script selector attributes are modified
in Unified CCE, the modifications are automatically retrieved and synchronized in ECE when an administrator
clicks the name of the queue in the list pane of the Administration Console. If the MRD or script selector is
deleted from Unified CCE, the queue in ECE is unmapped when a user clicks the name of the queue in the
Administration Console, and the administrator is shown a message saying that the queue has been unmapped.
For more information about importing MRDs, see the Enterprise Chat and Email Administrator’s Guide to the
Administration Console.

Queues Created by the System

The following queues are created automatically by the system at the time of install and are not directly tied to an
MRD.

Default Exception Queue

By default, an exception queue is created in every department. Activities are routed to the exception queue when:
» There are no active inbound workflows in the department.

» A workflow faces an error while processing activities.

» The queue used in a workflow is made inactive. All the activities coming to the inactive queue are routed to
the exception queue.

» Emails are bounced back.
» A new_task_failure message is returned by Unified CCE.

» If a connection is lost with the Cisco routing system, for example, if the MR PIM machine temporarily shuts
down or restarts.

@ Important: The exception queue cannot be deleted or made inactive.

Chat Queue

This queue is not in use.
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Email Queue

This queue is not in use.

Supervisory Queues

By default, a supervisory queue is created for each MRD associated with either the email or the outbound media

classes.

Creating Queues

You can manually create queues in the application in addition to the ones created when MRDs are imported.

To create a queue:

1.
2.
3.

In the top menu, click Business Rules.

In the left menu, click Queues.

Click the New button.

The workspace refreshes to show the Create Queue page.

On the General tab, adjust the following details as needed.

o

Name: Type a name of the queue. This is required information. The following characters are not
allowed in the name: <, . ?2:>$ *\/

Type: Set to Unified CCE.

Media Routing Domain: Select the MRD to which the queue should map. One MRD can be mapped
to only one queue. The list of MRDs is dynamically retrieved from Unified CCE. The MRD that is
selected determines what tabs and fields can be accessed during the queue editing process.

While creating queues for outbound emails, make sure you select the MRD created for outbound
emails. Similarly, while creating queues for inbound emails, make sure you select the MRD created for
inbound emails.

If you are creating a queue for callback or delayed callback activities, select the Cisco_Voice MRD
from the dropdown. This adjusts the fields that appear below.

Script Selector: From the dropdown list, select a script selector associated with the MRD to which the
queue is mapped. It is the keyword that identifies the Unified CCE routing script that is executed in
Unified CCE on the activity originating from this queue. An MRD can have multiple script selectors
associated with it, but you can select only one script selector for a queue.

Active: When a queue is created, by default it is active. Click this toggle to make it inactive. If you are
using a queue in workflows or are intending to use it, do not make the queue inactive. If a queue is
being used in workflows and it is made inactive, no new incoming activities are routed to the queue. All
activities coming to an inactive queue are routed to the exception queue. Also, if the queue is being used
in workflows, and agents have pull and transfer permissions on the queue, they can pull activities from,
and transfer activities to inactive queues. If you want to restrict these actions, remove the pull and
transfer permissions on the inactive queue.

Description: Type a brief description.
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O  Maximum Task Limit: This is the maximum number of activities or tasks that can reside within the
MRD at any point. It is also referred to as the Unified CCE queue depth or the Maximum calls per
queue. The value in this field is set automatically based on the selected MRD and it cannot be changed
for chat and email queues. To change this, go to Configuration Manager > Media Routing Domain List
Tool, and update the field Max Calls In Queue.

O Routing Priority: Select the routing priority for activities waiting in the queue. The value chosen here
determines the order in which activities are retrieved from the queue, and which new activity requests
are sent for routing to Unified CCE. The options available are:

e Due date: New activity request with the nearest due date is sent to Unified CCE.
e Longest waiting: New activity request with the longest wait time is sent to Unified CCE.

O Queue Priority: Select the priority of the queue. While sending new activity requests from a queue, the
priority of a queue is checked. If more than one queue has the same priority, the application looks for a
specified activity priority for the activities in the queues with the highest priority. If no activity priority
is found, activities are processed based on age, with the oldest being processed first. The EAAS instance
(see Enterprise Chat and Email Administrator's Guide for more information) retrieves activities from
the highest priority queues first, and the lowest priority queues last. The queue priority can be:

e Low
e Medium

e High

- Apps User Management E es  Language Tools Data Adapters Business Objects ()

&) Due Date

Lengest Waiting

Queue Pricrity Low -

Provide the general properties of the Callback or Delayed Callback queue

5. Click the Save button. Once the queue has been created, you can begin editing it. For more information, see
“Editing Queues” on page 51.
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Editing Queues

Each queue that is created in the application or after importing the designated MRD can be edited and adjusted
to suit your needs.

To edit a queue:

1.
2.

In the top menu, click Business Rules.

In the left menu, click Queues.

In the Queues workspace, click the queue you want to edit.
The workspace refreshes to show the Edit Queue page.

On the General tab, adjust the details as needed. For more information about the fields here, see “Creating
Queues” on page 49.

Edit Queue : ECE_Chat?2_Chat2_S5S

Chat Call Variables Expanded Call Variables Skill Groups Precision Queue Concurrent Task Limit
Name* ECE_Chat2_Chat2_s3
Type
Media Routing Domain® ECE_Chat2 ~
Script Selector* Chat2_sS ~
Active [
Description
Maximum Task Limit 5000
Routing Priority Due Date

Longest Waiting

Queue Priority Select Queue Priority ~

Edit general properties

Next, go to the Chat tab and set the following properties. This tab is available only for queues that belong to
a chat MRD.

@ Important: This feature is not available for callback and delayed callback activities.

In the Chat Media section, set the following:

O Quick links: From the available quick links, select the quick links to be associated with the queue.
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O Quick responses: From the available quick responses, select the quick responses to be associated with
the queue.

In the Options section, set the following:

O Display alternative engagement option: Select Yes to display the alternate engagement options in the
chat window while customers are waiting to be serviced by agents. The default value is No. For details
about configuring these options, see. “Configuring Alternative Engagement Options” on page 89.

O Display alternative engagement option after (minutes): Define the time after which the alternate
engagement options will be presented to the customer. If you do not set a value, customers will see the
options as soon as they start the chat.

o Enable chat attachments for agents and customers: If Chat attachments are enabled at the global
level, in the Options section, you can select Yes to allow agents and customers to send attachments
during chat sessions or select No to prevent agents and customers from being able to send attachments
during chat sessions. Image attachments sent during chat interactions appear in line. The allowed or
blocked file types and the size limits of the chat attachments are configured at the global level. For more
information about configuring attachments settings, see the Enterprise Chat and Email Administrator’s
Guide.

O Extended session timeout for customers (minutes): Define the period of time in which the system
should attempt to reconnect with a customer in the event of a disconnection during the chat. If a chat
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between an agent and a customer suddenly disconnects, the application attempts to reconnect the agent
and customer for the amount of time specified in this field and resets upon a successful connection.

Edit Queue : ECE_Chat2_Chat2_5S
General Call Variables Expanded Call Variables Skill Groups Precision Queue Concurrent Task Limit
Chat Routing
Queue Priority for Chats 5 - Medium ~
Chat Media

Quick Links

Name Order

Application form 1

Quick Responses

Name Order
Welcome 1
Options

Display Alternative Engagement
Option

Display Alternative Engagement
Option After (minutes)

Enable Chat Attachment for

Extend Session Timeout for
Customer (minutes)

Set chat properties

Next, in the Email tab, set the following properties. This tab is available only for queues that belong to an
email MRD.

O  Select the headers, footers, greetings, and signatures to be associated with the queue. For each queue,
you can configure the header, footer, signature and greeting to be associated with the queue. The
selected header, footer, signature and greeting are available to the agents in the Reply pane toolbar, for
quick access. The selected header, footer, signature, and greeting are also automatically added to the
Reply pane, and the agent can choose to use them or delete them, if he does not want to use them.

o\ Important: You must create the headers, footers, greetings, and signatures articles in the Apps
% space. Each queue can have only one greeting, header, footer, and signature associated with it.
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e Include original message: Enable this option to display the incoming message from the customer
in the Reply pane. If this option is disabled, the incoming message is displayed in the Activity
section of the Information pane. By default this option is enabled.

Edit Queue : ECE_Email_Email_SS

General Ema Call Variables Expanded Call Variables Skill Groups Precision Queue Concurrent Task Limit
Email Media
Header Email header ~
Greeting Email greeting ~
Signature Company signature ~
Footer Email footer ~
Include Original Message in Reply aO

oo son ]

Set email properties

7. Go to the Call Variables tab. This tab displays the call variables that map to specific attributes of an activity
(for example: activity_id, activity_subject). Provide a unique value in the Call Identifier field to apply this
ID to calls that come through this queue. This field is optional.

Next, select the call variables (Call Variable 1 through 10) to be passed along with activity requests
originating from this queue. The selected call variables can then be used in Unified CCE scripts to facilitate
and influence routing. After selecting the call variables, define an order for the variables. For more
information about configuring these variables, see “Call Variables” on page 44.

Edit Queue : ECE_Email_Email_SS

General Email Call Variables Expanded Call Variables Skill Groups Precision Queue Concurrent Task Limit
Call Identifier
(4]
Name Order
subject 1
queue_id 2
contact_point_data 3

=3 =3

Select call variables
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Go to the Application Strings tab. This tab displays the application string that map to specific attributes of an
activity (for example: activity_id, activity_subject). For queues for callback and delayed callback type of
activities, select the variables that can be passed as application strings. By default, the customer phone
number (customer_phone_number) is passed as an application string to Unified CCE. The selected
application strings can then be used in Unified CCE scripts to facilitate and influence routing. For more
information about configuring these variables, see “Call Variables” on page 44.

@ Important: This tab is available for callback and delayed callback type of queues only.

Edit Queue - Cisco_Voice_Callback_1544594

General Call Variables Expanded Call Variables

Name Order

contact_peint_data 2

Select application strings

Go to the Expanded Call Variables tab. This tab displays the ECC variables that map to specific attributes of
an activity (for example: activity_id, activity_subject). Select the Expanded Caller Context (ECC) variables.
The selected ECC variables can then be used in Unified CCE scripts to facilitate and influence routing. Both
Scalar and Array ECC variables are supported. For more information about configuring these variables, see
“Call Variables” on page 44.

ECC variables must be created in Unified CCE before they are used to map object attributes in ECE, as the
mapping must be registered in Unified CCE before the variables are sent with requests to Unified CCE.

By default, the following activity attributes are sent to Unified CCE as ECC variables:
O For email activities: activity_id

O  For chat activities: activity_id, customer_name
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O For callback and delayed callback activities: activity_id, customer_name

=\ Important: When you associate ECC variables with a queue, or remove the association, you need
Y to restart the EAAS service instance. For details, see the Enterprise Chat and Email Administrator’s

Guide.

Edit Queue : Cisco_Voice_Callback_1552546693134
General Call Variables Expanded Call Variables Application Strings
Add Expanded Call Variables

Name* Data*

Name

user.ece. activity.id

user.ece.customer.name

Select Expanded Call Variables

Data

activity_id

customer_name

© Add Expanded Call Variable

10. Go to the Concurrent Task Limit tab. For queues that handle email or chat activities, set the maximum
number of tasks that a given agent can handle at a time. This value is also known as the maximum
concurrent task limit for an agent. There are two types of agents that are displayed here:

O  Agents who belong to the skill group associated with the Unified CCE MRD selected in the General tab.

O Agents whose Attribute is used in Precision Queue (PQ) routing steps, and that PQ is mapped to the
Unified CCE MRD selected in the General tab.

If more than one queue is mapped to the same MRD, then the highest value assigned to the agent for any of
those queues will apply as the concurrent task limit. In such cases, users must go to the Concurrent Task
Limit tab for each queue mapped to that same MRD to view the actual value that the system considers.

The Concurrent Task Limit for a user cannot be greater than the maximum task limit of the queue. The
maximum task limit of a queue can be viewed from the Maximum Task Limit field on the General tab. The
value for this field is configured in the Max Calls In Queue in the Configuration Manager > Media Routing

Domain List Tool.
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The concurrent task limit for an agent is valid only as long as the agent remains in the same skill group.
When the agent is reskilled, the value is lost. If the agent is added to the same skill group again, this field
must be manually updated.

Edit Queue : ECE_Email_Email_SS
General Email Call Variables Expanded Call Variables Skill Groups Precision Queue Concurrent Task Limit
Concurrent Task Limit for ahaig 1
Concurrent Task Limit for anig 1

Concurrent Task Limit for kon 1

=3

Set concurrent task limit

11. Add precision routing to the queue by adding Skill Groups and Precision Queues to the queue under their
respective tabs. Skill Groups and Precision Queues applied to the queue determine how activities can be
routed or transferred to agents or other queues. For more information about how Skill Groups and Precision
Queues affect the routing of activities in a queue, see “How Queues Assign Work to Agents” on page 58.

Important: The Precision Queues tab appears only if the ECE installation has been integrated with
- Unified CCE 12.0(1).

Edit Queue : ECE_Email_Email_SS

General Email Call Variables Expanded Call Variables Skill Groups Precision Queue Concurrent Task Limit
Selected Precision Queues [+]
Name
Email_PQ

=3 3

Select precision queues

12. Click the Save button.
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Deleting Queues

You cannot delete queues that have open activities, or queues that are being used in workflows or chat entry
points. Also, the default queues provided with the system cannot be deleted.

To delete a queue:

1.
2.
3.

In the top menu, click Business Rules.
In the left menu, click Queues.

In the Queues workspace, hover over the queue you want to delete. Click the Delete button that appears next
to the queue.

How Queues Assign Work to Agents

58

Permissions are automatically assigned to queues mapped to MRDs and they cannot be changed in ECE.

Important Things to Note About Picking and Pulling Activities

Emails

» Agents can pick emails from other agents that belong to the same set of skill groups.

» Only agents who are part of a skill group that is associated with the queue can pick or pull from that queue.

» Only agents who match the attributes of a Precision Queue (PQ) that is associated with the ECE queue can
pick or pull from that queue.

» Based on the Maximum Task Limit setting, agents who have reached their concurrent task limit can pick
additional activities. The maximum number of activities is defined as part of the setting.

» When working on a non-interruptible chat or voice call:
O Agents can pick or pull interruptible emails from queues and other agents.
O  Agents cannot pick or pull non-interruptible emails from queues or other agents.

» Agents with the Administrator Role can pick from the Default exception queue.

Chats

» Agents are assigned chats by the system automatically. They cannot pull chat activities from queues. Pick

does not apply to chats.

Important Things to Note About Transferring Emails

4

Multiple emails can be selected and transferred to another user or queue at the same time, so long as the
emails are new and have no draft responses. If an email has any draft responses, or is not a new incoming
email, it must be transferred individually.

Outbound emails created by agents can only be transferred to users and not to queues.
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Disabled users are not listed in the list of users to whom you can transfer activities.
When an activity is transferred from one user to another, the owner of the case does not change.

You can transfer activities only if you have the Transfer action. For more information about actions, see the
Enterprise Chat and Email Administrator’s Guide.

Transferring to Queues:

»

»

Only agents who are part of a skill group that is associated with a queue can transfer emails to that queue.

Only agents who match the attributes of a Precision Queue (PQ) that is associated with an ECE queue can
transfer emails to that queue.

Transferring to Agents:

»

»

Agents can transfer emails to other agents that belong to the same set of skill groups.
Agents can transfer emails to other agents that belong to the same set of skill groups.

Based on the Maximum Task Limit setting, agents can transfer additional activities to agents who have
reached their concurrent task limit. The maximum number of activities is defined as part of the setting.

Emails cannot be transferred to departments directly. If the Allow Transfer of Activities to Integrated
Queues in Other Departments setting is enabled, agents can transfer activities to queues of other
departments.

If the Allow email transfer to agents who are not available setting is enabled, agents can transfer activities
to other agents who are not available to work on new activities. To be able to transfer an email to an agent,
the agent must be logged in to the application, should not have met the concurrent task limit, and should not
be working on a non-interruptible activity. If these requirements are not met, the agent is not displayed in the
Transfer Activities window.

If the Allow email transfer to agents who are not logged in setting is enabled, agents can transfer
activities to other integrated agents who are not logged in to the application. To be able to transfer an email
to an agent, the agent should not have met the concurrent task limit. If this requirement is not met, the agent
is not displayed in the Transfer Activities window.

An agent can transfer interruptible email activities to another agent. An agent cannot transfer non-
interruptible email activities to another agent. The concurrent task limit of the agent is considered in these
instances.

Important Things to Note About Transferring Chats

4

»

Only one chat activity can be transferred at a time.

Only open chat activities, in which the customer has not left the chat session, can be transferred.
When an activity is transferred from one user to another, the owner of the case does not change.
Disabled users are not listed in the list of users to whom you can transfer activities.

You can transfer activities only if you have the Transfer action. For more information about actions, see the
Enterprise Chat and Email Administrator’s Guide.
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Transferring Chats to Queues:

»

Only agents who match the attributes of a Precision Queue (PQ) that is associated with an ECE queue can
transfer chats to that queue.

Chats cannot be transferred to departments directly. If the Allow Transfer of Activities to Integrated
Queues in Other Departments setting is enabled, agents can transfer activities to queues of other
departments.

To be able to transfer a chat to a queue, at least one agent who can receive work from that queue must be
logged in, must be available, and must not have met the concurrent task limit. The queue must also not be at
its maximum task limit.

Transferring Chats to Agents:

Agents who do not meet these conditions are not displayed in the transfer window.

»

»

Agents can transfer chats to other agents that belong to the same set of skill groups.
Only agents who are part of a skill group that is associated with a queue can transfer chats to that queue.
The receiving agent must be logged in to the application.

The receiving agent must be available, depending on how the Allow chat transfer to agents who are not
available setting is configured.

The receiving agent should not have met the concurrent task limit, unless you are working on non-
interruptible chat activities. This may be affected by the Maximum assignment beyond concurrent task
limit setting.

Based on the Maximum assignment beyond concurrent task limit setting, agents can transfer additional
activities to agents who have reached their concurrent task limit. The maximum number of activities is
defined as part of the setting.

If the Allow chat transfer to agents who are not available setting is enabled, agents can transfer activities
to other integrated agents who are not available to work on new activities. To be able to transfer a chat to an
agent, the agent must be logged in to the application. Also, the agent should not be at the concurrent task
limit (CTL), and the queue associated with the agent should not be at its maximum task limit (MTL). If the
CTL and MTL for the agent have been reached, or if the agent is not logged in, the agent is not displayed in
the Transfer Activities window.

An agent can transfer chat activities to another agent who is working on an interruptible email activity or a
non-interruptible chat activity. If the receiving agent is working on a non-interruptible voice call, only
interruptible chat activities can be transferred to that agent. Agents working on non-interruptible voice calls
cannot be transferred non-interruptible chats.

Changing the Status of Queues

When a queue is created, by default it is active. If you are using a queue in workflows or are intending to use it,

do not make the queue inactive. If a queue used in workflows is made inactive, no new incoming activities are

routed to the queue. All activities coming to the inactive queue are routed to the exception queue.
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If the queue used in workflows, and agents have pull and transfer permissions on the queue, they can pull

activities from, and transfer activities to inactive queues. If you want to restrict these actions, remove the pull

and transfer permissions for the inactive queue.

Queues used in chat entry points cannot be made inactive.

To change the status of a queue:

1.

2
3
4,
5

In the top menu, click Business Rules.
In the left menu, click Queues.

In the Queues workspace, click the queue you want to edit.

On the Edit Queue page, use the toggle button for the Active field to make the queue active or inactive.

Click the Save button.

Queues
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Assets for Chat

» Chat Settings

» Managing Quick Links and Quick Responses



This chapter describes the various settings available for chat. It also explains how to create quick responses
and quick links for agents to use during chats.

Chat Settings

Chat Auto-Pushback Settings

The chat auto-pushback feature allows you to pushback chat activities to the queue, if the agents do not click
on the new chats assigned to them in the configured time (default value is 2 minutes). You can also
automatically mark the agents unavailable when chats are pushed-back from their inbox.

Enable Auto-Pushback of Chats

Use this setting to decide if new chats assigned to agents should be automatically pushed back from the
agent's inbox if they do not click on the activity in the time defined in the Expiry time for auto-pushback
for chats setting.

» Type: Partition setting

» Default value: Enabled

Expiry Time for Auto-Pushback for Chats (Minutes)

In this setting, define the time, in minutes, after which the new chat assigned to the agent will be
automatically pushed back from the agent's inbox, if the agent does not click on the chat in the defined time.

» Type: Partition setting

» Default value: 2

Make Agent Unavailable on Auto-Pushback of Chats

Use this setting to define if agents should be made unavailable after a chat is pushed back automatically
from the agent’s inbox. By default this setting is disabled.

» Type: Partition setting

» Default value: No
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Chat Agent Session Settings

Chat - Agent Chat Message Maximum Length

Use this setting to determine the maximum length of messages sent by agents to customers.
» Type: Department setting

»  Default value: 800

»  Minimum value: 60

» Maximum value: 2000

» Can be reset at lower level: No

Show Smiley in Agent Chat Toolbar

The toolbar in the Chat pane has a Smiley button that can be used to add emoticons in the chat messages. Use
this setting to determine if this Smiley button should be available to the agents.

» Type: Department setting
» Default value: Yes
» Value options: Yes, No

» Can be reset at lower level: No

Chat - Display Timestamp in Agent Chat Console

Use this setting to decide if the timestamp should be displayed with the chat messages in the Agent Console.
This setting applies to open chat activities only.

» Type: Department setting
» Default value: No
» Value options: Yes, No

» Can be reset at lower level: No

Chat - Display Timestamp in Completed Chat Transcript

Use this setting to decide if the timestamp should be displayed with the chat messages in the Agent Console.
This setting applies to completed chat activities only.

» Type: Department setting
» Default value: Yes
» Value options: Yes, No

» Can be reset at lower level: No



Chat - Disable Typing Area and Page Push Area on Customer Exit

Use this setting to disable Page Push and the typing area of the Chat pane for agents and supervisors, when a
customer leaves the chat session.

» Type: Department setting
» Default value: No
» Value options: Yes, No

» Can be reset at lower level: No

Chat - Enable Sound Alert

Use this setting to decide if you want play a sound alert to draw the agent’s attention to the chat inbox when a
new chat is assigned to the agent, or a new message is sent by the customer. The sound alert is played only when
the Agent Console is minimized or not in focus. If the agent is already working in the Agent Console, the sound
alert is not played.

» Type: Department setting
» Default value: Yes
» Value options: Yes, No

» Can be reset at lower level: Yes

Chat - Reason for Transfer

Use this setting to decide if you want agents to always assign a transfer code to chat activities while transferring
chats to other users, queues, or departments.

» Type: Department setting
»  Default value: Optional
» Value options: Optional, Required

» Can be reset at lower level: No

Chat Monitors

Chat - My Monitor - Activity Refresh Interval (Seconds)

In this setting configure the time interval (in seconds) at which the chat activities are refreshed in the My
Monitor’s folder of the supervisor’s Advisor Desktop. The following details of chat activities are refreshed - the
list of activities for the queue or agent being monitored; the transcript of chats that the supervisor has not joined
and is monitoring passively.

» Type: Department setting
»  Default value: 30

»  Minimum value: 30

Assets for Chat 65



66

4

»

Maximum value: 600

Can be reset at lower level: No

Chat Inbox Settings

Chat - Inbox Sort Column

In this setting, define the column that is used to sort items in the Chat Inbox in the Agent Console. Use the “Chat
- Inbox sort order” setting to define whether the items are sorted in the ascending or descending order.

%\ Important: If you specify a column that is not part of the agent's inbox list or if there is a tie
% between two activities with the same value for the sorting column, the inbox will then be sorted by
the shortcut key.

Type: Department setting, User setting
Subtype: Activity
Default value: Key

Value options: Key, Activity ID, Case ID, When Created, Customer name, Subject, Activity sub status,
Queue name

Can be reset at lower level: Yes

Chat - Inbox Sort Order

Use this setting to define the order - ascending or descending, in which items appear in the Chat Inbox in the
Agent Console. Use the “Chat - Inbox sort column” setting to determine the column by which items are sorted.

4

4

4

4

Type: Department setting, User setting
Default value: Descending
Value options: Ascending, Descending

Can be reset at lower level: Yes

Chat Activity Settings

Chat - Force Activity Categorization

Use this setting to ensure that agents assign categories to each chat activity before completing it.

4

4

4

Type: Department setting
Default value: No
Value options: Yes, No

Can be reset at lower level: No



Chat - Force Resolution Code

Use this setting to ensure that agents assign resolution codes to each chat activity before completing it.
» Type: Department setting

» Default value: No

» Value options: Yes, No

» Can be reset at lower level: No

Chat - SLA for Response Time (Seconds)

This setting is required for the, Chat - Current service level (%) and Chat - Daily service level (%), queue-
monitoring attributes, viewed from the Supervision Console. With this setting you can decide the threshold
interval (in seconds) that all in-progress sessions are checked against, to measure what percentage had a wait
time lesser than the threshold. Any session picked up after a wait time lesser than this threshold is counted as
having met the service level. The service level is shown as an aggregate percentage based on how many sessions
have met the service level and gives an indication of the timely pick-up of sessions by agents. If this value is set
to blank, then the “Chat - Current service level (%)” and “Chat - Daily service level (%)” attributes will show a
value of 100% for all queues. The default value is 600.

» Type: Department setting
» Default value: 600
» Maximum value: 3600

» Can be reset at lower level: No

Chat - Daily Service Level Sample Set Definition

This setting defines if the abandoned chat activities should be considered while calculating the daily service level
for chats.

» Type: Department setting
»  Default value: All chats handled including abandoned
» Value options: All chats handled including abandoned, All chats handled excluding abandoned

» Can be reset at lower level: No

Chat - Agent Availability Buffer Value

This setting determines the minimum number or percentage of agents that have to be available for a chat queue
mapped to an MRD, before a chat offer is presented to a website visitor. When a website visitor becomes eligible
for a chat offer, the system checks the number or percentage of available agents, whose assigned skill groups
match those of the queue, against the value configured in this setting. If this condition is met, the chat offer is
presented to the website visitor.

» Type: Department setting

» Default value: 5
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4

Can be reset at lower level: No

Chat - Agent Availability Check Mechanism

This setting determines whether the value set in the “Chat - Agent Availability Buffer Value” setting is an
absolute value or a percentage of the total number of agents that belong to the chat queue mapped to an MRD
and have the required skill groups.

»

4

4

4

Type: Department setting
Default value: Percentage
Value options: Absolute, Percentage

Can be reset at lower level: No

Managing Quick Links and Quick Responses

68

For Chat activities, the standard articles are:

4

Quick Responses: Quick responses are frequently used messages that can be easily used by agents in chat
sessions. Instead of remembering and typing them each time, agents can use these standard responses. For

example, Welcome can be a quick response that corresponds to the standard welcome message used across all
departments and by all agents. The text of this quick response can be *“7hank you for contacting the Customer
Care center. How may I assist you today?” Instead of typing the whole welcome message repeatedly, the agent

can use the quick response. Quick responses can be up to 600 characters long.

Quick Links: Quick links are frequently used web page URLSs that can be easily used by agents in chat
sessions. For example, Yakoo Finance can be a quick link that points to the URL w;k///mymo.mo/.

It is important to note that the quick responses and quick links must be mapped to a queue. Only the mapped
articles are made available in the Agent Console. For more information, see “Editing Queues” on page 51.

Changing Language

To change the language:

1.

2
3.
4

In the department level top menu, click the Apps option.
In the Left menu, navigate to Chat > Quick Response or Quick Link.
From the Actions button, select the Change Language option.

In the Change Language window, select from the languages assigned to you. The Quick Response or Quick
Link are displayed in the selected languages.



Creating Quick Links

To create a quick link:

1. In the department level top menu, click the Apps option.
2. In the Left menu, navigate to Chat > Quick Links.

3. In the Quick Links workspace, click the New button.

4. On the Create Quick Link page, provide the following:

O Name: A name for the quick link. This is what is displayed in the agent's desktop when the agent
selects a quick link.

O Description: A description of the article.

o Language: The language of the article. This is set to the language in which you are accessing the quick
links and cannot be changed. For more information about changing the access language, see “Changing
Language” on page 68.

O  Content: Provide the URL of the web page.
Create Quick Link

Name* Home page link
Description

Language

Content https://azdes05.infofeight/contact. htmi

Create a quick response

5. Click the Save button.

Creating Quick Responses

To create a quick response:
1. In the department level top menu, click the Apps option.

2. In the Left menu, navigate to Chat > Quick Responses.
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3. In the Quick Responses workspace, click the New button.
The Create Quick Response page opens.
4. Set the following in the General tab:

O Name: A name for the quick response. This is what is displayed in the agent's desktop when the agent
selects a quick link.

O Description: A description of the article.

O Language: The language of the article. This is set to the language in which you are accessing the quick
links and cannot be changed. For more information about changing the access language, see “Changing
Language” on page 68.

5. Add the content of the Quick Response in the Content tab. The content is displayed in plain text when agents
use the quick responses during a chat session. The content of the quick responses is displayed in the same
font and style as are the other messages that the agent types.

Create Quick Response

General Content

ot V| @souce| | WHE|B I U A- B |+« E} £ =

Mormal - Font - Size -

£
ut

Please wait while | check your account|

body p

Create a quick response

6. Click the Save button.

Deleting Quick Responses and Quick Links

@ Important: Quick Responses and Quick Links cannot be deleted if they are used in a queue.

To delete a quick response or quick link:
1. In the department level top menu, click the Apps option.

2. In the Left menu, navigate to Chat > Quick Response or Quick Link.



3. From the Actions field, select the Delete option.

Copying Quick Responses and Quick Links

To copy a quick response or quick link:
1. In the department level top menu, click the Apps option.
2. In the Left menu, navigate to Chat > Quick Response or Quick Link.

3. From the Actions field, select the Create Copy option. The page to create the quick response or quick link
opens with the description and content copied from the original article.

Previewing Content

To preview content:

1. In the department level top menu, click the Apps option.

2. In the Left menu, navigate to Chat > Quick Response or Quick Link.

3. From the List, click the Quick Response or Quick Link you want to preview.
4. On the edit page, click the Preview button.

The preview window shows the content.

Adding and Viewing Notes

To add and view notes:

1. In the department level top menu, click the Apps option.

2. In the Left menu, navigate to Chat > Quick Response or Quick Link.

3. From the List, click the Quick Response or Quick Link you want to add notes to.
4. On the edit page, click the Notes button.
5

In the View Notes window, add new notes and view or delete existing notes.
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Aqua Chat Template
Sets

» About Aqua Template Sets

» Creating an Aqua Template Set

» Changing General Settings

» Changing Header and Footer Colors

» Changing Color of Buttons

» Changing the Size and Placement of the Chat Frame
» Configuring Login Page Parameters

» Adding New Fields

» Configuring Sub-Domain Navigation Options

» Enabling Anonymous Chats

» Enabling Auto-Login

» Configuring Aqua Templates for Customer SSO
» Configuring Alternative Engagement Options

» Configuring Off-the-Record Options



Setting Maximum Length for Chat Messages
Changing Sound Alert

Changing Chat Bubble Colors

Configuring Survey Questions

Turning Off Surveys

Changing the Off Hours Message

Changing Chat Transcript Options

Deleting Template Sets
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This chapter will assist you in understanding how to set up docked chat template sets. For template sets for
callback activities, see “Callback Template Sets” on page 101. For information about editing template sets
upgraded from previous versions, see “Appendix C: Kiwi Chat Template Sets” on page 242.

About Aqua Template Sets

Template sets consist of CSS (cascading style sheets) and JS (JavaScript) files. The CSS files control the look
and feel of the Customer Chat Console. The JS files contain the business logic used to render data in the
Customer Chat Console. Templates are also used to determine what information is requested to identify the
customer (for example, name, email address, phone number). You can also compose messages that the customer
will see under certain circumstances (for example, if they request a chat session out of hours).

An entry point can be mapped to multiple template sets and multiple entry points can use the same template set.
The template sets for, Aqua and Aqua (docked), are shipped with the application and can readily be mapped to
any number of entry points.

@ Important: The system supplied templates should not be deleted.

The template sets are managed from the web server.

What Makes up an Aqua Template?

A template consists of a set of pages that are designed to work together. Typically, a chat template has the
following pages:

» A pre chat form

» The chat area

» Post chat survey form

» The off-hours page

» The alternative help options page

All these pages can be customized to meet your business needs.
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Pre chat form

Customers fill up this form to start a chat.

Live Chat 2 _ X

Name

Email

Phone Number

Your Question

Powered by Cisco

Pre chat form

Chat Area

Agent and customer exchange chat messages in the chat area.

= Live Chat

I need a new phone

You are now chatting with Robert

Hi John. | see you've been shopping for a
new phone. How can | help?

I have an older iPhone and | need to
upgrade

Sure thing! What version of the phone do
you have?

d by Cisco

The chat area

Start Chat
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Post Chat Survey

Customer is presented a survey form at the end of the chat.

= Live Chat Z_ X

Help us improve your chat experience by taking a
small survey.

How would you rate the quality of the answers
you received?

* o ok

What about the speed with which we answered
your guestions?

* & ok Kk K

How would you rate your overall chat
experience?
* W W

Powered by Cisco

Post chat survey form

Off Hours Page

An off-hours page is displayed to customers, typically when the customer tries to chat during business off hours.

Live Chat [ _x

Qur advisors are unavailable at this time. Please try
again later.

Powered by Cisco

The off hours page
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Do I need to create new templates or just use the default ones?

The docked chat template set, Aqua, is shipped with the application. You must always create a copy of the
default template set and customize it to look like your website.

You can choose to use one template set for all your chat entry points for a consistent look and feel. Alternatively,
you can use different templates, so that the look and feel of each one is targeted towards a specific audience.

How easy are the templates to modify?

The templates are easy to modify. All the properties of the templates sets are modified using the files available
on the web server. It is possible to make a number of layout and wording changes as well as branding changes to
match them with the look and feel of your website.

Some important things to note:

» You must have a good knowledge of the HTML and CSS languages to make changes in the HTML and CSS
files.

» Always create a backup copy of the files before making any changes.

The following table describes the files that can be changed for the Aqua template. All the files are available on
the web server at Cisco Home\eService\templates\chat\Aqua.

Use To

\U1 Un\LWW&_LDW' json » Update the text displayed on the chat pages.
application\application-chat- » Enable anonymous chat.

defaults.js » Enable auto login

» Enable surveys

» Configure the maximum length allowed for customer messages

» Configure sound alert for chat messages
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Use To

\css\appication.verson, number.css, » Configure the look and feel of the chat pop-up and the chat typing area.
iframe-style.css

» aqual\components\alternate- » Configure the look and feel of the chat pages, the chat typing area, and the text
contact-options editor toolbar.

» aqua\components\alternate- » Change the images used.
engagement-options » Note: The size of the custom images should match the size of the default images.

» aqua\components\article-content However, if you are changing the size of the chat windows, you can adjust the

. images size to match the new windows.

» aqua\components\article-toolbar

» aqua\components\attachment

» aqua\components\attachment-

review

» aqua\components\chat-
unavailable-message

aqualcomponents\cobrowse
aqualcomponents\error-message

aqualcomponents\escalation-
search-results-list

aqua\components\footer-small
aqua\components\header-small
aqua\components\launch-button

aqua\components\message-input-
horizontal

» aqua\components\post-chat-
survey

» aqua\components\pre-chat-
params-list

aqua\components\status-bar
aqua\components\thanks-message
aqua\components\transcript
aqua\components\video
aqualcomponents\wait-screen

v v v

v Vv v Vv

v Vv Vv v Vv

Creating an Aqua Template Set

You need access to the web server to perform this task.

7\ Important: Anytime you update or create new templates, you must copy the templates files on all
% web servers in your installation.

To create a new template set:
1. On the web server, browse to Cisco_tHome\eService\templates\chat.

2. Create a copy of the Aqua folder and rename the folder.
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The new template set is created. You can now edit the files in the template folder to configure your template
settings and to customize the look of your templates. After creating the template set, some of the things that
you can do are:

Configure the login page parameters (page 82)
Enable anonymous chats (page 87)

Set the maximum length of chat messages (page 93)
Configure the survey questions (page 95)

Change the off hours message (page 97)

Changing General Settings

To change the general properties for templates:

1.

Open the Cisco_Home\eServi ce\templates\chat\TW&_F()W\HOMLWW&—LDW.json file
in a text editor.

Edit the values for the various properties, such as:
O  TITLE: Change the title of the chat window. The default value is Live Collaboration by Cisco.

O EG_CONFIRM_CLOSE_CHAT: Change the message displayed to the agent when the customer closes the
chat session.

O EG_START_CHAT: Change the text of the button for starting chat. The default value is Start Chat.
O EG_SEND: Change the text of the button for sending the first chat message. The default value is Send.
O EG_SUBMIT: Change the text of the button for sending chat messages. The default value is Submit.

Save the changes.

Clear the browser cache and access the chat link to test the changes.

Changing Header and Footer Colors

This section talks about changing the header and footer of all pages in the Chat Customer Console, that is, the
Login page, the Chat page, and the Survey page.

To change the header and footer colors:

1.

Open the
Czkco_/—/omw\eSer'vice\tempLates\chat\Twzpla,fe_lfolder\css\application.uem'm_numﬁer. css
file in a text editor.

To change the header colors, locate the following classes and change the value of the background
properties:

#egain-chat-header-small nav.egain-navbar-fixed-top .colored
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3. To change the footer colors, locate the following classes and change the value of the background
properties:

#egain-chat-footer-small
#egain-chat-footer-small > span > span
#egain-chat-pre-chat-page .action-footer
#egain-chat-post-chat-page .action-footer
#egain-chat-overlay .egain-navbar-fixed-bottom

4. Save the changes.

5. Clear the browser cache and access the chat link to test the changes.

Changing Color of Buttons

This section talks about changing the colors for Start Chat, Send, and Close buttons.

Live Chat 2 _ X

Start Chat

Out-of-the-box color of buttons

Cisco

To change button colors:

1. Open the

Cisco_tome\eService\templates\chat\ 7emplate Folder\css\application.version nwmber.css
file in a text editor.

2. Locate the .action-footer .btn class and change the value of the Background property.

3. Save the changes.
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4. Clear the browser cache and access the chat link to test the changes.

Live Chat 2 _ X

Start Chat

Custom color of buttons

Cisco

Changing the Size and Placement of the Chat Frame

This section talks about defining the size of the chat frame.

To change the size of the chat frame:

1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\css\iframe-style.cssfileina
text editor.

2. Edit the values for the following properties:
O #egain-chat-wrapper: Set the size and position of the chat section in a standard frame.
O #Hegain-chat-iframe: Set the height, width, position, and placement of the frame.

O Hegain-chat-wrapper.egain-minimized #egain-chat-iframe: Set the size and position of
the chat sections in a minimized frame. By default, this area is left blank so the content follows the
frame.

O #Hegain-chat-iframe: Set the size and position of the chat frame.
3. Save the changes.

4. Clear the browser cache and access the chat link to test the changes.
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Configuring Login Page Parameters

Build the web form which customers must fill in to initiate a chat. The system uses the customer’s contact details
(for example, email address, phone number, and so on) to identify existing customers and add the chat session to
their customer records automatically. It also creates customer record for new customers.

You can:

» Change the text of the options
» Remove fields

» Change the order of fields

» Change error messages

» Change the format of the field

Live Chat 2 _ X

o

Start Chat

Out-of-the-box login page

Cisco

To configure the login page:

1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\application\application-
chat-defaults. js file in a text editor.

2. Locate the lLoginParameters property, and do the following.

a. To remove an existing field, select the code for the field and delete it from the file. For example, to
remove the phone number from the login page, delete the following lines:

{

"eGainAttributeName": "phone_number",
"eGainParentObject": "casemgmt",
"eGainChildObject": "phone_number_data",
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"primaryKey": false,

"controlType": "text",
"label": "APP.EG_PHONE_NUMBER",

"required": false,

"minLength": "0",
"maxLength": "18",
"validationPattern": "(LO0-9 \\=-\\(\\)I1)xs$"

}

@ Important: Do not remove a field that is set as the primary key.

b. To change the required fields, locate the attribute which you want to change and do the following:

L.

ii.

iii.

For the attribute, locate the property required and change the value to true to make it a required field,
or change the value to false to make it an optional field.

If you are setting a field as required, you must set the minimum length allowed for the field.

In the attribute section, locate the property minLength and set a minimum length for the field. You
can also set the maximum length by configuring the maxLength setting.

c. By default, the email address is set as the primary key for the login page. Also, note that only one field
can be set as the primary key. The attribute that is set as the primary key needs to be marked as a
required field.

d. To enable the use of selections in dropdowns for autologin, the values of the
egainChat.SetCustomerParameters(fieldname,value) parameter need to be passed as such:

Single-select: fieldname is the string “fieldname_index of login parameter” and value is the
internal value of selected option. For example,
egainChat.SetCustomerParameters('fieldname_1','savings"')

Multi-select: value is an array of selected values. For example,
egainChat.SetCustomerParameters('fieldname_1',["abc","xyz"1)

Open the Cisco_tHome\eServi ce\templates\TWate_Foldw\L'IOn\LMﬁMﬁa—LocMe. json file in a text

editor.

You can change the text of the fields displayed on the login page. Locate the following properties and
provide new labels for the fields.

EG_FULLNAME: Change the label of the name field.
EG_EMAIL_ADDRESS: Change the label of the email field.
EG_PHONE_NUMBER: Change the label of the phone number field.
EG_QUESTION: Change the label of the text field.

EG_CHARACTERS_REMAINING: Change the text of the message displayed to indicate the character
count for the text box on the chat interaction page. Make sure you do not delete
{{characterCountRemaining}} from the message.

EG_MESSAGE_LENGTH_ERROR: Change the text of the warning message to be displayed when the
message of the customer exceeds the allowed length. As part of the message, if you want to display
the allowed length and the number of characters the user has typed, make sure you retain
(MESSAGE_LENGTH) and (MAX_LENGTH) in the new message.
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4. Save the changes.

5. Clear the browser cache and access the chat link to test the changes.

Adding New Fields

Along with full name, email address, and phone number, you can use custom attributes on the login page.

Custom attributes created for the following objects can be added to the login screen. For details about creating
these attributes, see the Enterprise Chat and Email Administrator’s Guide.

o Customer Data

o  Contact Point Data

O Activity Data

The following table lists the fields that can be added to the login page. It also lists the attribute names and object
names for each field. You will need this information to add new fields to the login screen.

For Parent Object Child Object Attribute Name

Full Name casemgmt individual_customer_data full_name

Email Address casemgmt email_address_contact_point_data email_address

Phone Number casemgmt phone_number_data phone_number

Subject, Custom casemgmt activity_data subject

attributes added to If the custom attributes added to the object

activity data has two words, replace the space with
underscore (). For example, if the attribute
created is More details, the attribute
name will be more_details.

Custom attributes casemgmt customer_data If the custom attributes added to the object

added to customer has two words, replace the space with

data underscore (). For example, if the attribute
created is Family name, the attribute name
will be family_name.

Custom attributes casemgmt contact_point_data If the custom attributes added to the object

added to contact
point data

To add new fields:

has two words, replace the space with
underscore (). For example, if the attribute
created is Mobile number, the attribute
name will be mobile_number.

1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\application\application-

chat-defaults. js file in a text editor and do the following:

a. Locate the LoginParameters property, and copy a section for one of the existing parameters and
paste it where you want to add the custom field. Edit the following properties.

e eGainAttributeName: Provide the attribute name. See the table for details about the attribute
name you need to provide.
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b.

e eGainParentObject: Provide the parent object name. See the table for details about the object
name you need to provide.

e eGainChildObject: Provide the child object name. See the table for details about the object
name you need to provide.

e primaryKey: Set the value as false.

e controlType: Set the format for the field. For a single line text field, set the value to text. For a
multi-line text field, set the value to textarea.

e Llabel: Provide the label from the 110n language file for the field. For example, for the phone
number field, use APP.EG_PHONE_NUMBER.

e required: If you want to set the field, as optional set the value as false. To make the field
mandatory, set the value as true.

e minLength: Set the minimum required characters for the field.

e maxLength: Set the maximum allowed characters for the field. The value should not be set more
than the value set while creating the custom attribute.

e validationPattern: Provide the expression against which the information provided by the
customer is to be checked. For example, for phone number you can give an expression like,
A\sx\(?2\s*¥\d{3}\s*\)?2\s*[-.12\sx\d{3}\s*[-.1?\s*\d{4}\s*$. And, for email you
can use the expression like, AL0-9a-zA-Z\.\-\_1+\a[0-9a-zA-Z\.\-1+$ - this expression
refers to the format X@Y. Z (john@mycompany.com). For fields that require an integer value, you
need to at least set the validation string as \\d+$.

Save the changes.

2. Openthe Cisco_tHome\eService\templates\ Twéataflfolder\ L1 mumwe—um. json file in a text
editor and do the following:

a.

Add the following line in the property file: APP: { } list in the file: "EG_~ame" : " Display name for
the attribute",

Where: EG_~Name should match the value set in label in step 1 on page 84.

Save the changes.
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3. Clear the browser cache and access the chat link to test the changes. The login page should show the new
fields.

Live Chat 2 _ X

John Doe
John@d.com

I need a new phone

Start Chat

Cisco

Custom login form

Configuring Sub-Domain Navigation Options

The Aqua template, by default, allows for website visitors to chat with agents while browsing pages hosted on a
single domain. To allow for visitors to chat with agents while navigating to other web pages hosted on other sub-
domains, further configuration is required. The template must be configured to store chat session data in cookies,
thus allowing visitors to freely navigate so other sub-domains without ending the chat session.

5\ Important: Do not use multiple chat templates on a domain if only one template has been
Y configured for sub-domain navigation.

To configure templates for sub-domain navigation:
1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\application\application-

chat-defaults. js file in a text editor.
2. Locate the MultiSubDomainSupport object and adjust the following properties:

O IsRequired: By default, the values is set to false. Set the value to true to enable storage of chat
session data in cookies.

O CookieParentDomain: Provide the parent domain in which the cookies are stored. For example,
help.com. This is required if IsRequired is set to true.

O CookiePath: Provide the common URL path of all the sub-domains that should be supported for
continuing the chat, for example: /chat. This prevents the cookie data from being sent over to the
server with every request. This is required if IsRequired is set to true.
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3.

O IsCookieSecured: Determine whether the cookies should only be used for HTTPS domains. Set to
true to allow cookies only to be used in HTTPS connections, or set to false to allow cookies to be used
in HTTP and HTTPS connections.

Save the changes.

4. Clear the cookies and browser cache before accessing the chat link to test the changes.

Enabling Anonymous Chats

Anonymous chats allow customers to chat with agents without providing any personal details, like name, email
address, phone number, and so on.

To enable anonymous chats:

1.

Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\application\application-
chat-defaults. js file in a text editor.

Locate the LoginParameters property and delete all the parameters between the square brackets. The
property will look like: LoginParameters : L[]

Save the changes.

Clear the browser cache and access the chat link to test the changes. The chat should start without showing
the login page.

Enabling Auto-Login

When the chat link is provided in an authenticated section of the website, the auto-login feature can be used to
automatically login the customer for chat. When the customer clicks the chat link or button, he is not displayed
the login page.

@ Important: A template where auto-login is enabled should not be used for regular chats.

To enable auto-login for chats:

1.

Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\application\application-
chat-defaults. js file in a text editor.

Locate the EnableAutoLogin property and set the value to true to enable auto-login.

Save the changes.
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Configuring Aqua Templates for Customer SSO

Chat entry points can be configured to transfer customer context information from the company website to the
application through SAML. To learn more about Secure Chat for customers, see Enterprise Chat and Email
Administrator’s Guide.

To configure chat templates for customer single sign-on:

1. On the web server, navigate to Cz}:co_/wma\web\tempLates\chat\TW&_NW\ and open
application-chat-default.js.

2. Enable auto-login by setting the value of the EnableAutologin parameter to true.

3. Configure the attributes that will be transferred to the application along with the chat creation request. You
can do this by configuring the LoginParameters property for each of the attributes as described in
“Configuring Login Page Parameters” on page 82.

4. If any of the attributes will be transferred to the application in the SAML assertion, specify the following
additional properties for the attribute in LoginParameters:

O providerAttributeName: Name of the attribute in the SAML assertion.

O secureAttribute: Set the value to true to indicate that this attribute will be transferred in the SAML
assertion. For example:

{
"providerAttributeName": "my_name",

"secureAttribute": true,

"eGainAttributeName": "full_name",
"eGainParentObject": "casemgmt",
"eGainChildObject": "individual_customer_data",

"primaryKey": false,
"controlType": "text",
"label": "APP.EG_FULLNAME",
"required": true,
"minLength": "1",
"maxLength": "120",
"validationPattern": ""

}

If secureAttribute is missing or is set to false, the application does not look for and extract information for
that attribute from SAML assertion. Similarly, if secureAttribute is set to true for an attribute, but either
eGainAttributeName is not provided, or an attribute with the given name is missing from SAML assertion,
chat creation requests are denied.
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Configuring Alternative Engagement Options

Out-of-the-box templates come with three alternative engagement options for the chat window. These options are
displayed to customers while they are waiting in queue (new chats or transferred chats) to be serviced by an
agent. Once an agent joins the chat, the options are removed from the chat window. You can display these
options as soon as the customer starts the chat, or after a delay. To enable these options for a queue, see “Editing
Queues” on page 51.

» Give us a call
» Send us an email
»  Visit our FAQ page
These options have placeholder links. You must update these links before using this feature. You can also:
» Update the text.
» Remove options.

» Add new options.

I need a new phone

Alternate Contact Options =

Sorry, all our chat agents are currently busy.
Would you like to try one of these options instead?

A%

Your estimated wait time is 0 minutes

Cisco

Out-of-the-box options

To update links on the page:

1. Open the Cp':co_Hom\eSer‘V'ice\templates\chat\Temf{ate_Fo[der\appL'icat‘ion\appl‘icat'ion—
chat-defaults. js file in a text editor.

2. In the file, search for AlternateEngmtParams and in this section set the following properties:

O Search for text : 'APP.EG_ALT_ENGMT_PHONE"' and for the URL parameter provide the link for the
callback page.

O  Search for text : 'APP.EG_ALT_ENGMT_EMAIL' and for the URL parameter provide the email address
which customers can use to send emails. Make sure you do not delete the mailto: text.
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O Search for text : ' APP.EG_ALT_ENGMT_FAQ' and for the URL parameter provide the link to the FAQ
page on your website.

3. Clear the browser cache and access the chat link to test the changes.

To update the text on the page:

1. Open the Cisco_ttome\eService\templates\chat\ Template Folder\ L1 On\LM(ﬁMAﬁ&—LDW. json file
in a text editor and do the following:

O Locate the EG_ALT_ENGMT properties and change the value of this property to the new message you
want to display for the alternative engagement options.

O  Similarly, locate the EG_ALT_ENGMT_PHONE, EG_ALT_ENGMT_EMAIL, and EG_ALT_ENGMT_FAQ
properties and update the text for each of the options, that is, Give us a call, Send us an email, and
Visit our FAQ page.

2. Save the changes.

3. Clear the browser cache and access the chat link to test the changes.

To remove an option:

1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\application\application-
chat-defaults. js file in a text editor.

2. In the file search for AlLternateEngmtParams and from this section delete the code lines for the help
option you do not want to display. For example, to remove the Send us an Email option, delete the
following lines of code:

{

label :'APP.EG_ALT_ENGMT_EMAIL',

image:'components/alternate-engagement-options/icon_email.png',
hoverImage:'components/alternate-engagement-options/mail_hover.png',
url:'mailto:supportacompany.com'

3,
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= Live Chat

[
|
X

I need a new phone

Alternate Contact Options

sorry, all our chat agents are currently busy.
Would you like to try one of these options instead?

AW

Your estimated wait time is 0 minutes

Cisco

Customized remove an option

Clear the browser cache and access the chat link to test the changes.

To add new options:

1.

Open the Cisco_tome\eService\templates\chat\ 7ewplate Folder\application\application-
chat-defaults.js file in a text editor.

In the file locate the AlternateEngmtParams property, and copy a section for one of the existing help
options and paste it where you want the new section. Edit the following properties.

O Llabel: Create a new parameter using the name as EG_ALT_ENGMT_Aauce from L1 On\LaJ/IﬁW&—
Locale. json.

O image: Set the value as 'components/aLternate—engagement—options/écom_amm’é.w'

O hoverlImage: Set the value as ' components/aLternate—engagement—options/mm‘é_hompwﬁ'
O url: Provide the URL for the option.

Save the changes.

Place the images to be used for the new section at the following location:
Cisco_HomeNeServi ce\templates\chat\TW@_Fo[der\components\aLternate—engagement—
options

Open the Cisco_ Home\eServi ce\templates\chat\Temf{ata_lfolder\ L1 On\LﬂMMaﬂe'Local&. json file
in a text editor and do the following:

a. Add the following line in the property file: EG_ALT_ENGMT_Name=" Text for the section” Where
EG_ALT_ENGMT_~aue should match the value set in text in step 2.

b. Save the changes.

Clear the browser cache and access the chat link to test the changes.
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Configuring Off-the-Record Options

When data masking is enabled, masking rules prevent agents and customers from sending sensitive information
like credit card numbers, social security numbers, and so on, during the chat session. The Off-the-record feature
allows agents and customers to exchange sensitive information as data masking rules do not apply to these
messages. Any information exchanged while off-record is not stored in the system. Off-the-record conversation
can be started and stopped only by customers. This feature is enabled while configuring data masking for the
chat channel. For details, see Enterprise Chat and Email Administrator’s Guide.

= Live Chat 2 _ X

Hi John. | see you've been shopping for a
new phone. How can | help?

I have an older iPhone and | need to
upgrade

Sure thing! What version of the phone do
you have?

Your messages are now off-record and will not be saved.

Cisco

Off the record messages

To change the text of off-the-record messages:

1. Open the Cisco Home\eServi ce\templates\chat\TW{M&_FoMer\HOn\LWWe—Lom.json file
in a text editor.

2. To change the text that appears when a customer goes on-record and off-record, locate the following
properties and change the values:

O EG_OFF_RECORD: The default value is Your messages are now off-record and will not
be saved in the system.

O EG_ON_RECORD: The default value is Your messages are now on record.

3. To change the text that appears when data is masked, change the value of the following property:

O EG_SENSITIVE_DATA_NOTIFICATION: The default value is Don't worry. Your sensitive
data has been masked.

4. To change the text that appears in the chat transcript when messages have been removed due to masking,
change the value of the following property:

O EG_OFF_RECORD_MESSAGE_REMOVED: The default value is Message has been removed.

5. Save the changes.
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6. Clear the browser cache and access the chat link to test the changes.

= Live Chat Z_ X

Hi John. 1 see you've been shopping for a
new phone. How can | help?

I have an older iPhone and | need to
upgrade

Sure thing! What version of the phone do
you have?

Cisco

Customized messages

Setting Maximum Length for Chat Messages

To set the maximum length for chat messages:

1.

Open the Cisco_tiome\eService\templates\chat\ 7emplate Folder\application\application-
chat-defaults. js file in a text editor.

Locate the MaxMessageSize property and change the value of the property to the number of characters you
want to allow for each chat message. By default the value is set to 800. This setting is also used to control
the message length in the Additional Comments field in the survey form. The maximum value can be set to
2000.

Save the changes.

Clear the browser cache and access the chat link to test the changes.

Changing Sound Alert

A sound alert is played on the customer side when a new chat message comes. You can change this sound alert.

To change the sound alert:

1.

Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\application\application-
chat-defaults. js file in a text editor.
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2. Locate the CustomerAudioAlert property and change the value of the property to the path of the new
chat sound file. Only .wav files are supported.

3. Save the changes.

4. Clear the browser cache and access the chat link to test the changes.

Changing Chat Bubble Colors

Different bubble colors are used to identify messages sent by the agent and the customer during chat interactions.
You can changes these colors of these bubbles.

= Live Chat Z_ X

I need a new phone

You are now chatting with Robert

Hello. My name is Robert. How can | assist
you

I cracked my screen

Cisco

Custom colors for chat bubbles

To change the chat message bubble colors:

1. Open the
Cisco_tome\eService\templates\chat\ Template Folder\css\application.verdon, number.css
file in a text editor.

2. To change the chat message bubble color for customers: Locate the egain-chat-transcript
.customer .bubble class and in the .bubble class change the value of the background property. You
can use the .customer .bubble classes to adjust the borders, spacing, and margin as well.

3. To change the chat message bubble color for the first agent: Locate the egain-chat-transcript
.agent .bubble class andinthe .bubble class change the value of the background property. You can
use the .agent .bubble classes to adjust the borders, spacing, and margin as well.

4. To change the chat message bubble color for all other agents who can join the chat as supervisors: Locate
the &.agent1, &.agent2, and &.agent3 classes and in the .bubble class change the value of the
background property. In the .arrow class change the value of the border-right property.

5. Save the changes.
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Configuring Survey Questions

At the end of the chat session a survey form is presented to customers to measure the usefulness of the chat. The
survey form has three questions and a text box for providing additional comments. You can change the text of
these questions, however, you cannot add or remove questions from the survey form.

You can turn off the survey, if you do not wish to use it. For details, see “Turning Off Surveys” on page 96.

= Live Chat [ _x

Help us improve your chat experience by taking a

small survey.

would you rate the quality of the answers

you received?

What about the speed with which we answered
your guestions?

How

would you rate your overall chat

experience?

o

Cisco

Out-of-the-box chat survey form

To change the text of survey questions:

1. Open the Cisco Home\eServi ce\templates\chat\Tem;%ata_Fo[der\HOn\LWWe—Lom.json file
in a text editor.

2. Locate the section for survey questions by searching for EG_SURVEY. In this section change the following
properties:

o

o

EG_SURVEY_HEADING: Change the text for presenting the survey form.
EG_SURVEY_QUESTION_1, EG_SURVEY_QUESTION_2,and EG_SURVEY_QUESTION_3: Change the

text of the survey questions.
EG_SURVEY_QUESTION_4: Change the title of the textbox.
EG_MESSAGE_LENGTH_ERROR: Provide the message to be displayed when the text in the comments

box exceeds the allowed size. Keep in mind this is a general message that is used in the chat session and
on the survey page when a user exceeds the character limit for the message.

EG_THANKS_SURVEY_MESSAGE: Change the message displayed to users after they have completed the
survey.

EG_SEND: Change the text of the button used for submitting the survey. Keep in mind this is a general
button which may be used in chat pages other than just the survey section.

3. Save the changes.
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4. Clear the browser cache and access the chat link to test the survey form changes.

= Live Chat Z_ X

Help us improve your chat experience by taking a

small survey.

How would you rate agent's overal
performance?

W ¥ o i o

d at which you

Would you like our help again?

W i o ¥ v

Customized chat survey form

Cisco

To change the maximum allowed characters of the survey text box:

1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\applicationl\application-
chat-defaults. js file in a text editor.

2. Locate and set the MaxSurveyTextSize property to a new value. By default, this value is set to 2000. The
maximum value for this property cannot exceed 4000.

3. Save the changes.

Turning Off Surveys

You can turn off the survey if you do not wish to display a survey form at the end of chat sessions.

To turn off surveys:

1. Open the co':co_Hom\eService\tempLates\chat\TW{ate_Folder\applicat‘ion\appL‘icat‘ion—
chat-defaults. js file in a text editor.

2. In the file locate the SurveyPageOn property and change its value to false. Save the changes.

3. Open the Cisco_Home\eServi ce\templates\chat\TW&_FoZder\HOn\LWWa—Lom.json file
in a text editor.

4. In the file locate the EG_THANKS_CHAT_MESSAGE property and change the text to be displayed to
customers when they end the chat session. The default value is Thank you for chatting with us.

5. Save the changes.
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6. Clear the browser cache and access the chat link to test the changes.

= Live Chat 2 _ X

m|

Thank you for chatting with us. We value your
feedback.

Cisco

The message shown if surveys are removed

Changing the Off Hours Message

An off hours message can be displayed to customers when agents are not available for handling chats. Note that
this message differs from the message that appears when all available agents have reached their concurrent task
limit.

Live Chat Z_ X

Thank you for your inquiry. Our service hours are %am-
5pm PST. Monday-Friday.

Cisco

Off hours message
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To change the off hours message:

1. Open the Cisco Home\eServi ce\templates\chat\Tmz{dat&_Fo[o{er\HOn\LMﬁMﬁa—Lom. json file
in a text editor.

2. Locate the property EG_CHAT_UNAVAILABLE and change the message to be displayed during off hours.
3. Save the changes.

4. Clear the browser cache and access the chat link to test the changes.

Live Chat Z_ X

Our advisors are unavailable at this time. Please try
again later.

Cisco

Custom message
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Changing Chat Transcript Options

During a chat session and at the end of a chat session, customers have access to the Save Transcript button.
Customers can use this to save the chat transcript for future reference.

You can change the tool tips and you can add a header, footer, and title for the transcript window. You cannot
remove buttons from the chat window.

Save Transcript

@ Go Off Record

Default Save and Print Transcript buttons

To change the chat transcript options:

1. Open the Co‘:co_Home/\eSer'vice\templates\chat\Templata_Folder\HOn\LWWe-Lom.json file
in a text editor.

2. Edit the values for the following properties:
O EG_TOOLBAR_SAVE_TRANSCRIPT: Change the tool tip of the Save Transcript button.
O EG_TRANSCRIPT_HEADER: Provide the header for the transcript page.

O EG_TRANSCRIPT_START_TIME: Change how you want the start time of the transcript to be displayed.
Do not change the value of the {{chatStartTime}} property.

O EG_CHAT_TRANSCRIPT_HEADER: Change how you want the customers to see which agent they're
talking to. Do not change the value of the {{AgentName}} property.

3. Save the changes.

4. Open the
Cisco_tHome\eServi ce\templ.ates\chat\TW{a/ta_Folder\l1On\messaging_Lzmﬁmga_Locale.prope
rties file in a text editor.

5. Edit the value for the following property:
O MAIL_HEADER_LIVE_CHAT: Change the header of the transcript emailed by the system.

6. Save the changes.
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7. Clear the browser cache and access the chat link to test the changes.

Deleting Template Sets

@ Important: You must delete the templates files from all web servers in your installation.

To delete a template set:
1. On the web server, browse to Cisco_tHome\eService\templates\chat.

2. Delete the template folder that you do not want to use. If you are using these templates for any entry point,
make sure to update the HTML code on web pages with the new template sets you want to use.
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This chapter will assist you in understanding how to set up callback template sets. For template sets for chat
activities, see “Aqua Chat Template Sets” on page 72.

About Template Sets

Template sets consist of CSS (cascading style sheets) and JS (JavaScript) files. The CSS files control the look
and feel of the Callback Console. The JS files contain the business logic used to render data in the Callback
Console. Templates are also used to determine what information is requested to identify the customer (such as
name, email address, phone number). You can also compose messages that the customer will see under certain
circumstances (for example: if they request a callback session out of hours).

An entry point can be mapped to multiple template sets and multiple entry points can use the same template set.
One template set, Cisco Rainbow, is shipped with the application and can readily be mapped to any number of
entry points.

@ Important: The system supplied templates should not be deleted.

The template sets are managed from the web server.

What Makes up a Template?

A template consists of a set of pages that are designed to work together. Typically, a callback template has three
pages - a callback or delayed callback request form, the call status page, and the off-hours page. All these pages
can be customized to meet your business needs.
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Callback request form

Customers fill up this form to start a callback session.

@ CallMe by Cisco - Mozilla Firefox o | e |

Jenna

Jenna@company.com

usa 4291

Loan application question|

Callback request form

@ CallMe by Cisca - Mosilla Firefox SRRCIE X

¢, GallMe |

Jenna

Jenna@compnay.com

usa 4201

CALL LATER Feb 10 2016 03:00 PM

Delayed callback request form
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Callback Status Area

Status of call session is displayed here.

@ CallMe by Cisco - Mozilla Firefox | (S

USA 4291

Calling you in 10 minutes.
You may close this window at any time.

The callback status area

Off Hours Page

An off-hours message is displayed to customers when the application is not able to connect to Unified CCE to
place a call.

[a, Mozilla Firefox o o S|

Thank you for your inquiry. Our service
hours are 9am-5pm PST, Monday-Friday.

If you are trying within the service hours
and still getting this message, please try
again after some time.

The off hours page
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Do I need to create new templates or just use the default ones?

The template set, Cisco Rainbow, is shipped with the application. You must always create a copy of the default
template set and customize it to look like your website.

You can choose to use one template set for all your callback entry points for a consistent look and feel.
Alternatively, you can use different templates, so that the look and feel of each one is targeted towards a specific
audience.

How easy are the templates to modify?

The templates are easy to modify. All the properties of the templates sets are modified using the files available
on the web server. It is possible to make a number of layout and wording changes as well as branding changes to
match them with the look and feel of your website.

Some important things to note:

» You must have a good knowledge of the HTML and CSS languages to make changes in the HTML and CSS
files.

» Always create a backup copy of the files before making any changes.

The following table describes the files that can be changed. All the files are available on the web server at
Cisco_tHome\NeServiceltemplates\callback\ TW&_NAM&

Use To

\L10n\custom_callback_zocale.prope » Update the text displayed on the callback pages.

rties Note: All custom messages should be added in the
custom_callback_zocale.properties file. Do not make any changes
to the callback_Zocaleproperties

\eGainLiveConfig.js Change the fields displayed on the login page.
Enable auto login.

Configure the height of the callback window.

v v Vv Vv

Configure the maximum length allowed for the customer message.

v

css\callback.css Configure the look and feel of the callback pages.

v

\call.html Change the layout of the callback page.

v

Images folders: Change the images used.

b T e Name\image Note: The size of the custom images should match the size of the default images.
However, if you are changing the size of the callback windows, you can adjust
the images size to match the new windows.
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Creating Template Set Folders

You need access to the web server to perform this task.

o\ Important: Anytime you update or create new templates, you must copy the templates files on all
% web servers in your installation.

Create a separate template set for each of the following types of activities:
» Callback activities

» Delayed callback activities

To create a new template set:
1. On the web server, browse to Cisco_tHome\eService\templates\callback.
2. Create a copy of the Rainbow folder and rename the folder.

3. The new template set is created. You can now edit the files in the template folder to configure your template
settings and to customize the look of your templates. You can change any files except for files in the
following folders:

O script
O Llibs
After creating the template set, some of the things that you can do are:
» Configure the login page parameters (page 109)

» Change the off hours message (page 116)

Changing General Settings

To change the general properties for templates:

1. Open the
Cisco_tome\eService\templates\callback\ 7emplate Folder\110n\custom_callback_rocale.pro
perties file in a text editor.

2. Add the following properties and set the values as required.

O L10N_DOCUMENT_TITLE: Change the title of the callback window. The default value is CallMe
by Cisco.

o L10N_BROWSER_CLOSE_MESSAGE: Change the message displayed to the customer when he
closes the callback window.

O L10N_CLICK_TO_CALL: Change the text of the button for initiating callback session. The default
value is Call Me.

o L10N_CLOSE: Change the text of the button for closing the callback window. The default value is
Close.

3. Save the changes.
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4. Clear the browser cache and access the callback link to test the changes.

Changing Header Image

This section talks about changing the header image for the callback templates.

To change the header image:

1. Change the Logo_click_to_call.png image file in the
Cisco_tome\eService\templates\callback\ 7emplate Folder\image folder with your custom image.

2. Clear the browser cache and access the callback link to test the changes.

Changing Color of Buttons

This section talks about changing the colors for Call Me and Close buttons.

@ CallMe by Cisca - Moszilla Firefox o |5 |

Jenna

Jenna@company.com

Usa 4291

Loan application question|

Out-of-the-box color of buttons

To change button colors:

1. Open the ckwfﬁom\eService\templates\caleack\TmWafFolder\css\caLLback.css filein a
text editor.

2. To change the Call Me button colors, do the following:

a. To change the button color, locate the cal L_button_class class and change the value of the
background-color property.

b. To change the hover color, locate the cal L_button_class:hover class and change the value of the
background-color property.
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3. To change the Close button colors, do the following:

a. To change the button color, locate the close-button-class and change the value of the background-
color property.

b. To change the hover color, locate the close_button_class:hover class and change the value of
the background-color property.

4. Save the changes.

5. Clear the browser cache and access the callback link to test the changes.

@ Call Me by Cisco - Mozilla Firefox SRR X

‘ {, Call Me |

Jenna

Jenna@company.com

USA 4291

Loan application question|

Custom color of buttons

Changing the Size of Callback Windows

This section talks about defining the size of the windows.

To change the size of the callback windows:

1. Open the Cisco_tome\eService\templates\callback\ 7emplate Folder\eGainLiveConfig.js file
in a text editor.

2. Edit the values for the following properties:

o  windowWidth: Set the width of the callback and delayed callback windows. The default value is 425
pixels.

o windowHeightCallback: Set the height of the callback page. The default value is 600 pixels.

o windowHeightDelayedCallback: Set the height of the delayed callback page. The default value is 680
pixels.

3. Save the changes.

4. Clear the browser cache and access the callback link to test the changes.
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Configuring Call Request Page Parameters

Build the web form which customers must fill in to initiate a web callback interaction. The system uses the
customer’s contact details (for example, email address, phone number, and so on) to identify existing customers
and add the session to their customer records automatically. It also creates customer records for new customers.

Phone number is a required attribute for callback and delayed callback activities. Schedule call is a required
attribute for delayed callback activities and should not be removed from templates configured for delayed
callback activities.

You can:

» Change the text of the options
» Remove fields

» Change the order of fields

» Change the primary key

@ CallMe by Cisco - Mozilla Firefox = X

ll ¢ Call Me

Jenna

Jenna@company.com

usa 4291

Loan application question|

Out-of-the-box login page

To configure the call request page:

1. Open the Cisco_tome\eService\templates\callback\ 7emplate Folder\eGainLiveConfig.js file
in a text editor.

2. Locate the lLoginParameters property, and do the following.

a. To remove an existing field, select the code for the field and delete it from the file. For example, to
remove the question field from the page, delete the following lines:

{

paramName : 'L10N_YOUR_QUESTION_PROMPT',
objectName : 'casemgmt::activity_data',
attributeName : 'subject',

primaryKey : '0',
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required : '0',

minLength : '1°',

maxLength : '800',

fieldType : '2°',
validationString : '',
errorMessage : '',

className : 'textarea_field'
}

@ Important: Do not remove a field that is set as the primary key.

b. To change the order of the fields, remove the code for the field you want to move and paste it at the
new location. Make sure to copy the complete set of lines for a field and move them to the new
location.

c. To change the required fields, locate the attribute which you want to change and do the following:

i. For the attribute, locate the property required and change the value to 1 to make it a required
field, or change the value to 0 to make it an optional field.

If you are setting a field as required, you must set the minimum length allowed for the field.

ii. In the attribute section, locate the property minLength and set a minimum length for the field. You
can also set the maximum length by configuring the maxLength setting.

d. By default, the email address is set as the primary key for the login page. You can choose to change the
primary key to phone number. No other field can be set as the primary key. Also, note that only one
field can be set as the primary key. To change the primary key, do the following:

@ Important: Only the customer phone number or email address can be set as the primary key.

i. Locate the section for email address by searching for attributeName : 'email_address'.In
this section, locate the primaryKey property and set the value to 0.

ii. Next, locate the section for phone number by searching for attributeName
'phone_number'. In this section, locate the primaryKey property and set the value to 1.

Also, the attribute that is set as the primary key needs to be marked as a required field.
iii. In the phone number section, locate the property required and change the value to 1.

3. Open the

Cisco_tome\eService\templates\ 7emplate Folder\L10n\custom_callback_socale.properties
file in a text editor.

a. You can change the error message for the fields displayed on the call request page. Add the following
properties and provide new error messages:

e L10N_ERROR_NAME: Change the error message of the name field.

e L10N_ERROR_EMAIL: Change the error message of the email field.

e L10N_ERROR_PHONE: Change the error message of the phone field.

e L10N_ERROR_DELAYED_TIME: Change the error message in case delay time is not valid.
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b. You

L10N_ERROR_SUBJECT: Change the error message of the question field.

can also change the text of the fields displayed on the call request page. Add the following

properties and provide new labels for the fields.

4. Save the

L10N_NAME_PROMPT: Change the label of the name field.
L10N_EMAIL_PROMPT: Change the label of the email field.
L10N_PHONE_NUMBER_PROMPT: Change the label of the phone number field.
L10N_YOUR_QUESTION_PROMPT: Change the label of the text field.

L10N_CALL_NOW: Change the label of Call Now in the dropdown. This applies to delayed
callback only.

L10N_CALL_LATER: Change the label of Call Later in the dropdown. This applies to delayed
callback only.

L10N_CALL_IN_MINS: Change the label of the options Call in IWM_ Time minutes
dropdown. While setting the value, do not remove the variable {02} as that defines the time after
which the call will be placed.

L10N_SCHEDULE: Change the label of Schedule Call field. This applies to delayed callback
only.

changes.

5. Clear the browser cache and access the callback link to test the changes.

Adding New Fields

Along with full name, email address, and phone number, you can use custom attributes on the login page.

Custom attributes created for the following objects can be added to the login screen. For details about creating
these attributes, see the Enterprise Chat and Email Administrator’s Guide.

O  Customer Data

o  Contact Point Data

O Activity Data

The following table lists the fields that can be added to the login page. It also lists the attribute names and object
names for each field. You will need this information to add new fields to the login screen.

For

Object Name Attribute Name

Full Name

Email Address

casemgmt:individual_customer_data | full_name

casemgmt::email_address_contact_ | email_address

point_data
Phone Number casemgmt::;phone_number_data phone_number
Subject, Custom casemgmt::activity_data subject
attributes added to If the custom attributes added to the object has two words,

activity data

replace the space with underscore (_). For example, if the attribute
created is More details, the attribute name will be
more_details.
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For Object Name Attribute Name

Custom attributes casemgmt::customer_data If the custom attributes added to the object has two words,

added to customer replace the space with underscore (). For example, if the attribute

data created is Family name, the attribute name will be
family_name.

Custom attributes casemgmt::contact_point_data If the custom attributes added to the object has two words,

added to contact replace the space with underscore (_). For example, if the attribute

point data created is Mobile number, the attribute name will be

mobile_number.

To add new fields:

1. Open the Cisco Home\eServi ce\templ.ates\cal.l.back\TW@_Folder\eGa'inLiveConf'ig.js file
in a text editor and do the following:

a. Locate the LoginParameters property, and copy a section for one of the existing parameters and
paste it where you want to add the custom field. Edit the following properties.

paramName: Create a parameter name using the format L10N_Aame_PROMPT.

objectName: Provide the object name. See the table on page 111 for details about the object name
you need to provide.

attributeName: Provide the attribute name. See the table on page 111 for details about the attribute
name you need to provide.

primaryKey: Set the value as 0.

required: If you want to set the field as required set the value as 0. To make the field mandatory,
set the value 1.

minLength: Set the minimum required characters for the field. If a field is not required, set the
minimum length as 0.

maxLength: Set the maximum allowed characters for the field. The value should not be set more
than the value set while creating the custom attribute.

fieldType: Set the field type.

e For single line text fields, set the value as 1.

® For multi-line text fields, set the value as 2.

e For dropdown fields, set the value as 3.

e For multi-select dropdown list, set the value as 4.

validationString: Provide the expression against which the information provided by the customer
is to be checked. For example, for phone number you can give an expression like,
As*\(2\s*\d{33\s*\)?2\s*x[-.12\s*x\d{3}\s*x[-.1?\sx\d{4}\s*$. And, for email you
can use the expression like, AL0-9a-zA-Z\.\-\_J+\a[0-9a-zA-Z\.\-1+$ - this expression
refers to the format X@Y. Z (john@mycompany.com). For fields that require an integer value, you
need to atleast set the validation string as \\d+8$.

className: Provide the css class you want to use for the field. These are defined in the
callback.css file available in the css folder. You can use an existing class or create a new one.

b. Save the changes.

2. Open the
Cisco_tome\eService\templates\callback\ 7emplate Folder\110n\custom_callback_locale.pro
perties file in a text editor and do the following:
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a. Add the following line in the property file: L10N_~ane_PROMPT = “0Digplay name for the attribute"
Where: L10N_Aame_PROMPT should match the value set in paramName in step 1 on page 112.
b. Save the changes.

3. Clear the browser cache and access the callback link to test the changes. The login page should show the
new fields.

@ Call Me by Cisco - Mazilla Firefox =NECE X

Jenna

Jenna@company.com

Platinum

usa 4239

Custom login form

Adding New Countries

By default United States and United Kingdom are the two countries available on the callback form. You can add
or remove countries from this list.

To add a new county:

1. Open the Cz}:co_Hom\eServ’lce\tempLates\caLLback\TW&_Folder\eGa'inLiveConf'ig.js file
in a text editor.

2. Locate the countryCodes property, and copy a section for one of the existing country and paste it where
you want to add the new country. Edit the following properties:

o name: Create a name like L10n_~Naue

O  value: Provide the country code.

3. Open the
Cisco_tome\eService\templates\ 7emplate Folder\L10n\custom_callback_locale.properties
file in a text editor and do the following:

a. Add the following line in the property file: L10N_~Name= " Country Name" Where: L10N_Aauce should
match the value set in Step 2.

b. Save the changes.
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4. Clear the browser cache and access the call link to test the changes. The call request page should show the
new country.

To remove a country:

1. Open the Cisco_tome\eService\templates\callback\ 7emplate Folder\eGainLiveConfig.js file
in a text editor.

2. Locate the countryCodes property, and select the code for a country and delete it from the file. For
example, to remove United States, and delete the following lines:
{
name: 'L10n_US',

value: '1'°'
}

3. Clear the browser cache and access the call link to test the changes. The call request page should not show
the country removed from the file.

To change the order of countries:

The order of the country codes in the call request form is determined by the order in which the fields are

configured in the eGainLiveConfig. js. To change the order, just move the section for a country in the file to
the new location.

1. Open the Cisco_tome\eService\templates\callback\ 7emplate Folder\eGainLiveConfig.js file
in a text editor.

2. Locate the countryCodes property, and rearrange the country codes. For example, to move United
Kingdom before United States change the order as:

countryCodes : [
{

name: "LTON_UK",
value: "&44"

X,

{

name: "L10N_US",
value: "1"

}

]

3. Clear the browser cache and access the call link to test the changes. The call request page should show the
new order of country codes.
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Enabling Auto-Login

When the callback link is provided in an authenticated section of the website, the auto-login feature can be used
to automatically login the customer for call. When the customer clicks the callback link or button, he is not
displayed the login page.

@ Important: A template where auto-login is enabled should not be used for regular callback.

To enable auto-login:

1.

Open the Cisco_tome\eService\templates\callback\ 7emplate Folder\eGainLiveConfig.js file
in a text editor.

Locate the autoLogin property and set the value to 1 to enable auto-login.
Save the changes.

Change the entry point code so that the customer information collected at the time of login on the website is
passed on to the application when the customer initiates a callback session. For details, see “Adding
Undocked Text Chat and Collaboration Links to a Website” on page 130.

Adding Country Codes

Callback templates can be set to automatically enter the country code for the phone number entered by the
customer using an entry point. Be aware, if a customer includes their country code in their phone number while
the parameter is enabled, the country code is still automatically added to the number, causing a misdial. Disable
the country code parameter to allow customers to enter their own country codes.

To change the country code parameter:

1.

Open the Cz}:co_Hom\eService\templ.ates\cal.l.back\TW@_Polder\eGa'inLiveConf'ig.js file
in a text editor.

Locate the useCountryCode parameter and change it to one of the following:
O 0: The phone number used to place the call does NOT use the country code.

O 1: The phone number used to place the call uses the country code.
Save the changes.

Reload the Callback / Delayed Callback URL entry point web site from the browser.
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Changing the Off Hours Message

An off hours message is displayed to customers when the application is not able to connect to Unified CCE to
place a call.

[a Mozilla Firefox = o S . S|

¢, Call Me

Thank you for your inquiry. Our service
hours are 9am-5pm PST, Monday-Friday.

If you are trying within the service hours
and still getting this message, please try
again after some time.

Off hours message

To change the off hours message:

1. Open the

Cisco_tome\eService\templates\callback\ 7emplate Folder\110n\custom_callback_rocale.pro
perties file in a text editor.

2. Add the property L10N_OFF_HOURS and change the message to be displayed to customers.

3. Save the changes.
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4. Clear the browser cache and access the callback link to test the changes.

@ Moazilla Firefox = | B |

Thank you for your inquiry. Our agents are not
avilable to take calls rightnow.

If you are trying within the service hours and
still getting this message, please try again
after some time.

Custom message

Deleting Template Sets

@ Important: You must delete the templates files from all web servers in your installation.

To delete a template set:
1. On the web server, browse to Cisco_tHome\eService\templates\callback.

2. Delete the template folder that you do not want to use. If you are using these templates for any entry point,
make sure to update the HTML code on web pages with the new template sets you want to use.
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This chapter will assist you in understanding how to set up chat and collaboration entry points.

About Entry Points

An entry point defines the starting point from which customers initiate chat and web callback interactions. Every
help link on a website is mapped to an entry point. Each entry point has a queue associated with it and the queue
is used to route activities to agents. A default entry point is provided in each department.

@ Important: Multiple help links on a website can point to the same entry point.

Creating Entry Points

Before creating an entry point, create the queues and template sets to be used for the entry points. For details on
creating queues, see “Queues” on page 47.

Chat Activities and Callback Activities use two different starting template sets: eGain Kiwi and eGain Callback
Rainbow. For details on creating templates for chat, see “Appendix C: Kiwi Chat Template Sets” on page 242.
For details on creating templates for callback activities, see “Callback Template Sets” on page 101.

Creating Entry Points for Chat

To create an entry point for chat:

1.

2
3.
4

In the top menu, click Apps.
In the left menu, click Chat > Entry Points.
In the Entry Points workspace, click the New button.

The workspace refreshes to show the Create Entry Point page. In the General tab, provide the following
details.

O Entry Point Active: Click the toggle switch to turn the entry point on or off.

5\ Important: For a customer to be able to chat, the entry point mapped to the chat help link should
> be made active, else the customer would be displayed a no service page.

O  Entry Point Name: Type a name of the entry point. This is required information.
O Routing type: This is automatically set to Unified CCE.
O  Subactivity: From the dropdown list, select Chat.

O Queue: Select a queue. This is required information. The queues available can be active or inactive. If
the entry point is marked as active, then an active queue must be selected for the entry point.
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@ Important: An active entry point cannot be mapped to an inactive queue.

O  Apply customer chat single sign-on: Select one of the following options
e No: Disable the entry point for secure chat.

e At the start of chat: Enable secure chat for the entry point and allow customers to authenticate
their accounts using Chat Customer Single Sign-On before the chat activity is first created.

e During chat: Enable secure chat for the entry point and allow customers to authenticate their
accounts using Chat Customer Single Sign-On after the chat activity has begun and while
interacting with an agent.

Secure Chat, utilizing customer single sign-on functionality, allows chat entry points to transfer
customer context information from the company website to the application through SAML. This allows
customers who are already recognized on the company website to use a SSO-enabled entry point to chat
with a customer without having to provide redundant information.

The chat creation request must contain a SAML assertion. If the SAML assertion is missing, or is not
valid for the entry point, chat requests are denied for that entry point. For details about secure chat
configuration, see Enterprise Chat and Email Administrator’s Guide.

O Agent Availability Required: With this option you can decide if the agent availability is to be checked
when a customer initiates a chat session. The following options are available:

e Required: Customers will be able to initiate a chat session only if an agent is available
(Availability setting from the Agent Console is selected) for handling chats. If no agent is available,
the off hours message is shown to customers.

e Not required: Customers will be able to initiate chat sessions even when no agent (Availability
setting from the Agent Console is not selected) is available for handling chats. Customers are not
shown the off hours message and the login page is displayed.
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O Description: Type a brief description.

Create Entry Point

General Options Transcript Notifications
Entry Point Active [ @
Entry Point Name* Sales chats
Routing Type*
Subactivity* Chat ~
Queue* CPG2_CP2 ~
Apply Customer Chat Single Sign- No "
on
Agent Availability Required [ @
Description

= =

Set the general properties

5. In the Options tab, set the following options for the page push feature.

O Enable page pushing from agent to customer: Enable this option to allow agents to send web pages
to customers. By default Yes is selected. Select No to disable it. When page pushing is not allowed, the
Page Push button of the Agent Console is disabled.

You can also control the URLs allowed for page pushing.

a. Enable page pushing from agent to customer: Toggle the option to all agents to send web pages to
customers.

b. Allow/Block page push for below URLSs: Select an option:
e Allow: Only the listed URLs will be allowed for page pushing.
e Block: The listed URLSs will not be allowed for page pushing.
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c. In the List of URLSs section, type the URL. Press Enter and type the next URL.
Create Entry Point
General Options Transcript Notifications

Enable page pushing from agent to (_-
customer

Allow or Block page push for listed Allow
e @) Block
List of URLs
www_blocked_company.com (%]

=3 =

Set page push options

Click the Save button.

After creating the entry point, set the notifications and transcript emails (page 125), test the entry point
(page 124), and add the help link to your website (page 128).

Creating Entry Points for Callback

To create an entry point for callback:

1.

2
3.
4

In the top menu, click Apps.
In the left menu, click Chat > Entry Points.
In the Entry Points workspace, click the New button.

The workspace refreshes to show the Create Entry Point page. In the General tab, provide the following
details.

o  Entry Point Active: Click the toggle switch to turn the entry point on or off.

5\ Important: For a customer to be able to chat, the entry point mapped to the chat help link should
- be made active, else the customer would be displayed a no service page.

O  Entry Point Name: Type a name of the entry point. This is required information.
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O Routing type: This is automatically set to Unified CCE.
O  Subactivity: From the dropdown list, select Callback.

O Queue: Select a queue mapped to a Unified CCE Media Routing Domain that belongs to the
Cisco_Voice Media Class. This is required information. When the subactivity selected is callback and
the routing type selected is Unified CCE, only the queues mapped to a Unified CCE Media Routing
Domain that belong to the Cisco_Voice Media Class are displayed. The queues available can be active
or inactive. If the entry point is marked as active, then an active queue must be selected for the entry
point.

@ Important: An active entry point cannot be mapped to an inactive queue.

O Agent Availability Required: This option is not used for callback activities as availability is
determined in realtime by Unified CCE and not ECE. Activity assignment is also handled by Unified
CCE.

O  Description: Type a brief description.
5. Click the Save button.

After creating the entry point, test it (page 124) and add the help link to your website (page 128).

Creating Entry Points for Delayed Callback

To create an entry point for delayed callback:

» Follow all the steps in the “Creating Entry Points for Callback” on page 122. In Step 3, for the Subactivity
and Queue fields, make sure you set the following values:

O Subactivity: From the dropdown list, select Delayed Callback.

O Queue: Select a queue mapped to Unified CCE Media Routing Domain that belongs to the Cisco_Voice
Media Class. This is required information. The queues available in the list are decided based on the
subactivity and routing type configured for the queue. When the subactivity selected is delayed
callback, only the queues that belong to the Cisco_Voice Media Class are displayed. The queues
available can be active or inactive. If the entry point is marked as active, then an active queue must be
selected for the entry point.

@ Important: An active entry point cannot be mapped to an inactive queue.

Deleting Entry Points

Before you delete the entry point make sure you remove all the chat links related to the entry point from your
website.

@ Important: The default entry point and active entry points cannot be deleted.
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To delete an entry point:

1.
2.
3.

In the top menu, click Apps.
In the left menu, click Chat > Entry Points.

On the Entry Point List page, locate the entry point you want to delete. Hover over the entry point, and
click the Delete button.

Testing Entry Points

After configuring an entry point, you can test it immediately to see how the entry point looks like.

The UI does not display the custom chat or callback templates or languages added for chat. Before you begin this
task, get the list of template names and language files names that you have created on the web server:
Cisco_tHome\eService\templates\chat and Cisco Home\eServiceltemplates\callback.

To test an entry point:

1.

2
3.
4

In the top menu, click Apps.
In the left menu, click Chat > Entry Points.
In the Entry Points workspace, click the entry point you want to test.

On the Edit Entry Point page, click the Entry Point URL button.

%\ Important: If you are creating a new entry point and want to test it, you have to save the entry
»¥ point to be able to test it.

In the Entry Point URL window select the templates and language you want to use for the entry point. This
window only displays out-of-the-box templates and languages. If you have created custom templates or
languages, you will need to edit the entry point URL before you can test it (page 124). The URL is displayed
in the URL for Chat field. Click the Copy URL button to copy the URL.

%\ Important: If you are using the Aqua (docked) template or a custom template made from Aqua
Y (docked) for a docked chat entry point, the entry point HTML must be embedded in a webpage. For
more information, see “Adding Chat and Collaboration Help Links to Websites” on page 128.

If you are using custom templates or languages, change the following parameters in the URL:

Replace both occurrences of aqua or rainbow with the name of your custom template. For example,
PurpleNile.

Change the language code and country code in LanguageCode=en&countryCode=US. For example,
languageCode=it&countryCode=1IT.

The sample chat URL will look like:

http://demo1/pm/templates/chat/PurpleNile/chat.html?subActivity=Chat&entryPoint
Id=1000&templateName=PurpleNile&languageCode=it&countryCode=IT&ver=v11
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7. Open a new browser window and access the entry point URL and test it. To test the entry point with other
templates available in the system, repeat Step 6 and select a different template folder.

Live Chat 2 _ X

Start Chat

A sample chat entry point

Cisco

Setting Up Transcripts and Notifications

@ Important: These features are not available for callback and delayed callback activities.

Sending Transcripts for Serviced and Abandoned Chats

You can email chat transcripts to customers. Transcripts can be sent for both serviced and abandoned chats.
Serviced chats are those chat sessions where the agent joins the chat session at least once (activity substatus
changes to “In Progress”) before the customer exits the session. Serviced chats also include chats that were not
completed successfully because of some error. Abandoned chats are those chat sessions where the customer exits
the chat before the activity substatus changes to “In Progress” at least once. This means the customer leaves the
chat before an agent could attend to him.

In the transcript email that is sent, the chat transcript is placed between the greeting article and the signature
article.

Important: Before you start, make sure you create the header, footer, signature, and greeting KB
Y articles to be used in the chat transcript email.
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To email transcripts of serviced and abandoned chats:

1.

2
3.
4

In the top menu, click Apps.

In the left menu, click Chat > Entry Points.

In the Entry Points workspace, select an entry point.

In the Transcript tab, go the Abandoned chats or Serviced chats section and provide the following details.

o]

If you want to send the chat transcript select the Email the chat transcript to the customer option. If
you select the Do not email a chat transcript to the customer option, all other options will be
disabled.

From: Type the email address to be displayed in the From field of the transcript emails sent to
customers. This is required information. Any replies sent by customers, in response to the chat
transcript emails, go to this address.

To: The transcript emails are sent to the email address provided by customers while initiating chats.
This field cannot be edited.

Subject: Type the subject of the email.

Header: Select a header from the dropdown list.
Greeting: Select a greeting from the dropdown list.
Signature: Select a signature from the dropdown list.
Footer: Select a footer from the dropdown list.

Chat transcript content: Specify what you want to include in the transcript. The following options are
available.

e Include chat messages and URLs exchanged (default value)

e Include only chat messages
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e Include only URLSs exchanged
Edit Entry Paint - Chat with support
General Options Motifications

Abandoned Chats

Do not email a chat transcript to
the customer

Email the chat transcript to the
customer. The chat transcript is
inserted between the greeting and
the signature

From* chat_notification@company.com

To

Subject* A copy of your chat

Header Email header ~
Greeting Email greeting ~
Signature Company signature ~
Footer Email footer ~
Chat Transcript Content Include chat messages and URLs e... ~
Serviced Chats

Send transcript for abandoned and serviced chats

5. Click the Save button.

Setting Up Notifications

Notifications are messages sent to administrators using the messaging infrastructure. You can send a notification
when a chat gets abandoned. Along with notifications, the transcript of a chat can also be sent. Notifications can
be sent to internal users as well as to external email addresses.

The difference between a transcript and a notification is that a transcript is sent to the customer with whom the
chat session is held and a notification is sent to administrators when a chat is abandoned. You can create an entry
point without selecting the option of sending transcript or notification.

To send a notification:

1. In the top menu, click Apps.

2. In the left menu, click Chat > Entry Points.

3. In the Entry Points workspace, click an entry point to view its properties.
4

On the Notification tab, set the following:
O In the Conditions section specify if you want to send notifications for abandoned chats.

O In the Message section, and provide the following details.
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e To: Select to whom you want to send the notifications. You can send notifications to all users in a
department, or you can select from a list of users and user groups. Notifications can be sent as
internal messages or as emails to external email addresses. This is required information.

e Subject: Type a subject for the notification to be sent.
e Message: Type a message in the text box. Use the text box toolbar to format the text.

e Append chat transcript at the bottom of the message: Enable this option if you want to send the
chat transcript with the notification.

5. Click the Save button.

Turning Off Chats in a Department

Use this option to temporarily turn off chats for all entry points for your department.

To turn off active entry points:

1. In the top menu, click Apps.

2. In the left menu, click Chat > Entry Points.

3. In the List pane toolbar, click the Stop New Chats button.
All the active entry points are turned off.

4. Click the Enable New Chats button, to turn on the entry points. When you click the button, it turns on the
active entry points.

Adding Chat and Collaboration Help Links to
Websites

You can view the HTML code, and use it for pointing the chat help hyperlinks and buttons on your website to
open chat sessions. In a web page, chat help can be invoked from either a hyperlink or from a form button, the
HTML window displays code to be used for both these cases.

Adding Docked Text Chat to a Website

Docked chat allows website visitors to interact with customer service without creating additional browser
windows. The docked chat frame always floats on top of the browser window, which lets the visitor continue to
communicate with the agent without having to move between windows.

Docked chat utilizes a different set of templates than typical text chat, audio chat or video chat. For more
information about the docked chat templates, see “Aqua Chat Template Sets” on page 72.

The UI does not display the custom chat templates or languages added for chat or video chat. Before you begin
this task, get the list of template names and language files names that you have created on the web server:
Cisco__Home\eService\templates\chat.
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The following line must be added to the HTML of all pages on which you want docked chat to function:

<script type="text/javascript"
src="http:// WebserverNamel system/templates/chat/egain-chat.js"></script>

To add docked chat to a website:

1.

2
3
4,
5

10.

11.

In the top menu, click Apps.

In the left menu, click Chat > Entry Points.

In the Entry Points workspace, select an entry point.

In the Edit Entry Point page, click the Show HTML button.

In the Show HTML window, select a templates you want to use for the entry point and select the Template
Language from the dropdown list. Custom chat templates and languages are not displayed here. The HTML
for chat field displays the HTML code of the entry point. If you plan to edit it at all, copy it into a text editor
before adding it to the host webpage.

You can only view or copy the HTML in the application. It cannot be edited or deleted in the application. If
you are creating a new entry point and want to view its HTML, you have to first save it to enable the Show
HTML button.

Before adding the code to your website, ensure that you replace the server name in the value of the
egainDockChat.serverURL property with the fully qualified domain name of the web server. If you are
using custom templates and custom languages, change those values as well.

Locate egainDockChat.EntryPointlId and check the value of the property to see if you need to replace
the entry point ID.

Locate egainDockChat.Locale and check the value of the property to see if you need to replace the
language-country codes with custom languages.

Locate egainDockChat.Template and check the value of the property to see if you need to replace the
template name with custom templates.

Locate egainDockChat.UseCustomButton and egainDockChatIsChatLaunched and set the values
to true and if you wish to allow the docked chat entry point to be initiated through a custom button or offer
banner other than “Docked Chat”.

Locate egainDockChat.PostChatAttributes and check the value of the property. By default, it is set
to false. Set to true to enable posting attributes to the template in use. For example, if you wish to set
customer parameters, you can set the following parameters within the chat entry point java script:

egainDockChat.PostChatAttributes = true;

<script language= javascript>
egainDockChat.SetCustomerParameters("full_name","Test");
egainDockChat.SetCustomerParameters("email_address","testatest.com");
egainDockChat.SetCustomerParameters("phone_number","12345");
egainDockChat.SetCustomerParameters("subject","Test");

<script>

After setting these parameters, you need to specify these parameters in application-chat-
defaults.js. For example, to set thefuéé_mme attribute, locate LoginParameters and add the
providerAttributeName as follows:
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{
"providerAttributeName": "full_name",

"secureAttribute": 0,

"eGainAttributeName": "full_name",
"eGainParentObject": "casemgmt",
"eGainChildObject": "individual_customer_data",

"primaryKey": false,
"controlType": "text",

"label": "APP.EG_FULLNAME",
"required": true,

"minLength": "1",

"maxLength": "120",
"validationPattern": "ALAK>T+3$"

}

If you wish to enable secure chat for the entry point, you also need to set the
egainDockChat.PostChatAttributes property to true and add the following:

egainDockChat.SetCustomerParameters("SAMLResponse","")

Secure chat requires this change to the entry point in addition to the chat template. For more details on
configuring the aqua template set for secure chat, see “Configuring Aqua Templates for Customer SSO” on
page 88.

12. Open the code view of the host web page and add the link code at the appropriate point. You may need to
ask your webmaster to perform this task.

Adding Undocked Text Chat and Collaboration Links to a Website

You can view the HTML code, and use it for pointing the chat help hyperlinks and buttons on your website to
open chat sessions. In a web page, chat help can be invoked from either a hyperlink or from a form button, the
HTML window displays code to be used for both these cases.

This section also talks about how to enable auto-login for an entry point and how to show the chat link based on
agent availability.

The UI does not display the custom chat templates or languages added for chat. Before you begin this task, get
the list of template names and language files names that you have created on the web server:
Cisco__Home\eService\templates\chat.

To add undocked chat and collaboration help links to a website:
1. In the top menu, click Apps.

2. In the left menu, click Chat > Entry Points.

3. In the Entry Points workspace, select an entry point.

4

In the Edit Entry Point page, click the Show HTML button.
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10.

In the Show HTML window, select a templates you want to use for the entry point and select the Template
Language from the dropdown list. Custom chat templates and languages are not displayed here. The HTML
for chat field displays the HTML code of the entry point. If you plan to edit it at all, copy it into a text editor
before adding it to the host webpage.

%\ Important: You can only view or copy the HTML. It cannot be edited or deleted. If you are creating
> a new entry point and want to view its HTML, you have to first save it to enable the Show HTML
button.

Before adding the code to your website, ensure that you replace the server name in the value of the
egainChat.serverURL property with the fully qualified domain name of the web server. If you are using
custom templates and custom languages, change those values as well.

Locate egainChat.EntryPointId and check the value of the property to see if you need to replace the
entry point ID.

Locate egainChat.Locale and check the value of the property to see if you need to replace the language-
country codes with custom languages.

Locate egainChat.Template and check the value of the property to see if you need to replace the
template name with custom templates.

Locate egainChat.PostChatAttributes and check the value of the property. By default, it is set to
false. Set to true to enable posting attributes to the template in use. For example, if you wish to set customer
parameters, you can set the following parameters within the chat entry point java script:

egainChat.PostChatAttributes = true;

<script language= javascript>
egainChat.SetCustomerParameters("full_name","Test");
egainChat.SetCustomerParameters("email_address","testatest.com");
egainChat.SetCustomerParameters("phone_number","12345");
egainChat.SetCustomerParameters("subject","Test");

<script>

After setting these parameters, you need to specify these parameters in application-chat-

defaults.js. For example, to set thefwéé_mma attribute, locate LoginParameters and add the
providerAttributeName as follows:

{
"providerAttributeName": "full_name",

"secureAttribute": 0,

"eGainAttributeName": "full_name",
"eGainParentObject": "casemgmt",
"eGainChildObject": "individual_customer_data",

"primaryKey": false,
"controlType": "text",
"label": "APP.EG_FULLNAME",
"required": true,

"minLength": "1",

Chat Entry Points 131



"maxLength": "120",
"validationPattern": "ALAK>I+$"

}

If you wish to enable secure chat for the entry point, you also need to set the
egainChat.PostChatAttributes property to true and add the following:

egainChat.SetCustomerParameters("SAMLResponse","")

Secure chat requires this change to the entry point in addition to the chat template. For more details on
configuring the aqua template set for secure chat, see “Configuring Aqua Templates for Customer SSO” on
page 88 or “Configuring Kiwi Templates for Customer SSO” on page 257.

11. Edit the following parameters of the entry point code:

a. Look for the parameter var refererName. By default, the parameter value is blank. Type in a name
that describes the page that the hyperlink will appear in. In the following example, the name of the page
is “Support.”

var refererName = "Support"

b. Edit the following line to change the text that appears in the hyperlink. By default, it is “Test”.
Substitute the word “Test” for wording which you deem appropriate, such as “Click here to chat with
one of our agents.”

<a href="#" onClick="openHelp()" style=cursor:hand> 7est</a>

12. Locate var eGainChatUrl and check the value of the property to see if you need to replace the template
name, language code, and country codes with custom templates or custom languages.

13. To enable auto-login for an entry point, you need to modify the entry point code so that the customer
information collected at the time of login on the website is passed on to the application when the customer
initiates a chat session. The auto-login feature for the template must be enabled. For details, see “Enabling
Auto-Login” on page 87.

In the link, you need to add the customer details, which are provided by the customer. The name, email, and
question fields are required to initiate the chat. The phone number field is optional.

For example, if the entry point is mapped to a template set which has name, email ID, and phone number as
the login page fields, the following parameters should be added to the URL:
&fieldname_1=<valuel1>&fieldname_2=<value2>&fieldname_3=<value3>. Make sure that the
values of the parameters are encoded in ASCII encoding.

Locate the following lines in the code:
where Name, EmaillD, Phone-number are the customer details collected at the time of login to the website.

14. Open the code view of the host web page and add the link code at the appropriate point. You may need to
ask your webmaster to perform this task.

Adding Callback Links to a Website

This section includes steps about how to enable auto-login for an entry point.

The UI does not display the custom templates or languages added. Before you begin this task, get the list of
template names and language files names that you have created on the web server:
Cisco_tHome\eServiceltemplates\callback.
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To add a callback link to a website:

1.

2
3
4,
5
6

In the top menu, click Apps.

In the left menu, click Chat > Entry Points.

In the Entry Points workspace, select an entry point.

In the Entry Points workspace, select an entry point.

In the Edit Entry Point page, click the Show HTML button.

In the Show HTML window, select a templates you want to use for the entry point and select the Template
Language from the dropdown list. Custom chat templates and languages are not displayed here. The HTML
for chat field displays the HTML code of the entry point. If you plan to edit it at all, copy it into a text editor
before adding it to the host webpage.

%\ Important: You can only view or copy the HTML. It cannot be edited or deleted. If you are creating
> a new entry point and want to view its HTML, you have to first save it to enable the Show HTML
button.

To enable auto-login for an entry point, you need to modify the entry point code so that the customer
information collected at the time of login on the website is passed on to the application when the customer
initiates a callback session. The auto-login feature for the template must be enabled. For details, see
“Enabling Auto-Login” on page 115.

In the link, you need to add the customer details, which are provided by the customer. Callback entry points
require 4 fields be provided: the customer’s name, email address, phone number, and question.

For example, if the entry point is mapped to a template set which has name, email ID, phone number, and
question, as the login page fields, the following parameters should be added to the URL:
&fieldname_1=<valuel1>&fieldname_2=<value2>&fieldname_3=<value3>&fieldname_4=<va
Lue4>. Make sure that the values of the parameters are encoded in ASCII encoding.

Locate the following lines in the code:

var eGainChatUrl =
egainChat.liveServerURL+'/templates/callback/rainbow/call.html?subActivity=Callba
ck&entryPointId=<EntryPointId>&templateName=rainbow&languageCode=en&countryCode
=US&ver=v118&postChatAttributes="+egainChat.postChatAttributes+'&eglvrefname="+r
efererName+'&'+eglvcaseid+vhtlds;

And modify the following line:

var eGainChatUrl =
egainChat.liveServerURL+'/templates/callback/rainbow/call.html?subActivity=Callba
ck&entryPointId=<EntryPointId>&templateName=rainbow&languageCode=en&countryCode
=US&ver=v118&postChatAttributes="+egainChat.postChatAttributes+'&eglvrefname="+r
efererName+'&'+eglvcaseid+vhtIds+'&fieldname_1="+Namet'&fieldname_2="+FmailiD+'&
fieldname_3="+Phonenwmbert'&fieldname_4&="+Question;

where Name, EmaillD, Phone-number, Question are the customer details collected at the time of login to the
website.

Open the code view of the host web page and add the link code at the appropriate point. You may need to
ask your webmaster to perform this task.
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Configuring Auto-Pushback Settings for Chats

The chat auto-pushback feature allows you to pushback chat activities to the queue, if the agents do not click on
the new chats assigned to them in the configured time (default value is 2 minutes). Use these settings to enable
auto-pushback and to define if agents should be made unavailable after a chat is pushed back automatically from
the agent’s inbox.

These changes take effect for all departments in the installation.

To configure auto-pushback settings for chats:

» From the Partition space, configure the following chat auto-pushback settings. For details about doing these
settings, see “Chat Auto-Pushback Settings” on page 63.

O  Enable auto-pushback of chats
o  Expiry time for auto-pushback for chats (minutes)

O Make agent unavailable on auto-pushback of chats

Configuring Dynamic Messages for Chats and
Callback

Dynamic Run Application Script Request (DRASR) allows you to display wait messages with dynamic text
(such as expected wait time) to customers while chat and call requests are being processed by the ECE and
Unified CCE integrated systems. You can use ECC variables and call variables to display the dynamic content.

Dynamic messages can be displayed for integrated chats and callback activities.
Configuring the dynamic messages includes the following steps:

1. Configure the Network VRU scripts in Unified CCE.

2. Identify the queues for which you want to display the dynamic messages.

3. Identify the ECC variables or call variables you want to use in the dynamic message and prepare the macros
for the variables. For details about these objects and how they are used in Unified CCE, see the Scripting
and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted available here:
http://www.cisco.com/en/US/products/sw/custcosw/ps1001/products_user_guide_list.html

4. Configure the dynamic message.

Preparing to Create Dynamic Messages

1. From Unified CCE, configure the Network VRU scripts and use them in the Unified CCE scripts used for
chat activities. You will need the name of the Network VRU script for configuring the dynamic messages.
For details about doing these tasks, see the Enterprise Chat and Email Installation Guide.

2. Identify the integrated chat queues for which you want to display the dynamic messages.
3. To display the dynamic content using ECC variable macros, prepare your macros by doing the following:

a. Look at the chapter “Call Variables” on page 44 for the names of ECC variables that can be used.
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b.

Identify the ECC variables you want to use in the message. The macro will be added in the format
KECC <lariable Name>} . For example, ZECCuser.ece.activity.id%

2\ Important: While selecting ECC variables to be used in macros, make sure that the variables have
: valid values. If you use a variable that does not have a value, a run application script failure will
occur and the customer will not be able to chat. The error template is displayed to the customer.

4. To display the dynamic content using call variable macros, prepare your macros by doing the following:

o

From the Call Variables tab of the queue properties, identify the call variables you want to use in the
message and note down the number associated with the call variable. For example, in the following
figure the number for customer_phone_no is 1 and for activity_id, the number is 2. The macro is added
in the format % CV Nwunberl, . For example, %4CV1% for customer_phone_no.

Configuring Dynamic Messages

To configure dynamic messages:

1.

2
3.
4

In the Partition space in the top menu, click Integration.

In the left menu, click Unified CCE > DRASR.

In the DRASR workspace, click the New button.

Set the following properties for the dynamic message:

Name: The name of the script as it will be identified in the application.

Script name: From the dropdown, select the Network VRU script configured in Unified CCE. A script
can be associated with only one message.

Enabled: Enable the dynamic message.

Display message is URL: Specify if the message is a URL.

@ Important: If enabled, the message must be a valid URL or it will not display properly.

Display message: Provide the message that will be displayed to users upon accessing the entry point. If
you have set the message to be a URL, provide a valid URL. In such cases, only provide the URL in the
message and do not provide any text. A sample text message, with variable macros: An agent is
expected to be available in approximately ZECCuser.wait.time’Z minutes. While
you are waiting, checkout the latest offers on our website.For your record,
please save the case number %CVcase_ID%
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O Description: Description of the script.

Create DRASR

Name* Agent wait message|

Script Name* konscript ~
Enable [ @]

Display Message Is URL [ @]

-

An agent is expected to be available
in approximately
%ECCuserwait.ime% minutes.

Display Message*

Deseription

Create a dynamic message for chat

5. Click the Save button.
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About Chat Messaging API Integration

Chat Messaging APIs can be used to build external integrations with custom messaging apps, messaging
channels like Facebook Messenger, and building custom web templates. The chats created from these Chat
Messaging APIs are routed to agents like regular web chats and have the web chat features available.

The client applications for the integration is setup from the Enterprise Chat and Email Administration console.
In order to use chat messaging APIs, the following must first be performed:

1. Register a client application (page 138).

2. Register a Webhooks Callback URL to receive the chat messages and events (page 138).

3. Associate the client application with a chat entry point (page 142).
4

Create an end to end chat session using the REST APIs: Authenticate Client Application, Get Entry point
Configuration, Start Conversation, Send Chat Message, End Conversation. For more information about these
APIs, see Enterprise Chat and Email Developer’s Guide to Web Service APIs.

Registering Applications

While registering a client application, you must also register a Webhooks Callback URL to receive the chat
messages and events.

To register an application:

1. In the partition-level top menu, click Integration.

2. In the left menu, click Apps > Register Applications.
3. Click the New button.
4

On the General tab, provide the following details.

O Name: Type the name of the application. This is required information. For example, “Messaging App
Integration”.

O Application URL: This field is disabled and cannot be changed.
O  Application Type: This is required information. Select an option from the dropdown:

e  Chat: Select this option to integrate Chat APIs for custom messaging channels, mobile messaging,
and so on.
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O Description: Type a brief description.

Create Registered Application

Genera Callback URL

Name* Messaging App Integration

Application URL Enter Application URL

Application Type* Chat -
Client Key

Enter Client Key

Client Secret o

Description Enter Description

=33

Provide the general information for the client application

5. Click the Callback URL tab. In the Properties pane, on the Callback URL tab, provide the following details.

O Callback URL: The Webhooks Callback URL to receive the chat messages and events. The same
callback URL can be configured for multiple client applications.

O Callback Format: Select the format of the messages or events that are posted to the callback URL.
Options available include: XML and JSON.

o  Callback Error Notification Email Address: Provide the address to which email notifications are sent
if the call to the callback URL fail.

O  Authentication: Select an authentication configuration to use for callback. For more information about
creating authentication configurations, see “App Authentication” on page 140.

Create Registered Application
General Callback URL

Callback URL* https://callback_url.call/ 13hghiadf

Callback Format* JSON -
Callback Error Notification Email

Address* callbackerror@email.com

Authentication v

Provide the Webhooks Callback URL information
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6. Click the Save button. This generates the client key and client secret for the server configuration in the
General tab. If you need to regenerate the client secret and key, click the Regenerate Client Secret button.

App Authentication

Configuring Basic Authentication

To create a basic app authentication configuration:
1. In the partition-level top menu, click Integration.

2. In the left menu, click Apps > Authentication.

3. Click the New button.
4

On the General tab, provide the following details.
O Name: The name for the configuration.
O  Description: A brief description of the configuration.

O Authentication type: Select Basic.

5. Under the Configuration tab, provide the following details:
O User name: The user name for the account the data adapter will use for authentication.
o Password: The password for the account the data adapter will use for authentication.
Create Authentication
Genera Configuration
Name*

Basic Authentication

Basic Authentication Configuration
Description

Authentication Type* pasic -

Provide the general basic authentication details

6. Click the Save button to save your configuration. This configuration can now be used when registering apps
for Callback. For more information, see “Registering Applications” on page 138.

Configuring OAuth 2.0 Authentication

To create an OAuth 2.0 app authentication configuration:
1. In the partition-level top menu, click Integration.

2. In the left menu, click Apps > Register Applications.
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Click the New button.

On the General tab, provide the following details.

Q

o

o

Name: The name for the configuration.
Description: A brief description of the configuration.

Authentication type: Select OAuth 2.0.

In the Properties pane, under the Configuration tab, provide the following details:

o

OAuth2 Clientld: The unique string representing the registration information provided by the service
provider.

OAuth2 ClientSecret: The unique string provided by the service provider that acts as a means of
authorizing a client that is requesting an access token.

Refresh Token: Credentials used to obtain new access tokens when the current access token expires.

Token Request URL: Provide the access token request URL and click OK to close the window. This
field is required.

Method: Select the method in which the access token is retrieved. Select either Post or Get. The
method selected depends on what the client authentication server supports.

Token Request Params: Provide the parameters for the token request body. Format the parameters
string property with variables and values to ensure that correct information is sent in the request.

For example:

client_id=<client_id>&client_secret=<client_secret>&refresh_token=<refresh_t
oken>&grant_type=refresh_token

Access Token JSON Path: The JSON query path of an attribute in the returned JSON response. For
example, $.access_token.

Access Token: If you wish to provide a current access token, enter the string in the field. Leave this
field blank if you do not have an Access Token. New token will be requested by the application using
the provided details.
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O Headers: Provide any necessary additional values to include in the response header by entering a Name
and Value for the corresponding fields. When you have entered the necessary values, click Add button.
Create Authentication
General Configuration
OAuth2 Clientld

5165b846d5adfbvdSbbasd6i8b4bBad1

B8798d4adsBAAFASFEFE458163516a5
d4TAFASFe

QAuth2 ClientSecret

Refresh Token ‘ASFSDFDSFB41f9BasdiDFDFDIES165

https://www_goapis.com/oauth2fvd to
ken

Token Request URL®

Method* POS1 v

client_id=<client_id>&client_secret= A
<glignt,_secret>&reflesh token=<ref |,

Token Request Params
roch_talans

Access Token JSON Path* § access_token

AUy UTEETWYRTE RO TTEuNTwWeTIgue

Access Token nha8edy59udh3to84yethodeuth483 a
64u3hBweht54hyShta v
Headers
Header Name Content-Type Header Value application/x-www-form-urlencoded m
Header Name Header Value

=3 3

Provided the OAuth 2.0 configuration details

6. Click the Save button to save your configuration. This configuration can now be used when registering apps
for Callback. For more information, see “Registering Applications” on page 138.

Creating Messaging Adapters

Once the client application has been registered, along with the Webhooks Callback URL, the messaging adapters
must be created. By creating messaging adapters, you are mapping client applications to a chat entry point.

For more information about registering client applications, see “Registering Applications” on page 138.

To create messaging adapters:

1. In the Department-level top menu, click Apps.

2. In the left menu, click Chat > Messaging Adapters.
3. Click the New button.
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4. In the Create Messaging Adapater workspace, provide the following details.

o

o
o]
o

Q

Name: The name of the adapter.
Description: A description of the adapter.
Type: This is set to ‘External’ and cannot be changed.

Registered Application: Select a registered application from the dropdown. For more information
about registering applications, see “Registering Applications” on page 138.

Chat Entry Point: Select a chat entry point from the dropdown. For more information about registering
applications, see “About Entry Points” on page 119.

Enable Custom Chat Messages: Click the toggle to select the following:
e Disabled: Use default system-generated messages for the adapter.

e Enabled: Configure and provide system messages for the adapter. This enables the Custom
Messages field.

Custom Messages: If Enabled was selected in the Enable Custom Chat Messages field, this field is
enabled. Before uploading custom messages, click the Download Default Messages button to
download the default system-generated messages. Edit this zip file and use these messages as the
template for your custom messages. When you have made the necessary edits to the default messages,
click the Upload Custom Message button and in the window that appears, provide the zip file that
contains the custom messages.

If there are any errors in the custom messages that you have uploaded, the application validates the
messages and notifies you of the errors that need to be corrected.

Create Messaging Adapter

Name* Chat Messaging Adapter

Description

Type

Enter Description

Registered Application* Messaging App Integration v

Chat

Entry point* Chat o

Enable Custom Chat Messages*

Custom Messages®

Download Default Messages m Save

Provide the details for the messaging adapter

5. Click the Save button.
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Post Integration Configuration

Once you have registered the client application, added the callback URL, and configured messaging adapter, you
must use the Chat Messaging APIs to build the integration. For more information about Chat Messaging APIs
see the Enterprise Chat and Email Developer’s Guide to Web Service APIs. For more information about the post-
configuration process, see also the following diagram.

Integrator

Authenticate Client Application
#Bearer token

Setup ——=
Get chat enirvooint configuration

#masking pattemns, setfings efc.

Start conversation Customer message

#conversation ID

Webhook APl [messages, attachments etc.)

Agent Message
Response
Send Message (conversation ID) Customer message
Chat
conversation Webhook API
Agent Message
Response

Send Message (conversafion iD) Customer message

End Conversation (conversafion ID)

—

With the client application registered and the messaging adapter created, you can follow the integration flow

144  Enterprise Chatand Email Administrator’s Guide to Chat and Email Resources



Assets for Email

» Email Settings

» Managing Articles



This chapter describes the various settings available for emails. It also explains how to create headers,
footers, greetings, signatures, and auto-acknowledgements for email activities.

Email Settings

Incoming Email Settings

Number of Emails to Retrieve

Use this setting to define the maximum number of emails to be picked by the Retriever Service for
processing.

» Type: Partition setting
» Default value: 10
»  Minimum value: 10

» Maximum value: 250

Maximum Email Size for Retriever (MB)

Use this setting to define the maximum size of emails that the Retriever Service can retrieve from the Mail
Server. This size includes the email subject, body (text and HTML content), header, and attachments. For
example, if the value of the setting is 1 MB, and an email with 1 MB content comes in, this email will not
be retrieved, as the size of the email is greater than 1 MB because of headers and both text and HTML parts
of email. If the email size exceeds the number specified in this setting, the email is either skipped or deleted,
and a notification is sent. This action is defined in the “Action for Large Email” setting.

» Type: Partition setting
» Default value: 16
» Minimum value: 2

» Maximum value: 35

Maximum Body Size for Retriever (KB)

Use this setting to define the maximum size of the email body that the Retriever Service can retrieve from
the Mail Server. This size does not include the header and attachments. If the body size exceeds the size
specified in this setting, the body is saved as a text file and is attached to the email. A note is added to the
email body that the original email content is available as an attachment. This note can be changed from the
“Message note for large body” setting.



» Type: Partition setting

» Default value: 1000 KB

» Minimum value: 100 KB

» Maximum value: 1000 KB

Message Note for Large Body

Use this setting to change the message added to emails, which exceed the allowed maximum body size for
incoming emails.

» Type: Partition setting

» Default value: Email body was too large. It is saved as an attachment

Action for Large Email

Use this setting to decide what should be done with large emails coming in the system. An email is considered
as large if it exceeds the size specified in the “Maximum email size for retrieval” setting.

» Type: Partition setting
»  Default value: Skip and notify

» Value options:
O  Skip and Notify: Retriever skips the email and notifies the administrator about the same.

O Delete and Notify: The email is deleted from the mail server and a notification is sent to the
administrator.

Outgoing Email Settings

Maximum Body Size for Dispatcher (KB)

Use this setting to define the maximum body size of an outgoing email. This size considers only the email body
size and excludes the email attachments. The system will not allow agents or workflows to create outgoing
emails whose body size is larger than this setting value. Users are notified while composing email from the
Agent Console, and while configuring workflows from Administration Console. If a system generated email
(auto-acknowledgements, for example) exceeds this size, the email will not be sent and a notification is sent to
the email address configured in the “To: address for notification from Services” setting.

» Type: Partition setting
» Default value: 100
»  Minimum value: 100

»  Maximum value: 1000
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Maximum Email Size for Dispatcher (MB)

Use this setting to define the maximum size of an outgoing email. This size includes the body of the email and
the attachments. The system will not allow agents or workflows to create outgoing emails whose size is larger
than this setting value. Users are notified while composing email from the Agent Console, and while configuring
workflows from Administration Console. If a system generated email (auto-acknowledgements, for example)
exceeds this size, the email will not be sent and a notification is sent to the email address configured in the “To:
address for notification from Services” setting.

Note: The value of this setting should be 40% less than the email size configured on the SMTP server. This
buffer is needed because email data (content and attachments) is encoded before an email is sent out by the
SMTP server. For example, if the size configured on SMTP is 10 MB, the value of this setting should be 6 MB.

» Type: Partition setting
» Default value: 25
» Minimum value: 1

» Maximum value: 150

To: Address for Notifications From Services

DSM sends out notifications when any error occurs in the functioning of services (example, retriever, dispatcher,
etc). Use this setting to specify the email address to which notifications are sent by the DSM.

» Type: Partition setting

From: Address for Notifications From Services

DSM sends out notifications when any error occurs in the functioning of services (example, retriever, dispatcher,
etc). Use this setting to specify the email address displayed in the “from” field of the notifications sent by the
DSM.

» Type: Partition setting

Notification Mails Auto BCC

DSM sends out notifications when any error occurs in the functioning of services (example, retriever, dispatcher,
etc). Use this setting to specify the email address that will be sent notification emails, but remain hidden to other
recipients.

» Type: Partition setting

Default SMTP Server Settings

For various objects in the system, you can configure notifications to be sent to administrators. Some of the
objects for which you can configure notifications are, Monitors (in the Supervision Console), Reports (in the
Reports Console), Alarm workflows (in the Administration Console), Abandoned chats. The address to which
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these notifications are sent, is specified in the properties of the object and the from email address is specified in
the “From: address for notifications from services” setting.

Configure the settings described in this section for the server to send notifications to administrators. To view or
configure the default SMTP server settings, click the Assistance button in the Value field of the setting.

Server type

In this setting select the protocol (SMTP or ESMTP) to be used for the server.
» Type: Partition setting

» Default value: Never

» Value options: Never, If authentication fails

Use SMTP

If the “Server type” setting is set to ESMTP, to be used for the server.
» Type: Partition setting

» Default value: SMTP

» Value options: SMTP, ESMTP

Server name
In this setting provide the name of the server.

» Type: Partition setting

User name (ESMTP)

If the “Server type” setting is set as “ESMTP”, provide the user name to be used to connect to the mail server.

» Type: Partition setting

Password

If the “Server type” setting is set to “ESMTP”, provide the password to be used to connect to the mail server.
Verify the password in the field immediately below.

» Type: Partition setting

Connection type

Select the authentication connection type for the server to use.
» Type: Partition setting

»  Default value: Plain text

» Value options: Plain text, SSL, TLS
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Port

In this setting provide the default port of the SMTP server. The value of the setting cannot be changed from the
UL Note: The port value changes based on the connection type.

» Type: Partition setting
» Subtype: Default SMTP Server

» Default value: 25

Workflow Settings

From Email Address for Alarm
Use this setting to configure the email address to be displayed in the “From” field of alarm notifications.
» Type: Department setting

» Can be reset at lower level: No

Include Original Message for Auto Acknowledgement

Use this setting to include the content of incoming emails in the auto-acknowledgement sent to customers in
response to the incoming emails.

» Type: Department setting
» Default value: Enable
» Value options: Disable, Enable

» Can be reset at lower level: Yes

Auto Response Number

Use this setting to define the number of auto-acknowledgements to be sent to a customer in a specified time
duration. The time duration is configured through the “Auto response time” setting. For example, if the value in
this setting is three and a customer sends four emails in one hour (time duration configured through the “Auto
response time” setting), the customer will get auto responses to three emails only.

» Type: Partition setting
» Default value: 3
»  Minimum value: 3

»  Maximum value: 100

Auto Response Time

In this setting define the time duration (in minutes) to be considered to decide the number of auto responses to
be sent to a customer.
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» Type: Partition setting
» Default value: 1440
»  Minimum value: 360

» Maximum value: 1440

Set “From” Email Address for Email Activities Transferred Between
Departments

This setting determines how the from email address is set for the email activities that are transferred to the
department from other departments. Administrators can choose from the following options:

O Do not change: The original email address set in the From field is retained.

O  Use default alias of destination department: The From email address is set to the default alias
configured for the department. Make sure that a default alias is configured for the department.

O Force agents to select “From” email address: The value of the “From” field is reset to “Please select
an email address” and agents are required to pick the From address while sending out the email.

» Type: Department setting
» Default value: Do not change

» Value options: Do not change, Use default alias of destination department, Force agents to select “From”
email address

» Can be reset at lower level: No

Main Inbox Settings

Inbox Sort Column

In this setting, define the column that is used to sort items in the Activity and Cases folders in the Agent
Console. Use the “Inbox sort order” setting to define whether the items are sorted in the ascending or descending
order. This setting does not apply to the Chat Inbox. For chat, use the Chat - Inbox Sort Column setting.

» Type: Department setting, User setting
»  Default value: Activity ID

» Value options: Activity ID, Activity Priority, Case ID, Contact point, Department name, Subject, When
created, Activity type, Activity sub status

» Can be reset at lower level: Yes

Inbox Sort Order

Use this setting to define the order - ascending or descending, in which items appear in the Activity and Cases
folders in the Agent Console. Use the “Inbox sort column” setting to determine the column by which items are
sorted. This setting does not apply to the Chat Inbox. For chat, use the Chat - Inbox Sort Order setting.

» Type: Department setting, User setting
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» Default value: Ascending
» Value options: Ascending, Descending

» Can be reset at lower level: Yes

Email - Enable Sound Alert

Use this setting to define if you want the system to play a sound when an email is assigned to the agent. To
minimize distraction, the alert sounds only when the focus is not in the main inbox.

» Type: Department setting
» Default value: Yes
» Value options: No, Yes

» Can be reset at lower level: No

Alert Agent When Activity Is Assigned

Use this setting to decide if an alert should be displayed to agents when new activities are assigned to them. If
the Agent Console is minimized, or not in focus, an alert is displayed in the bottom right hand side section of the
screen. This setting does not apply to chat activities.

» Type: Department setting, User setting
» Default value: Always

» Value options:
O Never: Activity is displayed in the Inbox, but no alert is displayed to agents.
O Always: An alert is displayed every time an activity is assigned to the agent.

O When the agent has no open activity: The alert is displayed only when the agent has no activities in the
inbox.

» Can be reset at lower level: Yes

Alert Subject

Notifications can be sent to users when new activities are assigned to them. Use this setting to configure the
subject of these notifications.

» Type: Department setting
» Default value: You have received a new activity

» Can be reset at lower level: No

Alert Body

Notification can be sent to users when new activities are assigned to them. Use this setting to configure the
message displayed in these notifications.

» Type: Department setting
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» Default value: You have received a new activity (id = ““activity_id) from customer identified by
““contact_point_data

» Can be reset at lower level: No

Send Agent an Email When Activity Is Assigned

Use this setting to decide if an email notification should be sent to agents when new activities are assigned to
them. This setting does not apply to chat activities.

» Type: Department setting, User setting
» Default value: Never

» Value options:
O Never: Email notifications will not be sent.
O When Logged In: Email notifications will be sent only if the agent is logged in.
O  When not Logged in: Email notifications will be sent only if the agent is not logged in.

o Always: Email notifications will always be sent whether the agent is logged in or not.

» Can be reset at lower level: Yes

Add Contact Point on Compose

In this setting you can decide if the email address specified in the To field of a composed email activity should
be added to the customer profile associated with the case to which the activity belongs.

» Type: Department setting
» Default value: Yes
» Value options: Yes, No

» Can be reset at lower level: No

Language Detection Threshold (KB)

Use this setting to define the amount of data that is required to be present in activity before the application is able
identify the language of the activity.

» Type: Partition setting
»  Default value: 10
»  Minimum value: 1 KB

» Maximum value: 1024 KB

Force Activity Categorization

Use this setting to ensure that agents assign categories to each activity before completing it. This setting does not
apply to chat activities. For chat, use the Chat - Force Activity Categorization setting.

» Type: Department setting
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» Default value: No
» Value options: No, Yes

» Can be reset at lower level: No

Force Resolution Code

Use this setting to ensure that agents assign resolution codes to each activity before completing it. This setting
does not apply to chat activities. For chat, use the Chat - Force Resolution Code setting.

» Type: Department setting
» Default value: No
» Value options: No, Yes

» Can be reset at lower level: No

Pick and Pull Settings

Maximum Activities to Display for Pull

Use this setting to specify the maximum number of activities that are displayed in the Pick activities window in
the Agent Console.

» Type: Partition setting
» Default value: 50
» Minimum value: 1

»  Maximum value: 100

Maximum Activities to Pull at a Time

This setting determines the maximum number of activities that are assigned to an agent when he clicks the Pull
button in the Agent Console.

» Type: Department setting, User setting
» Default value: 10

» Minimum value: 1

» Maximum value: 25

» Can be reset at lower level: Yes
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Blocked Attachments Settings

Email - Criteria for blocking attachments

Use this setting to configure the criteria for blocking attachments. You can choose to block attachments for
incoming emails, or for both incoming and outgoing emails.

%\ Important: After changing the value of the setting, you need to restart all retriever instances in
' the system.

» Type: Department setting
»  Default value: Inbound emails only
» Value options: Inbound email only, Both inbound and outbound emails

» Can be reset at lower level: No

Block All Attachments

Use this setting to block all attachments coming in the system.

o\ Important; After changing the value of the setting, you need to restart all retriever instances in
' the system.

» Type: Department setting
» Default value: No
» Value options: Yes, No

» Can be reset at lower level: No

Action on Blocked Attachments

Use this setting to decide what should be done with all the block attachments. You can either save the
attachments in the Cisco_Home\eServicelstorage\1\maillattachments folder or you can delete them.

5\ Important: After changing the value of the setting, you need to restart all retriever instances in
' the system.

» Type: Department setting
» Default value: Quarantine

» Value options:

O Quarantine: The attachment is saved in the Cisco_ Home\eService\lstorage\1\maillattachments
folder and a notification email is sent to the administrator.

O Delete: The attachment is deleted.

» Can be reset at lower level: No
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Autopushback Settings

Enable Autopushback

Use this setting to enable the auto-pushback feature for your department. Auto-pushback helps you to
automatically pull back activities from logged out agents and assign these activities to other available agents.
Pinned activities are not candidates for auto-pushback. Along with this setting, make sure you configure the time
duration after which an activity should be considered for pushback and the criteria for activities to be pushed
back from the agent’s inbox. Note that these auto-pushback settings apply to the following activities - inbound
emails associated with queues, supervisory activities associated with queues, tasks associated with queues, and
custom activities associated with queues. The following activities are not considered for auto-pushback - rejected
supervisory activities, drafts, pinned activities, locked activities, and outbound emails.

4

4

»

»

Type: Department setting
Default value: Enabled
Value options: Disabled, Enabled

Can be reset at lower level: No

Activity Type for Autopushback

In this setting, determines the criteria for automatically pulling back activities from the agent’s inbox.

»

4

4

Type: Department setting, User setting
Default value: New activities only

Value options:
O None: No activities will be pushed back to the queues.
O New activities only: Only activities with substatus “New” will be pushed back to the queues.

O  Both new and incomplete activities: All the activities will be pushed back to the queues.

Can be reset at lower level: Yes

Autopushback Time (Minutes After Logout)

In this setting, define the time duration after which an activity is pulled back from an agent and is sent back to
the original queue to be reassigned to another agent.

4

4

4

Type: Department setting, User setting
Default value: 30

Minimum value: 0

Maximum value: 21600 (15 Days)

Can be reset at lower level: Yes
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Managing Articles

Before configuring queues for workflows, knowledge resources should be mapped to the queues. Short and
simple articles (no more than 500 characters long) can be assigned to queues, or implemented in workflows to
assist agents and improve response time. These articles serve a specific purpose, depending on the channel for
which they are created.

Aside from auto-acknowledgements, these articles are accessible by agents in the Agent Console, based on the

activity on which they are working. Once selected, agents can then use the articles in their replies.

>

For Email activities, the standard articles are:

O Headers, Footers, Signatures, and Greetings: Short introductory and closing statements or images
that agents can use in their responses to customers. After creating the articles associate them with a
queue. When an email from the queue is assigned to the agent, the text of the articles is automatically
added to the text editor in the Reply pane.

O Auto-Acknowledgements: Messages that can be created and used in inbound workflows as a reply that
is automatically sent to customers at the time an email enters the workflow. These articles are only used
in workflows and cannot be accessed from the Agent Console. For more information on how to use
auto-acknowledgements in workflows, see “Configuring the Auto-Acknowledgement Node” on
page 204.

It is important to note that the headers, greetings, footers, and signatures must be mapped to a queue. Only
the mapped articles are made available in the Agent Console. For more information, see “Editing Queues”
on page 51.

Changing Language

To change the language:

1.
2.

In the department level top menu, click the Apps option.

In the Left menu, navigate to Email > Auto-Acknowledgements, Headers, Footers, Signatures, or
Greetings.

From the Actions button, select the Change Language option.

In the Change Language window, select from the languages assigned to you. The articles are displayed in
the selected languages.

Creating Articles

To create an article:

1.
2.

In the department level top menu, click the Apps option.

In the Left menu, navigate to Email > Auto-Acknowledgements, Headers, Footers, Signatures, or
Greetings.

In the workspace, click the New button.

On the Create page, provide the following:
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O Name: A name for the article.
O Description: A description of the article.

O Language: The language of the article. This is set to the language in which you are accessing the
articles and cannot be changed. For more information about changing the access language, see
“Changing Language” on page 157.

Create Auto Acknowledgement

Content Attachments

Name* Auto Acknowledgement - one day SLA

Description

Language

sample auto-acknowledgement

5. Add the content of the article in the Content tab.

Create Auto Acknowledgement

General Content Aftachments
ot % | Blsouce| = M A||B I U A- B-| O @ =
Normal - || Font -|| size ~|| = 3= QY

Thank you for your email We will contact you with an update on your query in one business day |

body p A

Notes Previ

Create content
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6. Add attachments to articles from the Attachments tab.

7. Click the Save button.

Deleting Articles

@ Important: Articles cannot be deleted if they are used in a queue or workflow.

To delete an article:
1. In the department level top menu, click the Apps option.

2. In the Left menu, navigate to Email > Auto-Acknowledgements, Headers, Footers, Signatures, or
Greetings.

3. From the Actions field, select the Delete option.

Copying Articles

To copy an article:
1. In the department level top menu, click the Apps option.

2. In the Left menu, navigate to Email > Auto-Acknowledgements, Headers, Footers, Signatures, or
Greetings.

3. From the Actions field, select the Create Copy option. The page to create the article opens with the
description, content, and attachments copied from the original article.

Previewing Content

To preview content:
1. In the department level top menu, click the Apps option.

2. In the Left menu, navigate to Email > Auto-Acknowledgements, Headers, Footers, Signatures, or
Greetings.

3. From the List, click the article you want to preview.
4. On the edit page, click the Preview button.

The preview window shows the content.

Adding and Viewing Notes

To add and view notes:

1. In the department level top menu, click the Apps option.
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2. In the Left menu, navigate to Email > Auto-Acknowledgements, Headers, Footers, Signatures, or
Greetings.

3. From the list page, click the article you want to add notes to.
4. On the edit page, click the Notes button.

5. In the View Notes window, add new notes and view or delete existing notes.
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This chapter will assist you with setting up aliases.

About Aliases

Aliases are business objects in the application that map to email addresses that customers use to contact your
company. They function as entry and exit points for emails processed by the system, and are configured almost
like an email client. Design your aliases in such a way that they become the first step in meaningfully separating
the different types of inquiries received by your company. For example, a bank may decide to create separate
email addresses for inquiries about the different kinds of services they provide, such as accounts, home loans, car
loans, mutual funds, etc. This bank would create the following email addresses, and corresponding aliases:
accounts @yourbank.com, loans @yourbank.com, mfunds @ yourbank.com and so on.

Once an alias is configured, the Retriever Service is set up to retrieve emails that arrive at the email server, and
bring them into the system. Workflows then act on them to create activities, send auto-responses, set service
levels and route activities to queues and agents. For more information about workflows and routing, refer to the
Enterprise Chat and Email Administrator’s Guide to Routing and Workflows.

Basic authenticated email aliases can be added to email accounts to convert them to OAuth authenticated aliases.
For more information, see “Email Accounts” on page 168.

Creating Aliases

Before you create an alias, verify that the corresponding email address has been created on the email server. You
will require the server type, server name, and user name and password for the email account, while creating the
alias.

To create an alias:

1. In the Department-level top menu, click the Apps option.
2. In the left menu, navigate to Email > Aliases.

3. Click the New button.
4

In the General tab and provide the following details.
O Name: Type the name of the alias. This is required information.

O Email address: Type the email address for the alias. This is required information. The email address
you provide here should be first created on the incoming email server.

O  Status: Select the status of the alias. By default the status of an alias is set as active. For more details,
see “Changing the Status of Aliases” on page 167.

O  Default alias: Click the toggle switch to set the alias as the default alias for the department. When an
agent composes a new email, the default alias is selected as the From address for the email. The default
email address is also used for activities transferred to this department from other departments, if the
value of the setting ‘Set “From” email address for email activities transferred between departments’ is
set to “Use default alias of destination department”. For details about the setting, see Enterprise Chat
and Email Administrator’s Guide.
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%\ Important: The default alias should be an active alias. Only one alias can be set as the default
: alias for each department.

O  Description: Type a brief description of the alias.

O Automatic BCC: Type the email address to which you want to send a BCC copy of the email. Only one
BCC address may be used. Whenever an email is sent out from this alias, a BCC copy of that email is
automatically sent to this address. You can use this option when you want to review later the replies sent
out from a particular alias.

O Send mail to: Use this field to specify an email address to which all outgoing emails from this alias
should be sent. If a value is entered in this field, no outgoing email from this alias will reach its original
intended recipient. When an agent replies to a customer email, the reply is sent to the email address
specified in this field, and not to the customer’s email address. Enter values in this field only while
testing the system. Make sure that after testing the alias, you clear the values in this field.

7\ Important: If you provide email addresses in both the Automatic BCC and Send mail to fields, the
Y email is sent only to the address given in the Send mail to field.

O Redirection Email Addresses: If you are redirecting emails from other email addresses to this alias,
then provide the list of those addresses. Separate the list of addresses using a semicolon. While replying
to emails, in the From field, agents will by default see the redirection email address from where the
email came in the system.

Create Alias
General Servers
Name* Customer Support Alias
Email Address Support@company.com
Status® [ @)
Default Alias
Description

Automatic BCC
Send Email To

Redirection Email Addresses

Corea Json

Set general properties

5. In the Servers tab and provide the details of the incoming and outgoing servers to be used for the alias.
O In the Incoming section, provide the following details. All the fields are required.

e Server type: Select the server type you want to use. By default POP3 is selected. The options
available are POP3 and IMAP.
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e Server name: Type the name of the server.

e User name: Type the user name of the email account.
e Password: Type the password of the email account.

e Verify password: Verify the password.

e Connection type: Select one of the following options. Note: The port value changes based on the
connection type.

e Plain text: Set the retriever service to work with a mail server that does not use SSL or TLS
authentication.

® SSL: Enable the retriever service to work with an SSL enabled mail server.
e TLS: Enable the retriever service to work with an TLS enabled mail server.

e Port: Provide the port used by the services server to connect to the IMAP or POP3 server. The field
is pre-filled with a port number based on the type of server and configuration selected. The default
ports are:

POP3, with Plain text: 110
POP3, with SSL: 995
POP3, with TLS: 995
IMAP, with Plain text: 143
IMAP, with SSL: 993
IMAP, with TLS: 993

e Folder: The folder from which emails are fetched. By default, “inbox” is selected. This can be
changed to a different folder if IMAP protocol is selected.

Create Alias
General Servers
Incoming
Server Type POP3 v
Server Name* 10.10.10
User Name* administrator

Password*
Verify Password

Connection Type Plain Text ~
Port* 110

Folder*

=1

Configure incoming server

O Next, in the Outgoing section, provide the following details:
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Server type: Select the server type you want to use. By default SMTP is selected. The options
available are SMTP and ESMTP.

Server name: Type the name of the server.

The following three options are enabled only if the server type is set as ESMTP in the Server type field.

User name (ESMTP): Type the user name.
Password: Type the password.
Verify password: Verify the password.

Use SMTP: If your server type is ESMTP, then you can optionally use the SMTP server when the
ESMTP server authentication fails. Select Never if you do not want to use the SMTP server. The
options available are Never and When authorization fails. This field is enabled only if the server
type is set as ESMTP in the Server type field.

Connection type: Select one of the following options. Note: The port value changes based on the
connection type.

o Plain Text: Set the dispatcher service to work with a mail server that does not use SSL or TLS
authentication.

e SSL: Enable the dispatcher service to work with an SSL enabled mail server.
e TLS: Enable the dispatcher service to work with an TLS enabled mail server.

Port: Provide the port used by the services server to connect to the SMTP or ESMTP server. The
field is pre-filled with a port number based on the type of server and configuration selected. The
default ports are:

SMTP, with Plain text: 25
SMTP, with SSL: 465
SMTP, with TLS: 587
ESMTP, with Plain text: 25
ESMTP, with SSL: 465
ESMTP, with TLS: 587
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Create Alias

General Servers

Qutgeing
Server Type SMTP v
Server Name® 10.10.10

User Name (ESMTP)*

Password*

Verify Password®

Use SMTP

Connection Type Plain Text ~

Port* 25

=3 =

Configure outgoing server

Click the Save button.

After creating an alias, add the new alias to a retriever service instance. Then, restart the retriever service
instance. Now, use the alias in an inbound workflow. For more details on workflows, see “Workflows” on
page 190.

Deleting Aliases

Messages sent to a deleted alias are not received by the system even if the email address to which it maps
continues to exist on the mail server.

You cannot delete an alias, if:

4

4

It is configured as the default alias.
It is associated with a retriever service instance.
It is used in an inbound workflow.

If any replies are sent out from a deleted alias, they go out using the default SMTP preferences. For this,
make sure you have set the following six default SMTP settings at the global level. For more information
about working with settings, see “Assets for Email” on page 145.

Default SMTP Server
Default SMTP protocol
Default SMTP Port
SMTP Flag
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» Default SMTP user name
» Default SMTP password

If these settings are not configured, replies from deleted aliases are not sent out to customers.

To delete an alias:

1. In the Department-level top menu, click the Apps option.

2. In the left menu, navigate to Email > Aliases.

3. In the list, hover your mouse over the alias you wish to remove and click the Delete button.
4. A message appears asking to confirm the deletion. Click Yes to delete the alias.

When you delete an alias, the Retriever Service and Dispatcher Service instances associated with that alias
need to be restarted for the changes to take effect.

Changing the Status of Aliases

Administrators can change the status of an alias. The system can also automatically set an alias to be active or
inactive. The retriever tries to connect to an alias three times, and after the third failed attempt, it makes the alias
inactive.

For the following two conditions, the retriever makes an alias inactive and then tries to connect to the alias after
ten minutes. If it is able to connect, the retriever makes the alias active again and starts retrieving emails.

» POP3 server is not available because of a problem with the network, or if the server appears to be stopped.
» A user is logged in to the mailbox through telnet or through another external email client.

For the following two conditions, the retriever makes the alias inactive and does not try to connect again. The
administrator has to manually fix the problem, and make the alias active.

» POP3 or IMAP service is not started on the POP3 or IMAP servers.

» The authentication details provided for the alias are incorrect.

To change the status of an alias:

1. In the Department-level top menu, click the Apps option.
2. In the left menu, navigate to Email > Aliases.

3. Select an alias.
4

In the General tab and change the status of the alias by clicking the toggle switch in the Status field.

o If set to active, the retriever retrieves incoming emails from this alias and the dispatcher dispatches
outgoing emails from the alias. By default the status of an alias is set as active.

O If you make an alias inactive, the retriever does not retrieve incoming emails from this alias, but the
dispatcher dispatches outgoing emails from the alias.

5. Click the Save button.
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About Email Accounts

You can use the OAuth 2.0 authentication service (provided by Azure Active Directory) to enable your
application to connect with IMAP, POP or SMTP protocols to send and receive emails in a more secure way.
Email accounts allow you to create or add OAuth authenticated aliases. These email accounts are associated with
the OAuth applications registered with Microsoft Azure Active Directory.

To use the OAuth 2.0 authentication for email, perform the following tasks:

1.
2.
3.

Register your application with Azure Active Directory (page 169).
Configure an OAuth application in the Administration Console (page 171).

Configure an email account and add email aliases to it (page 173).

—. Important: While configuring an email account, in order to communicate to the mailbox, you need
'/ to ensure that the following URLs have been provided accessibility and connectivity from the
Application server and Services server: *.office365.com and *login.microsoftonline.com.

Test connection for the email account (page 176).

Registering Applications with Azure Active Directory

Before using OAuth 2.0 authentication with your application, you must register your application with Azure
Active Directory. Once the registration is complete, you will get the client ID, tenant ID and Value of the client
secret. For more information, see Register an application with the Microsoft identity platform.

You need to perform the following tasks:

»

4

4

Register an application on the Azure portal (page 169).
Add a client secret (page 170).

Assign API permissions to the registered application (page 171).

Registering an Application

To register an application with Azure Active Directory:

1.

2
3.
4

Sign in to the Azure portal.
Search for and select Azure Active Directory.
Under Manage, select App registrations > New registration.

In the Register an application page, provide the following details:
O Name: Provide a user-facing display name for the application.

O  Supported Account Types: Select the Accounts in this organizational directory only (Single
tenant) option.
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O  Redirect URL: Provide the Redirect URL in the following format:
https://ECE _Web Server or lLoad, Balancer Sevver/Context Naumelweb/view/mail/admin/accou
nt/showauthcode. jsp. For example,
https://sample.company.com/system/web/view/mail/admin/account/showauthcode.j
sp. This is the URL of the page where the authorization code is generated after successful
authentication.

Click Register.

The Overview pane opens after the application is registered. The following information is displayed for the
registered application:

O Application (client) ID (also called the client ID): This value uniquely identifies your application in
the Microsoft identity platform.

O Directory (tenant) ID (also called the tenant ID)

— Important: Record the client ID and tenant ID. This information is used while configuring the
>/ OAuth Application in the Administration Console (page 171).

Adding Client Secret

A client secret is a secret string that is used by the application to prove its identity when requesting a token.

To add a client secret:

1.
2.
3.

Sign in to the Azure portal.
Search for and select Azure Active Directory.

Under Manage, click App registrations and select the application that you registered with Azure Active
Directory (page 169).

Now, under Manage, select Certificates & secrets > New client secret.
In the Add a client secret page, provide the following details:
O  Description: Add a description for your client secret.

o  Expires: From the dropdown, select an expiration for the secret or specify a custom lifetime. You can
select from the following options:

e Recommended: 6 months
e 3 months

e 12 months

e 18 months

e 24 months

e Custom: You can provide a custom start and end date.

— Important: Client secret lifetime is limited to two years (24 months) or less. You cannot specify a
@ custom lifetime longer than 24 months.

6. Click the Add button.
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The client secret Value and Secret ID is displayed.

— Important: Record the Value of the client secret as it is masked after you leave the page. This
@ information is used while configuring the OAuth Application in the Administration Console
(page 171).

Assigning AP|l Permissions

To assign API permissions:
1. Sign in to the Azure portal.
2. Search for and select Azure Active Directory.

3. Under Manage, click App registrations and select the application that you registered with Azure Active
Directory (page 169).

4. Now, under Manage, select API Permissions > Microsoft Graph > Delegated permissions.
5. In the Request API page, select the following delegated permissions:

O IMAP.AccessAsUser.All

O Mail.Read

O Mail.Read.Shared

O Mail.ReadWrite

O Mail.ReadWrite.Shared

O Mail.Send

O Mail.Send.Shared

O offline_access

POP.AccessAsUser.AlL
SMTP.Send

O User.Read

6. Click the Update Permissions button.

Configuring OAuth Applications

After registering your application with the Azure Active Directory, configure your application details in the
Administration Console.

To configure an OAuth application:
1. Sign in to the legacy ECE Administration Console as a partition administrator.
2. In the Tree pane, browse to Administration > Partition: rastition Name > Email > OAuth Applications.

3. In the List pane toolbar, click the New button
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5.

In the Properties pane, provide the following details:
O Name: The name for the configuration.
Description: Provide a brief description.
Provider: Select Microsoft Office 365.
Endpoint: Select Worldwide.

o O O O

Tenant ID: Provide the tenant ID assigned by Azure Active Directory. For more information
see, “Registering an Application” on page 169

O  Client ID: Provide the client ID assigned by Azure Active Directory. For more information
see, “Registering an Application” on page 169

O Client Secret: Provide the Client secret value. For more information see, “Adding Client Secret” on
page 170

General

Name Value
®  MName* email_app

Description
® | Provider Microsoft Office 365 ~
®  Endpaint Worldwide ~
® | ClientID* 28047 cfe-0c27-47dc-843d-b9a188210382
® | TenantID* 60837 ce-6960-4205-980b-272606225830F
® | Client Secret *

Configure the general properties of the OAuth Application

Click the Save @I button.

Deleting OAuth Applications

You cannot delete an OAuth application, if it is used in email accounts.

To delete an email account:

1.

2
3
4,
5

Sign in to the legacy ECE Administration Console as a partition administrator.

In the Tree pane, browse to Administration > Partition: 7artition Name > Email > OAuth Applications.
In the List pane, select the OAuth application you want to delete.

In the list pane toolbar, click the Delete button.

You are prompted to confirm the deletion. Click OK to delete the OAuth Application.
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Configuring Email Accounts

After configuring the OAuth applications, you need to create email accounts (page 173) and add email aliases
(page 174) to them.

Before configuring the email accounts, perform the following tasks:

» Configure the Web Server URL and Load Balancer URL partition setting to generate the authorization code.

» Ensure that the FQDN (Fully Qualified Domain Name) used in the Web Server URL must match the FQDN
used in the Redirect URL configured in the Azure Active Directory.

»  Administrator must log into the ECE Administration Console using the same FQDN as inputted in the Web
Server URL.

Creating Email Accounts

To create an email account:

1. Sign in to the legacy ECE Administration Console as a department administrator.

In the Tree pane, browse to Administration > Department: Department Name > Email > Accounts.

2
3. In the List pane toolbar, click the New button
4

In the Properties pane, under the General tab, provide the following details:

Q

Q

o

o]

Account Name: The name for the account.
Account Description: A brief description of the account.
Status: Select Active to make the account active. By default the status of an account is set as Active.

OAuth Registered App: Select the OAuth application, configured at the partition level. For more
information, see “Configuring OAuth Applications” on page 171. Note that you can map an OAuth
application to multiple email accounts.

Server Type: Select the server type you want to use. The options available are: POP3 and SMTP and
IMAP and SMTP.

Address: The value is set as outlook.office365.com when an OAuth Registered App is selected. This
value cannot be changed.

Authentication Type: The value is set as OAuth 2.0 and it cannot be changed.

Authentication Token: Click the Assistance | button to generate the authorization code. On the
Microsoft Sign in page, log into the Microsoft account associated with the registered application and
accept the permissions requested to generate the authorization code. Once the authorization is complete,
a page is displayed with the authorization code.
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O Authorization code: Paste the authorization code.

(B c] [rescomser

| General
Name Value
® | Account name * Email Account

Account description

| Status Active ~
: ® | OAuth Registered App * cauth_app ~
| e/ pe IMA and SMT? v

Address outlock.office365.com

Authenticaticn type * CAuth0

Authenticaticn token Click the Assistance button to generate the authentication token. '_.|

Authonzation code
Configure the general properties of the Email Account

5. Click the Save @l button.

Once the account is saved, the Email Address tab (page 173) and the Test Connection (page 176) button in
the Properties pane toolbar are enabled.

Adding Email Aliases

Under the Email Address tab, you can either create new email aliases (page 174) or you can add existing email
aliases, under basic authentication, to email accounts to convert them into OAuth authentication (page 176).
After the existing aliases are added to the email accounts, they are no longer available in the Aliases list. To
know more about creating basic authenticated aliases, see “Aliases” on page 161.

Adding new email aliases

To add a new email alias:

1. Sign in to the legacy ECE Administration Console as a department administrator.

2. In the Tree pane, browse to Administration > Department: Depastuent Nume > Email > Accounts.
3. In the List pane, select the account to which you want to add a new email alias.

4. In the Properties pane, under the Email Address tab, click the New button.
5

In the Add a New Alias window, provide the following details:

O Email address: Type the email address for the alias. This is required information. The email address
you provide here should be first created on the incoming email server.

O  Status: Select Active.

O  Automatic BCC: Type the email address to which you want to send a BCC copy of the email. Only one
BCC address may be used. Whenever an email is sent out from this alias, a BCC copy of that email is
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automatically sent to this address. You can use this option when you want to review later the replies sent
out from a particular alias.

— Important: If you provide email addresses in both Automatic BCC and Send Email To fields, then
'/ the email is sent only to the address given in the Send Email To field.

O Send Email To: Specify the email address to which the outgoing emails from this alias should go.
Whenever an agent replies to a customer email, the reply is sent only to the email address specified in
the Send Email To field and not to the customer email address. You can use this option to test that the
alias has been configured properly and to test workflows. Make sure that after testing the alias you make
this field empty.

O Default alias: Select Yes to make this alias the default alias for the department. When an agent
composes a new email, the default alias is selected as the From address for the email. The default email
address is also used for activities transferred to this department from other departments, if the value of
the setting Set “From” email address for email activities transferred between departments is set to
Use default alias of destination department.

—. Important: A default alias should also be active and for each department only one alias can be the
'/ default alias.

O Redirection Email Addresses: List the email addresses from where you want to redirect the emails to
this email address. Separate the list of email addresses using a semicolon. While replying to emails, in
the From field, agents will by default see the redirection email address from where the email came in
the system.

O  Folder: The folder from which emails are fetched. By default, inbox is selected. This can be changed to
a different folder if IMAP protocol is selected.

o  Shared Mailbox: To add shared mailboxes as aliases to email accounts, select Yes. The default value is
No.

Add a new alias

Name Value
®  Erail address * support@company.com
®  siatust Active ~

Automatic BCC
Send mail to
®  Default alias * Yes ~
Redirection email addresses
Shared mailbox Mz ~

Folder inbax

Save Cancel

Add a new alias to the Email Account

6. Click Save.
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Adding existing email aliases

To add an existing alias:

1.

2
3
4,
5

Sign in to the legacy ECE Administration Console as a department administrator.

In the Tree pane, browse to Administration > Department: Department Name > Email > Accounts.

In the List pane, select the account to which you want to add an existing basic authenticated email alias.
In the Properties pane, under the email address tab, click the Add Existing Email Address button.

In the Add Existing Aliases window, from the list of existing email aliases in the department, click the
check boxes next to the email aliases you want to convert to OAuth authenticated aliases.

Click OK. The aliases are validated and then added to the account. When an alias, which does not belong to
the email account, is added, an error is shown.

Add existing aliases

Select Existing Aliases
® suppert@company.com
L] services@company.com

Cancel

Add an existing alias to the Email Account

Testing Connections for Email Accounts

176

After creating and saving an email account, the Test Connection button on the properties pane toolbar is
enabled. It is used to test the validity of an email account.

An email account can become invalid due to the following reasons:

4

4

4

When the generated authorization code is revoked or has expired.
When the email aliases no longer belong to the account.

When the permissions granted to the OAuth application are revoked.

To test the connection for an email account:

1.
2.

Sign in to the legacy ECE Administration Console as a department administrator.

In the Tree pane, browse to Administration > Department: Department Name > Email > Accounts.
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3. In the List pane, select an existing email account.

4. In the Properties pane toolbar, click the Test Connection button to test the validity of the account. If the
email account is valid, the following message pops up: Connection established successfully. If
the account is rendered invalid, an error message is shown.

Removing linked Aliases from Email Accounts

To delete an email account, it is imperative to remove linked email aliases. When email aliases are removed from
an email account, any aliases that are moved from basic authentication to OAuth authentication, are converted
back to basic authentication. These aliases become available in the Aliases list in an inactive state. The newly
added OAuth authenticated aliases are deleted permanently.

You cannot delete an email account, if an alias added to the email account:
» Is configured as the default alias and is in the active state.
» Is associated with a retriever service instance.

» Is used in an inbound workflow.

To remove an alias from an email account:

1. Sign in to the legacy ECE Administration Console as a department administrator.

2. In the Tree pane, browse to Administration > Department: Depastuent Nume > Email > Accounts.
3. In the List pane, select the email account for which you want to remove the email aliases.
4

In the Properties pane, under the Email Address tab, click the Delete * button to delete the email aliases
you want to remove.

e

You are prompted to confirm the deletion. Click OK.

Deleting Email Accounts

You can delete email accounts only after removing all linked email aliases from the account. For more
information, see “Removing linked Aliases from Email Accounts” on page 177

To delete an email account:

1. Sign in to the legacy ECE Administration Console as a department administrator.

2. In the Tree pane, browse to Administration > Department: Depastuent Numne > Email > Accounts.
3. In the List pane, select the email account you want to delete.

4. In the list pane toolbar, click the Delete l:| button.
5

You are prompted to confirm the deletion. Click OK to delete the email account.
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This chapter will assist you in understanding how to block specific file types from being processed by the
system.

About Blocked File Extensions

This is a security feature that allows you to selectively block certain types of attachments, which may contain
viruses, from entering the system. (For example, .exe, .vbs, .js, etc.) This feature works in conjunction
with department settings for email attachments. Using settings, the system can be configured to block all
attachments, block incoming and outgoing attachments, and delete or quarantine blocked attachments.

Along with setting the file extensions for blocking, you need to configure the following department settings for
this feature to work.

» Block all attachments
» Action on blocked attachments
For more information on working with settings, see “Assets for Email” on page 145.

Be aware that any file types that are blocked or allowed in the Attachments settings at the global level supercede
the blocked file extension rules set at the department level. For more information, see the Enterprise Chat and
Email Administrator’s Guide.

Configuring Blocked File Extensions

To configure a blocked file extension:

1. In the top menu, click Apps.

2. In the left menu, click Email > Blocked File Extension. This opens the Blocked File Extension space.
3. Click the New button or select the Blocked File Extension you wish to edit.
4

In the General tab, provide the following details.
O Name: Type a name for the blocked file extension.

O  Blocked file extension: Type the file extension you want to block such as .exe, .vbs, .js.
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O Description: Type a brief description.

Create Blocked File Extension

Name* Block exe files
Elocked File Extension® exe
Description

=

Block file extensions

5. Click the Save button.

When you configure a blocked file extension, the Retriever Service instances need to be restarted for the
changes to take effect.

Deleting Blocked File Extensions

To delete a blocked file extension:

1. In the top menu, click Apps.

2. In the left menu, click Email > Blocked File Extensions. This opens the Blocked File Extension space.
3. In the List pane, click the Delete button next to the blocked file extension you want to delete.

4. A message appears asking to confirm the deletion. Click Yes to delete the blocked extension.

When you delete a blocked file extension, the Retriever Service instances need to be restarted for the
changes to take effect.

Blocking Attachments

You can block:

» All incoming attachments
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All incoming and outgoing attachments
Specific incoming attachments
Specific incoming and outgoing attachments

You cannot block only the outgoing attachments.

Blocking Specific Types of Attachments for Inbound Emails

To block specific types of attachments for inbound emails:

1.

2
3
4.
5

In the top menu, click Apps.

In the left menu, click Email > Settings. This opens the Settings page.
In the Email for scan setting, select Inbound emails only.

In the Block all attachments setting, select No.

In the Action on blocked attachments setting, select Quarantine or Delete.

Blocking Specific Types of Attachments for Inbound and Outbound
Emails

To block specific types of attachments for inbound and outbound emails:

1.

2
3
4.
5

In the top menu, click Apps.

In the left menu, click Email > Settings. This opens the Settings page.

In the Email for scan setting, select Both inbound and outbound emails.
In the Block all attachments setting, select No.

In the Action on blocked attachments setting, select Quarantine or Delete.

Blocking All Types of Attachments for Inbound Emails

To block all types of attachments for inbound emails:

1.

Sl

In the top menu, click Apps.

In the left menu, click Email > Settings. This opens the Settings page.

In the Email for scan setting, select Inbound emails only.

In the Block all attachments setting, select Yes.

In the Action on blocked attachments setting, select Quarantine or Delete.

If you configure the setting, Block all attachments, to Yes, all attachments are blocked. Configuring file
extensions in the Email > Blocked File Extensions node, will not override this setting.
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Blocking All Types of Attachments for Inbound and Outbound Emails

To block all types of attachments for inbound and outbound emails:
1. In the Email for scan setting, select Both inbound and outbound emails.

2. In the Block all attachments setting, select Yes.

3. In the Action on blocked attachments setting, select Quarantine or Delete.

If you configure the setting, Block all attachments, to Yes, all attachments are blocked. Configuring file
extensions in the Email > Blocked File Extensions node, will not override this setting.
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» About Delivery Exceptions
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This chapter will assist you in understanding how to set up delivery exceptions.

About Delivery Exceptions

This feature allows you to handle emails that bounce back to the system because the original outgoing email
could not be delivered to the intended recipient. Emails can bounce back for a number of reasons, like an
incorrect email address, a customer mail box that has exceeded its storage limit, or network connectivity issues.
Such emails are processed using the delivery exception feature of the application.

Administrators create a list of delivery exception words and phrases, like Out of office, mail-daemon,
etc., that may appear in the email subject line or email addresses which indicate that an email is a bounce back.
If the system finds any of these phrases, it treats the email as a bounced back email. Regular emails that contain
phrases configured for delivery exception are also categorized as bounced back emails, and treated as such.
Bouncebacks are of two types:

» Permanent: Indicates that an irreparable reason, such as an invalid email address, caused the email to
bounce back. These are permanent failure conditions and any email sent to such email address would always
bounce back.

» Temporary: Indicates that a temporary reason, such as an out of office reply or a temporary unavailability
of the destination server caused the email to bounce back. The inference here is that should the emails be
sent again, there is a chance that they may be delivered.

When the retriever picks up an email, it checks it for delivery exception words and phrases configured in the
system. If the email address or subject contains any of those words, the activity subtype is changed to Email-
permanent undeliverable or Email-temporary undeliverable, based on the failure type configured for that
word or phrase, and the email activity is sent to the exception queue by the standard start workflow. These
activities can be processed from the exception queue by a user with the appropriate permissions. Workflows can
also be configured to process activities that are routed to the exception queue.

Address-type delivery exceptions work by checking the part of the email address before the “at” @ character and
excludes the “at” @ character. For example, administrators can configure the term, ‘postmaster’ as an address-
type delivery exception. This would then be compared against the from email address of the incoming email and
checked. For example, email addresses such as postmaster@aabc.com and mail-
postmaster.xyzadabc.com would be confirmed as delivery exceptions while
exceptionadpostmaster.com would not.

The application comes with some default delivery exception instances. Should you need to create other instances
of delivery exception, you can easily do so from the Delivery Exceptions space. For a list of default delivery
exceptions, see “Appendix A: Predefined Delivery Exceptions” on page 230.

Configuring Delivery Exceptions

To configure a delivery exception:
1. Select Apps from the top menu.

2. Select Email > Delivery Exceptions from the left menu. This opens the Delivery Exceptions space.
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3. Click the New button or select the Delivery Exception you want to edit.

4. In the Properties pane, on the General tab, and provide the following details:
O Name: Type a name for the delivery exception.
O Type: Select the type from the dropdown list. Options available are:
e Address
e Subject

O  Phrase: Type the phrase you want the system to check for.

@ Important: The “at” @ character must not be included in the exception phrase.

O  Failure: Select the type of failure from the dropdown list. The options available are:
e Permanent
e Temporary

O  Description: Provide a brief description.

Create Delivery Exception

Name* New exception - 404 error

Type* Subject w
Phrase® 404 error

Failure* Permanent -
Description

=

Create a new delivery exception

5. Click the Save button.

After configuring the delivery exception phrases, you need to stop and restart the email Retriever instance to
update the system accordingly.
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Deleting Delivery Exceptions

2\ Important; If you delete a system provided delivery exception phrase, it gets deleted from all
% departments in the system.

To delete a delivery exception:

1. Select Apps from the top menu.

2. Select Email > Delivery Exceptions from the left menu. This opens the Delivery Exceptions space.
3. In the List page, click the Delete button next to the delivery exception you want to delete.

4. A message appears asking to confirm the deletion. Click Yes to delete the delivery exception.

When you delete a delivery exception, the Retriever Service instances need to be restarted for the changes to
take effect.
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Service
Levels

» About Service Levels
» Creating Service Levels

» Deleting Service Levels



This chapter will help you configure service levels.

About Service Levels

Service levels allow you to set up response time expectations for incoming customer service interactions. Service
levels can be defined for cases and all activities other than chat activities. Once defined, they are used in
workflows to influence activity routing. Service level performance reports are available in the Reports Console.

Creating Service Levels

To create a service level:

1. In the top menu, select Business Rules.
2. Select Service Levels from the left menu.
3. Click the New button.
4

In the General tab, provide the following details.
O Name: Type the name of the service level.

O  Description: Provide a brief description.
Create Service Level
Genera Durations

Name*

8 Hrs Service levels

Description

=

Set general properties

5. Next, click the Durations tab and specify the service level for various type of work units. They are:

o Email: Specify the service level in minutes or business hours.
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O Case: Specify the service level in minutes or business hours.

Create Service Level

General Durations
Email
Value 8
Unit Business Hours -
Case
Value 12
Unit Business Hours -

=

Set durations

6. Click the Save button.

Deleting Service Levels

@ Important: Before deleting a service level, make sure that it is not used in any workflow.

To delete a service level:

1. In the top menu, select Business Rules.

2. Select Service Levels from the left menu.

3. In the List pane, click the Delete button next to the service level you want to delete.
4

Click the Yes button when the system prompts you to confirm the deletion.
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Workflows can only be viewed or edited from the legacy Administration Console. You will need Internet
Explorer and Java to access the legacy Administration Console and to configure workflows. For details about
preparing the desktop for doing this task, see Enterprise Chat and Email Browser Settings Guide.

About Workflows

Workflows provide a mechanism for applying a sequence of rules on activities. Flexible and easy to use, they
allow administrators to define rules to modify business objects, automate the progression of activities through
the system, raise alarms and send notifications about the status of activities, and so on.

Visually, a workflow is defined as a set of interconnected nodes created with the help of the Workflow Editor.
Each node contains definitions of a list of rules that are applied as an activity passes through that node. Each rule
consists of a set of conditions along with the set of actions to be performed when the conditions evaluate to true
or false.

Types of Workflows
There are three types of workflows:
» Alarm workflows
» Inbound workflows for email activities

» Outbound workflows

Alarm Workflows

Configure alarm workflows to process activities in the system and perform actions such as notifications,
reassignments, and so on, depending on the specified conditions. Alarm workflows can also route activities from
queues or users to other queues or users. Alarm workflows are typically used to provide customer service based
on customer value. Alarm workflows act on all activities except for chat activities.

Additional workflows can be configured to work on activities processed by the alarm workflows.
Alarm workflows can be run on:

» Users

»  Queues
Each department comes with a default alarm workflow. It is:

» Exception Queue Alarm Workflow: A workflow configured to send notifications when activities are
routed to the exception queue because of workflow errors encountered while processing activities. This
workflow is active by default and it runs every 12 hours to check if there are any activities with the substatus
“Workflow-Error” in the exception queue. If any such activities are found, a notification email with the list
of activity IDs is sent. The notification email is sent to the address specified in the “To address: for
Notification for services” setting. This is the default configuration of the workflow; however it can be
changed to meet your business needs. Although it is possible to delete the workflow, it should not be deleted.
If you do not wish to use the workflow, make it inactive.
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» For some sample workflows, see “Sample Workflows” on page 219.

Inbound Workflows for Email Activities

Inbound workflows define rules for all emails coming in to the system. Some special inbound workflows also
route activities transferred from other departments.

Activities from inbound workflows can be routed to:

» Users

»  Queues

»  Other inbound workflows

»  Other departments
Each department comes with three default inbound workflows. You can also create your own workflows.
The three default workflows are as follows:

1. Start Workflow - Standard: The first workflow that acts on all new, incoming activities. This workflow is
ignored for activities transferred from other departments.

The system provided workflow creates a new case for activities that do not have a case, and for activities
which already have cases, it associates the activities with the existing cases. If the existing case is closed, the
workflow reopens the case and assigns the activity to the reopened case. Then, the workflow checks if the
incoming activities are bounce backs, and routes such activities to the Exception queue. This is the default
behavior of the workflow and it can be changed to meet your business needs; however it cannot be made
1nactive.

2. Start Workflow - Transfer: This workflow is responsible for processing activities transferred from other
departments. Users from other departments can transfer activities only to the departments that have active
transfer workflows.

The system provides a blank transfer workflow. You can modify the workflow according to your business
requirements.

3. Finish Workflow: This workflow applies on activities only if no user-defined inbound workflow has been
applied to the activity. For example, if you have configured three aliases in your department and you have
configured inbound workflow for only one alias, the activities from that alias are handled by the configured
inbound workflow. Activities from the other two alias are handled by the finish workflow.

The system provides a blank finish workflow. You can modify the workflow according to your requirements.
You can choose not to use the finish workflow.

For some sample workflows, see “Sample Workflows” on page 219.

In addition to the pre-packaged workflows, new workflows can be defined in a department. Also, workflows can
be chained in such a way that one workflow takes over the processing of activities after another one has finished.

If there are no inbound workflows configured in a department, or if the inbound workflows are marked inactive,
all the incoming activities coming to the aliases configured in the system are moved to the exception queue after
an hour.
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Outbound Workflows

An outbound workflow identifies the set of rules that are applied on activities generated when email responses
are sent out. The outbound workflow is primarily used to review and enforce the quality of outbound email
responses.

Outbound workflows are applied on outbound email responses generated by a configured set of users or user
groups. They can also be configured to apply on responses to activities that belong to certain queues. However,
outbound workflows are not applicable to emails forwarded and redirected from the system.

When there are multiple outbound workflows configured in a department, and an activity qualifies for all the
workflows, then the workflow for a user take precedence over the workflow for a user group, and the workflow
for the user group takes precedence over the queue. For example, if there is one workflow for a user group and
another workflow for a queue, and the user from the user group defined in the workflow sends out an email,
which belongs to the queue defined in the other workflow, then the workflow configured for the user group will
act on the activity, and the workflow for the queue will be ignored. Likewise, if there is another workflow
configured for the user, and an activity qualifies for all three workflows, then the workflow for the user group
and queue will be ignored and the workflow for the user will act on the activity.

Outbound Email Review Workflows

To ensure high quality replies to email inquiries, customer service managers may wish to review the content of
replies before they are sent out to customers. The outbound email review workflow can be used to set up a
supervisory loop that addresses this need. A supervisory loop allows you to route a reply from an agent to
another user — a supervisor - based on pre-determined conditions, before the reply leaves the system. The
supervisor can then accept the reply, sending the email to the customer, or reject it, returning it to the original
agent for revision. During this process, supervisors can edit replies, modify attachments, and provide feedback to
the agent using notes. Activities that are generated as part of the supervisory loop are not included in activity
reports.

Some important things to note about outbound email review workflows are:
» The end node of an outbound email review workflow must be a queue. No other end nodes are supported.

» You cannot configure multi-level supervision. Once a supervisor approves an email, the email is sent out of
the system. If another outbound workflow is configured for the supervisor, the email is processed by all the
nodes, but it is not routed to another queue. The email is sent out to the customer.

For details on creating workflows and workflow nodes, see:
» “Creating Workflows” on page 195
» “Configuring Nodes” on page 197

For some sample workflows, see “Sample Workflows” on page 219.

Workflow Editor

The visual Workflow Editor makes it easy to create workflows via a palette of nodes. Each node performs a
specific function. For example, the Service Level node allows service levels to be set at that point of the
workflow. Placing nodes on the workflow canvas and linking them with connectors creates a system workflow.
The Diagram tab in the property sheet of a workflow opens the Workflow Editor.
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The following table lists the available workflow nodes.

Node

5

Auto-acknowledge node

)

Alarm node

@

Branch node

Related information

For details, see “Configuring the Auto-Acknowledgement Node” on page 204.

For details, see “Configuring the Alarm Node” on page 215.

For details, see “Configuring the Branch Node” on page 217.

o

Filter node

For details, see “Configuring the Filter Node” on page 208.

Classification node

@

Completion node

For details, see “Configuring the Classification Node” on page 206.

For details, see “Configuring the Completion Node” on page 210.

@

Department node

For details, see “Configuring the Department Node"” on page 209.

£

B,
Modify object node

=t
el

Queue node

@)

Service level node

For details, see “Configuring the Modify Object Node” on page 212.

For details, see “Configuring the Queue Node” on page 207.

For details, see “Configuring the Service Level Node” on page 213.

[

Start node

@

Workflow node

For details, see the following:

“Configuring the Start Node in Inbound Workflows” on page 197
“Configuring the Start Node in Standard Start Workflow” on page 198
“Configuring the Start Node in the Standard Transfer Workflow” on page 200
“Configuring the Start Node in the Standard Finish Workflow” on page 201
“Configuring the Start Node for Alarm Workflows” on page 202

“Configuring the Start Node in Outbound Workflows” on page 203

For details, see “Configuring the Workflow Node” on page 211.

List of nodes available in the Workflow Editor
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Creating Workflows

To create a workflow:

1.

In the Tree pane, browse to Administration > Department > Department_Name> Workflow > Workflows

> Wor@‘[ow Type.
In the List pane toolbar, click the New button.

In the Properties pane, on the General tab, provide the following details.
O Name: Type the name of the workflow.
O  Description: Provide a brief description.

O Active: From the dropdown list, select Yes to make the workflow active.

@ Important: To apply a workflow on activities, you have to make the status active.

Validate

General Diagram

Name Value

MName * Sample Workflow
Description

Active Yes

Set the general properties

Next, go to the Diagrams tab, and configure the workflow using the various nodes available in the Workflow
Editor toolbar.

a. First, add the nodes in the Workflow Editor. To add a node, click a node button in the Workflow
Editor toolbar, and then click in the Workflow Editor. The node is added in the Workflow Editor and
a window for configuring the node properties opens. For more details on setting up all the nodes, see
“Configuring Nodes” on page 197.

For nine nodes, you can also add a copy of the nodes created in other workflows or the same workflow.
To add a copy of a node, click the arrow next to the node button in the Workflow Editor toolbar, and
select the option to add a copy of the node.

b. After adding nodes, you need to connect them to determine the flow of the workflow. All nodes should
be connected to each other. A connector from one node can only point to one other node, but multiple
connectors can point towards the same node. In the Workflow Editor toolbar, click the Connect nodes
in workflow button. Then, click on the node and without releasing the mouse button, click on the
second node. A connector appears between the two nodes, indicating the flow of the workflow.
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c. After you have created the workflow you can use the auto layout option to arrange the nodes neatly. In
the Workflow Editor toolbar, click the Autolayout nodes on canvas button. All the nodes in the
workflow are arranged systematically.

Properties: Sample email workflow

| ” e | | Validate | | Audit |

Generzl | Diagram

w1 [ De® 0 9@« @0 e

fistlc

. . Ernall queue
Start Service level Branch %

Other ermails

Layout the workflow

5. Click the Save @I button.

6. Click the Validate button to validate the workflow. A workflow is validated only if it is in active state. If you
have not completed creating the workflow and want to save whatever is done, you can do that by keeping the
workflow inactive.

7. Click the Audit button to view an audit trail of the users who have made changes to the workflow and the
date and time when the change was made.

Copying Workflows

Copy workflows to reuse existing workflows, and to test workflows. Users with the Create Workflow action can
copy workflows. The copied workflow is named as “Copy of Workflow- Name” and saved as an inactive
workflow, without a start node. In the copied workflow, add the start node, evaluate the end nodes to see if they
need to be changed, and when the workflow is ready, make it active. The time taken by the copying process
varies based on the size of the workflow, and the user cannot work in the application during this time.

Workflows cannot be copied across departments and the following three standard inbound workflows are not
available for copying: Start Workflow — Transfer, Start Workflow — Standard, and Finish Workflow.

To copy a workflow:

1. In the Tree pane, browse to Administration > Departments > Department_Name > Workflow >
Workflows > Workﬂour_ Type.

2. In the List pane, select the workflow you want to copy.

3. In the List pane toolbar, click the Copy button.
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4. A message appears notifying that based on the size of the workflow, the copy process might take some time,
and the user would not be able to use the application during the process. In the message, click Yes to create
a copy of the workflow.

After a copy of the workflow is created, a message is displayed that tells the name of the copied workflow.
In the copied workflow, add the start node, evaluate the end nodes to see if they need to be changed, and
when the workflow is ready, make it active.

Deleting Workflows

@ Important: Before deleting a workflow, ensure that it is not in use.

To delete a workflow:

1. In the Tree pane, browse to Administration > Departments > Depastuent Name> Workflow >
Workflows > Workflow Type.

2. In the List pane, select the workflow you want to delete.

3. In the List pane toolbar, click the Delete l:l button.

Configuring Nodes

This section describes how to configure the various nodes in workflows.

Configuring the Start Node in Inbound Workflows

A start node is the starting point of a workflow and no workflow can be created without a start node. An inbound
workflow can have two types of start points - Alias and Workflow. All emails coming to an alias, specified as the
starting point of an inbound workflow, are routed by that workflow. You can add more than one aliases as the
start point of a workflow, but one alias can be a start point of only one inbound workflow. After saving a
workflow, if you add the workflow as an end node in another workflow, then the second workflow becomes the
start point of the first workflow. This means, that the activities routed by the second workflow are processed by
the first workflow. An inbound workflow can have both aliases and workflows as the start point.

A workflow can have only one start node.

u

The start node

To configure the start node in an inbound workflow:

1. In the Tree pane, browse to Administration > Departments > Depastuent Naume> Workflow >
Workflows > Inbound.
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2. In the List pane, select an inbound workflow or create a new one.
3. In the Properties pane, on the Diagram tab, add the Start node in the Workflow Editor.

4. In the Add Start Node window, in the Start Points tab, select the email alias to be set as the start point for
this workflow. All emails coming to the selected alias are routed by this inbound workflow. You can add
more than one aliases as the start point of a workflow, but one alias can be a start point of only one inbound

workflow.
2 Add Start Node - (S
Start Points
Available start points Selected start points
Ll Entry Paints Name Path
" >
4 [C1Email Aliases alias@comp... Entry Points - Email ...
: 2 ~
[=] alias@company.com

< ~
«

Select an alias as the start point

The Workflows tab is enabled only after a workflow is saved. After saving the workflow, if you add the
workflow as an end node in another workflow, then that workflow is listed in the Workflows tab. This
means, that the activities routed by the other workflow are processed by this workflow. An inbound
workflow can have both aliases and workflows as the start point.

5] Add Start Node =

Start Points Workflows
Workflow Description

Email workflow

View the workflows

5. Click the OK button to close the window.

Configuring the Start Node in Standard Start Workflow

A start node is the starting point of a workflow and no workflow can be created without a start node. In the start
node of a standard start workflow, you make the important decision of creating or not creating cases for each
incoming activity. By default, the node is configured to create a new case for activities that do not have a case
and for activities which already have a case, associates the activity with the existing case. If the existing case is
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already closed, the workflow reopens the case and assigns the activity to the reopened case. This is the default
configuration of the node and it can be changed to meet your business needs.

A workflow can have only one start node.

u

The Start node

To configure the start node in the standard start workflow:

1.

In the Tree pane, browse to Administration > Departments > Department_Name > Workflow >
Workflows > Inbound.

In the List pane select Start Workflow - Standard.
In the Properties pane, on the Diagram tab, add the Start node in the Workflow Editor.

In the Add Start Node window, select one of the following options.

O Always create a new case for the activity: If you select this options, all options, except for the option
to associate cases for activities that have existing cases, in the window are disabled.

O Create a new case or assign to current case under the following conditions: If you select this option,
you can further specify the conditions when a case is to be created.

e Specify what is to be done when an activity has an existing case and the case is open. The
following options are available:

e Always associate this activity to open case
® Always create new case

e If the existing case has been open for more than n number of days, then create a new case else
associate to old case: You can specify the number of days to be considered for this option.

e Now, specify what is to be done when an activity has an existing case and that case is closed. The
following options are available:

e Always reopen the case and assign the activity to the case

o Always create new case
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e If the existing case has been closed for more than » number of days, then create a new case
else associate to the old case. You can specify the number of days to be considered for this
option.

| Add Start Node w X
Specify the action to take when a new activity arrives.
Email Always create a new case for the activity
® Crezte a new case or assign to current case under the following conditions
f the activity has an existing case, then:
For existing open case

®) Always associate this activity to open case

) Always create new case

) If the existing case has been open for more than

days then create new case else associate to old case

For existing closed case
®) Always reopen the case and assign the activity to the case
) Always create new case
I the existing case has been closed for more than
days then create new case else associate to old case

[CJ1f & new case was created for the activity that has an existing case,
then associate the two cases.

Cancel

Set the start node for a standard start workflow

5. Lastly, you can associate two cases, if a new case was created for the activity that has an existing case. In the
Add Start Node window, select the If a new case was created for the activity that has an existing case,
then associate the two cases option.

6. Click the OK button to close the window.

Configuring the Start Node in the Standard Transfer Workflow

A start node is the starting point of a workflow and no workflow can be created without a start node. For the start
node of a transfer workflow, you do not need to configure any properties. All the activities that are transferred
from other departments form the start point of the transfer workflow.

A workflow can have only one start node.

u

The Start node
To configure the start node in the standard transfer workflow:

1. In the Tree pane, browse to Administration > Departments > Department_Nome > Workflow >
Workflows > Inbound.
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In the List pane select Start Workflow - Transfer.
In the Properties pane, on the Diagram tab, add the Start node in the Workflow Editor.

In the Add Start Node window you will see a message that the transfer of activities from other departments
is controlled by permissions. No additional properties need to be set for this node of the workflow.

2 Add Start Node o [

The departments that may transfer activities to this
department is controlled by permissions.Mo additional
configuration of this node is required,

Set the start node for a standard transfer workflow

Click the OK button to close the window.

Configuring the Start Node in the Standard Finish Workflow

A start node is the starting point of a workflow and no workflow can be created without a start node. No
properties need to be set for the start node of a finish workflow. The start node of the standard finish workflow
picks up all the incoming activities that are not processed by any other custom inbound workflow. Activities are
routed to the finish workflow only after they are processed by the Standard - Start Workflow.

A workflow can have only one start node.

u

The start node

To configure the start node in a standard finish workflow:

1.

In the Tree pane, browse to Administration > Departments > Departucent._Name > Workflow >
Workflows > Inbound.

In the List pane select Finish workflow.
In the Properties pane, on the Diagram tab, add the Start node in the Workflow Editor.

In the Add Start Node window you will see a message that the workflow will run only after the start
workflow has processed the activity. No additional properties need to be set for this node of the workflow.

2 Add Start Mede . (223

EThlswurkﬂuw should run if only the Start Workflow
iprocessed the activity.

Set the start node for a standard finish workflow

Click the OK button to close the window.
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Configuring the Start Node for Alarm Workflows

A start node is the starting point of a workflow and no workflow can be created without a start node. In the start
node of the alarm workflow, specify the objects you want to monitor. You can select from queues, users, and user
groups. Along with the objects, you have to specify the schedule when the alarm workflow should run. You can
run the alarm workflow only once or multiple times. Additionally, you can specify the end date and start date of

the scheduled alarm workflow.

A workflow can have only one start node.

s

The start node

To configure a start node for an alarm node:

In the Tree pane, browse to Administration > Departments > Department_Name > Workflow >

In the Add Start Node window, on the Objects tab, select from the list of users, user groups, and queues.

1.
Workflows > Alarm.
2. In the List pane, select an alarm workflow or create a new one.
3. In the Properties pane, on the Diagram tab, add the Start node in the Workflow Editor.
4,
2| Add Start Node e
Objects
Available objects Selected objects
tl Queues Name Path
[ Users :) Activities ne... Queues - Activities n...
Supervisor Users - Supervisor
«
Select from the users or queues
5.

following options need to be set:

o]

Next, in the Add Start Node window, on the Schedule tab, set the schedule for the alarm workflow. The

Specify the time or times that the workflow should be run: By default The workflow should be run

once at 7ime Dateis selected. You can select from one of the following options.

select from one of the following options.

e No end date
[ ]

End after « occurrences

End by the specified date

The workflow should be run once at 7iue Date
This workflow should be run multiple times

Specify the duration of the recurring workflow: Set the start date for the workflow. For the end date,

Specify the recurrence pattern of the workflow: Select one of the following options.
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e Daily: Set the workflow to run:
e Every nday
e Every weekday
e Weekly: Set the workflow to recur every « weeks on the days of the week
e  Monthly: Set the workflow to run:
e Day nof every « month
® The first, second, third, fourth, or last Day of every » month
e Yearly: Set the workflow to run:
o Every Month Date
e Every first, second, third, fourth, or last Day of Month
O On the day that the workflow runs, run the workflow: Select one of the following options.
o  Once at the specified time
e Every rhours starting at the specified time and ending at the pecified time

2 Add Start Node - (3]

Objects  Schedule

Specify the time or times that the workflow should be run.
_) The workflow should be run once at : : -
@ This werkflow should be run multiple times

Specify the duration of the recurring workflow:

Start: |12/30/2014 ~| @ Noend date

_) End after l:l occurrences
") End by -

Specify the recurrence pattern of the workflow:

@ Daily @ Every EI dayls)

- Weekly ) Every weekday
' Monthly
) Yearly
On the days that the workflow runs, run the workflow
) Onceat
) Every l:l - | starting at 3 3 and ending at

Set the schedule for the alarm workflow

6. Click the OK button to close the window.

Configuring the Start Node in OQutbound Workflows

A start node is the starting point of a workflow and no workflow can be created without a start node. The start
point of an outbound workflow can be a queue, a user, or a user group. You can select multiple objects as the
start point of the same workflow. Also, every workflow has a unique object as its start point. For example, the
same user cannot be a start point of two outbound workflows.
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A workflow can have only one start node.

u

The start node

To configure a start node in an outbound workflow:

1. In the Tree pane, browse to Administration > Departments > Depastuent Name> Workflow >
Workflows > Outbound.

2. In the List pane, select an outbound workflow or create a new one.
3. In the Properties pane, on the Diagram tab, add the Start node in the Workflow Editor.

4. In the Add Start Node window, on the Start Points tab, select from the list of users, queues, and user groups.
Note that if you are creating a supervisory loop, the start node must be a user or user group.

2 Add Start Node . |25
Start Points
Available objects Selected objects
tl Queues Name Path
>
D users - Chat queue Queues - Chat queue
~
(5 User Groups All UsersIn 5. User Groups - All User..,
v

= Supervisor Users - Supervisor

The Workflows tab is enabled only after the workflow is saved. After saving the workflow, if you add this
workflow as an end node in another workflow, then that workflow is listed in the Workflows tab. This
means, that the activities routed by the other workflow are processed by this workflow.

2 Add Start Mede . [

tPoints  Workflows
Workflow Description

New outbound workdfl...

View the workflows

5. Click the OK button to close the window.

Configuring the Auto-Acknowledgement Node

Use this node to automatically send acknowledgements for incoming emails. Auto-acknowledgement are emails
that are sent to customers when conditions set in the auto-acknowledgement node are met. Create the content for
these auto-acknowledgements in the form of articles. Then, configure the conditions under which auto-
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acknowledgments are to be sent to customers. You can configure a set of rules, and for each rule, configure a
different auto-acknowledgement.

&

The auto-acknowledgement node

To configure an auto-acknowledgement node:

1. In the Properties pane, on the Diagram tab, add the Auto-acknowledgement node in the Workflow Editor.

2. In the Auto Acknowledgement Rule Configuration window, provide the following details.

a.

b.

In the Name field, provide a name for the node.

In the Rule Name filed, provide a name for the rule and press the Enter Key. Select the rule name to
configure the rule properties.

Select one of the following options:
e  This rule is always true

e This rule is true under the following conditions

If you have selected the This rule is true under the following conditions option, configure the
conditions when the rule is true. For a list of objects available for configuring the conditions, see
“Appendix B: Reference Information” on page 235.

Next, select the articles to be sent as an auto-acknowledgement if the conditions configured in the rule
are met. Click the Select Article button and from the Select Article window select articles for auto-
acknowledgement. You can select multiple articles and configure the order in which they should appear
in the reply. When the auto-acknowledgement is sent, all the selected articles are combined together in
the order they are selected and sent out as one email.

Likewise, you can create multiple rules.

If you have created more than one rule, use the Move Up and Move Down button to change the order
of the rules.

Workflows 205



f. Lastly, you can also send an auto-acknowledgement if no rules are found true. Select the If no TRUE
rule is found, then send this article option, and select the articles to be sent as auto-
acknowledgement. Click the Select Article button, and from the Select Article window, select articles
for auto-acknowledgement.

a Auto Acknowledgement Rule Configuration = @

Name* : ‘Auto Acknowledgement

Create new rules () This rule is abways true.
below; processing )
ends when a TRUE @ This rule is TRUE under the following conditions:
fuiekfound: Specify the condition for the rule.
i Object Attribute Operator Value Boolean
‘ = p ~ ~ | [
U Activity ~ | Case Type v == v New ~ | AND v
1f the rule is TRUE, then send this article: |ACCessing and managing your account |
[/ no TRUE rule is found, then send this article: |[|

Set the auto-acknowledgment node

3. Click the OK button to close the window.

Configuring the Classification Node

Use this node to automatically assign categories and resolution codes to activities processed by the workflow.
Create these classifications from the Codes and Classification space. Then, configure the conditions under
which classifications should be assigned to activities. You can configure a set of rules, and for each rule,
configure a different set of classifications to be assigned to activities.

@

The classification node

To configure a classification node:
1. In the Properties pane, on the Diagram tab, add the Classification node in the Workflow Editor.
2. In the Classification Rule Configuration window, provide the following details.

a. In the Name field, provide a name for the node.

b. In the Rule Name filed, provide a name for the rule and press the Enter Key. Select the rule name to
configure the rule properties.

c.  On the Condition tab, select one of the following options:
e This rule is always true
e This rule is true under the following conditions

If you have selected the This rule is true under the following conditions option, configure the
conditions when the rule is true. For a list of objects available for configuring the conditions, see
“Appendix B: Reference Information™ on page 235.
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d. Next, go the True tab and select the categories or resolution codes to be assigned to activities when the
conditions configured in the rule are met.

e. Next, go the False tab and select the categories or resolution codes to be assigned to activities when the
conditions configured in the rule are not met. The False tab is enabled only if you have selected the
This rule is true under the following conditions option on the Condition tab.

Likewise, you can create multiple rules.

f.  If you have created more than one rule, use the Move Up and Move Down button to change the order
of the rules.

4::‘3 Classification Rule Configuration @
Name® : | Classification

Create new rules below: all rules Condition

will be processed.

Rule Name This rule is always true,

| =) @) This rule is TRUE under the following conditions:

L O ] TLEs LHD dredin (YR | brte

e ~ e | e

Email ~ Content v Contsins ~ Complaint OR v
Email ~ Content ~ Contains ~~ unhappy  AND ~

Set the classification node

3. Click the OK button to close the window.

Configuring the Queue Node

In this node, specify the queue to which activities should get routed after they are processed by a workflow.
Activities from queues are routed to agents based on the routing method defined in the queue. Queue node is a
terminating node of a workflow and you cannot add any nodes after it.

LE

The queue node

The process of adding a queue node for outbound workflows is slightly different than for inbound workflows. In
outbound workflows, you must select whether the outbound email is routed to the queue for supervisory review
before or after a response has been sent to the customer.

» If set to Before: The supervisor is able to review the response before it is sent. If the supervisor Approves
the response, it is sent to the customer. If the supervisor Rejects the response, it is sent back to the agent for
improvements.

» If set to After: If a shorter SLA is high priority, set the queue to route the email After it has been sent, at
which point the supervisor can mark the agent’s response as Quality Met or Quality not Met.
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To configure a queue node:
1. In the Properties pane, on the Diagram tab, add the Queue node in the Workflow Editor.

2. In the Select Queue window, select a queue.

] Select Queue |
Name Description
VT’J Default excepticn queue System provided queue for exceptions
[  Ece_email MRD_Email_Ss
“’ﬂ ECE_Email_MRD_Service Supervisory Queue for MRD ECE_Email_...
’Tﬂ ECE_Outbound_Service Supervisory Queue for MRD ECE_Outbou...
Route to target before or after the email has been sent out of the application: Refare ~s
I Before
oK Cancel Help After

Set the queue node

3. If the queue is being selected for an outbound workflow, select to route the response to the queue Before or
After the email has been sent out of the application.

4. Click the OK button to close the window.

Configuring the Filter Node

This node allows you to control the percentage of outgoing email activities that are sent to a location for review.
The filter node assists supervisors by reducing and controlling the total outbound agent emails to be reviewed for
quality assurance. An outbound email review workflow without the filter node sends all outgoing emails from a
user or queue to the target node in the workflow, while the filter node allows the administrator to control the
percentage of outgoing activities to be routed to the review destination. Rerouting of outgoing activities can be
done in increments of 5%.

o

The Filter Node

The filter node is only available while configuring outbound email workflows.

To configure a filter node:
1. In the Properties pane, on the Diagram tab, add the Filter node in the Workflow Editor.
2. In the Filter Rule Configuration window, perform the following:

a. Provide a name for the node.
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b. From the dropdown menu, select the percentage of emails to be randomly routed to the target node.

Filter Rule Configuration ﬂ

Name™ : |Filter 2

Percentage of email to be routed: |5 ~r | %

Route selected emails to™ : |I|

(] Route remaining emails to : l:l |:|

Select the target nodes and filter percentage

c. Select the target node to which the selected emails are routed. This object must already be present in
the workflow diagram area to be eligible. Click the Select Target button and from the Select Target
window select the target node. You can choose from the following nodes:

e Queue

e  Workflow

e Department

e Completion

e Auto-acknowledgement
e Branch

e C(Classification

e Modify object

e Service level

e User

d. If necessary, select the option to route the remaining emails to an alternate target node and follow the
same steps of selecting a target.

3. Click OK.

Once you have configured the targets in the filter node, the filter node and target nodes are automatically
connected by arrows. The green arrow points to the target node to which the selected emails are routed. The red
arrow points to the alternate target node. These arrows cannot be added or removed manually. They are added or
removed automatically when you make changes to the filter node.

Configuring the Department Node

Use this node to route activities to other departments. Activities can be routed only to departments that are
shared with the current department, and that have active transfer workflows. Only such departments are available
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in the department list. The department node is a terminating node of a workflow and you cannot add any nodes
after it. This node is not available in outbound workflows.

@

The department node

To configure a department node:

1. In the Properties pane, on the Diagram tab, add the Department node in the Workflow Editor.

2. In the Select Transfer Department window, select a department to which you want to transfer activities from
this workflow. Only the departments that are shared with the current department, and that have an active
Start Workflow - Transfer workflow, are available in this list.

é.j Select Transfer Department

Name

25 Sales

][] [

Description

=)

Set the department node

3. Click the OK button to close the window.

Configuring the Completion Node

This node allows you to complete activities automatically. When activities reach this node, the status of the

activities is changed to “Completed”. Use this node only when you are sure that no additional work needs to be
done, and the activity can be completed automatically, without being viewed by any agent. No properties need to
be set for this node of the workflow.

®

The completion node

To configure a completion node:

1. In the Properties pane, on the Diagram tab, add the Completion node in the Workflow Editor.
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2. Inthe Add Set Completion Node window you will see a message that activities will be marked as completed
when they reach this node of the workflow. No additional properties need to be set.

21 Add Set Completion Node |

Activities will be marked as completed when they reach this node of the
workflow. No additional properties need to be set for this node of the i
workflow.

Set the completion node

3. Click the OK button to close the window.

Configuring the Workflow Node

Use this node to specify the workflow to which activities should get routed after they have been processed by the
current workflow. Only workflows of the same type are available for routing activities, except for inbound
workflows, where you can route activities to both inbound and general workflows. Workflow node is a
terminating node of a workflow and you cannot add any nodes after it.

S

The workflow node

To configure a workflow node:
1. In the Properties pane, on the Diagram tab, add the Workflow node in the Workflow Editor.

2. In the Select Workflow window, select the workflow to which activities should get routed after they have
been processed by the current workflow. Only active workflows are available in this list.

21 Select Workflow | |

Name Description

oE  Sample Workflow

) [om] [

Set the workflow node

3. Click the OK button to close the window.
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Configuring the Modify Object Node

Use this node to modify properties of the following objects - activities, cases, customers, emails and custom

activities.

The modify object node

To configure a modify object node:

1. In the Properties pane, on the Diagram tab, add the Modify Object node in the Workflow Editor.

2. In the Modify Object Rule Configuration window, provide the following details.

a. In the Name field, provide a name for the node.
b. In the Rule Name filed, provide a name for the rule and press the ENTER key. Select the rule name to
configure the rule properties.
c.  On the Condition tab, select one of the following options:
e  This rule is always true
e This rule is true under the following conditions
If you have selected the This rule is true under the following conditions option, configure the
conditions when the rule is true. For a list of objects available for configuring the conditions, see
“Appendix B: Reference Information” on page 235.
a Modify Object Rule Configuration @
Name" : | Modify Object
Create new rules below; all rules (= ke
will l:e processed, Condltlon || True || False
Rule Name ) This rule is always true,
‘ i} (@ This rule is TRUE under the following conditions:
Ul One s LiEs LA LyEdim  hrE e
Rule Two ~ v v ~| =l
@ Activity  ~ | Activity Priority  ~ == w1 ~  AND ~
Activity v Activity Priority  ~ == v 2 ~  AND ~
Set conditions for the modify object node
d. Next, go to the True tab and select the object you want to modify, and specify the values for the

attributes that are to be modified. Through this node you can modify the following attributes of the
objects.

e Activity: Activity priority, assigned to, description, due date, due date time, queue, subject
e Case: Description, due date, due date time, owner, severity, solution description.
e Email: Content, subject

e Customer - common: Entitlements, how referred, industry, level, marketing segment, preferred
agent
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e Customer - individual: Date of birth, employment status, first name, middle name, last name,
gender, job title, marital status

e  Customer - group: Customer name, group type, no. of members, region

e Customer - organization: Customer name, no. of employees, region, sector type

There are four ways in which you can provide values for these attributes. They are:

e Macro: The macro specified here is expanded and the value of the macro is assigned as the value
for the attribute.

e Link: The data usage link specified here is executed and the value of the link is assigned as the
value for the attribute.

e Constant: The value specified here is assigned directly as the value for the attribute.

e Pattern: The pattern specified here is searched for in the body of the activity. The value
immediately following the pattern, till the end of the line, is assigned as the value for the attribute.

a Modify Object Rule Configuration --We.. | 2 |

Mame* :|Mndify Object

Create new rules belows all rules will

Condition | True | False
be processed.

Rule Name Specify the objects to modify when this rule is TRUE.

| ] Object

Rule One

Rule Two

Case

<

Specify the values for objects that are modified.

Name Type Value

Description Constant ~  Needs urgent attention -
Due date Constant ~ =
Due date time Constant v E
Owner Constant v

Severity Constant ~  Urgent ~

Configure the properties of the object to be modified

e. Next, go the False tab and select the object to be modified if the conditions configured in the rule are
not met. The False tab is enabled only if you have selected the This rule is true under the following
conditions option on the Condition tab. It is optional to configure the False tab.

Likewise, you can create multiple rules.

f.  If you have created more than one rule, use the Move Up and Move Down button to change the order
of the rules.

3. Click the OK button to close the window.

Configuring the Service Level Node

Use this node to automatically set service levels for activities. Service levels allow you to set up response time
expectations for various emails and custom activities being processed by the workflow. Create the service levels
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from the Service Levels space. Then, configure the conditions when a service level should be set for an activity
or case. You can configure a set of rules, and for each rule, configure a different service level.

@

The service level node

To configure a service level node:
1. In the Properties pane, on the Diagram tab, add the Service Level node in the Workflow Editor.
2. In the Service Level Rule Configuration window, provide the following details.

a. In the Name field, provide a name for the node.

b. In the Rule Name field, provide a name for the rule and press the Enter Key. Select the rule name to
configure the rule properties.

c. Select one of the following options:
e This rule is always true

e This rule is true under the following conditions

If you have selected the This rule is true under the following conditions option, configure the
conditions when the rule is true. For a list of objects available for configuring the conditions, see
“Appendix B: Reference Information” on page 235.

d. Next, select the service levels to be set for activities and cases, if the conditions configured in the rule
are met.

Likewise, you can create multiple rules.

e. If you have created more than one rule, use the Move Up and Move Down button to change the order
of rules.

f. Lastly, you can also set service levels if no rules are found to be true. Set the following:

e Select the If no TRUE rule is found, then set activity service level option, and select a service
level from the dropdown list.

e Select the If no TRUE rule is found, then set case service level option, and select a service level
from the dropdown list.

a Service Level Rule Configuration @

Name* 1|SEN\{E Level |

Create new rules below; processing This rule is always true.
ends when a TRUE rule is found. - -

@ This rule is TRUE under the following conditions:
Rule Name

‘ Specify the condition for the rule,
P}
o Object Attribute

Operator Value Boolean
Rule One
| ~ ~ ~ P
Rule Two |
Case v Severity | == v Urge.. ~ OR ~
¥ | Activity | Activity Priority | == v 1 ~ OR ~
If the rule is TRUE, then set activity service
level: Customer support service levss
If the rule is TRUE, then set case service level: Customer support service levas

[¥]1f no TRUE rule is found, then set activity service level: | Customer support service levs,~

[¥11f no TRUE rule is found, then set case service level: Customer support service levs.~

Configure the service level node
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3. Click the OK button to close the window.

Configuring the Alarm Node

Using this node, you can set up alarms if certain conditions are met. You can monitor some specific attributes of
cases and activities, and you can send internal and external notifications if the conditions are met. For activity
alarm rules, you can also filter activities based on a defined criteria. The filtered activities can then be further

processed by the alarm workflow.

An alarm workflow can have only one alarm node and it should be the second node in the workflow, that is, the

node following the start node.

o

The alarm node

To configure an alarm node:

1. In the Tree pane, browse to Administration > Departments > Department_Nome > Workflow >

Workflows > Alarm.

2. In the List pane, select an alarm workflow.

3. In the Properties pane, on the Diagram tab, add the Alarm node in the Workflow Editor.

4. 1In the Alarm Rule Configuration window, provide the following details.

a. In the Name field, provide a name for the node.

b. Next, on the Condition tab, configure the conditions under which the rule is true. Only the following
objects are available in the alarm node - Activity and Case, and you can set conditions for only one
object in one alarm node. Another important thing to note is that you cannot set conditions using only
the “Count” and “Percentage” attributes. You must select another attribute with these two attributes to
be able to save the node. For a list of objects available for setting alarm conditions, see “Appendix B:

Reference Information” on page 235.

a Alarm Rule Configuration

MName: [Alarm
Condition = True
This rule is TRUE under the following conditions:
Object Attribute Operator  Value Boolean
~ v v ~| [
Activity ~ | Count oo w10 AND ~
Activity ~  Hours till due VAR w1l AND

Configure conditions for the alarm node
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c. Next, on the True tab, configure the action to be performed when the alarm conditions are met. You can
do one of the following:

e Send notifications to users. This option is available in alarm rules configured for both cases and
activities. Set up internal messages or emails to be sent when an alert condition is met. Specify the
following - users to whom you want to send a message (you can send messages to internal user
accounts or external email addresses.); the subject of the message; the content of the message.

a Alarm Rule Configuration @

Name:|A\arm

Condition | True

specity the objects to create or modity when this rule is I RUE,

Action Object i
~ ~| =

Send ~  Notification ~

Filter ~ | Activity ~

m,

Please specify the notification message to be sent.
To: Je=e]
Subject :

Layout Source -
Yo XOmI-FF-F- B I U AD S
= = s [@ |

Activities in the Customer Support Queue are overflowing. Please... -
4| [ | »

Configure a notification for the alarm node

e Filter activities, based on a defined criteria. This option is available only in alarm rules configured
for activities. Set up the criteria of activities to be further processed by this workflow.

<
2 Alarm Rule Configuration @

Name : | Alarm Notification |

Condition | True

»

Specify the objects to create or modify when this rule is TRUE. il

Action Object

~ ~| e
Send ~  Notification ~
Filter v Activity ~

Specify the criteria of the activities to be further processed by this workflow.

Basic = Advanced || Relationships
Type Attribute Operator Value Boolean
activities  Department name = | Service AND o~ *
activities  Activity 1D = ~ AND  ~ L
activities ~ CaselD = ~ AND  ~
activities  Subject Contains  ~ Urgent Request AND v [E
activities  Assigned to Contains  ~ AND
activities  Created on = s B AND
v o1 ~ AND v

activities  Activity priority =

Configure a filter for activities to be further processed by the workflow

5. Click the OK button to close the window.
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Configuring the Branch Node

Branch node is a decision point where you decide what kind of work is to be routed to which resource. Using
rules, you can automatically route work to the resources capable of handling it. Activities can be routed to users,
queues, departments, or another workflow. You can create various rules in which you can specify the conditions
when a particular type of work should be routed to a specified resource. You can configure the system in a way
that when one set of conditions are met the work is routed to one resource, and when another set of conditions
are met the work is routed to a different resource. Like this you can configure different sets of conditions and for
each set of met conditions, a different resource. For example, your system handles three types of queries - orders,
inquiries, and support, and you want to automatically route each type of work to a different queue. Using the
branch node, you can set rules and automatically route the work to the appropriate queues.

In the Branch node, along with the rules, you have to also define the resources to which the work is to be routed.
So, before configuring the Branch node you have to first add the nodes to the Workflow Editor, to which you
want to route the work.

S

The branch node

To configure a branch node:

%\ Important: In the branch node, along with the rules, you have to also define the resources to
Y which the work is to be routed. So, before configuring the branch node you have to first add the
nodes to the Workflow Editor, to which you want to route the work.

1. In the Properties pane, on the Diagram tab, add the Branch node in the Workflow Editor.
2. In the Branch Rule Configuration window, provide the following details.
a. In the Name field, provide a name for the node.

b. In the Rule Name field, provide a name for the rule and press the Enter Key. Select the rule name to
configure the rule properties.

c. Select one of the following options:
e This rule is always true

e This rule is true under the following conditions

If you have selected the This rule is true under the following conditions option, configure the
conditions when the rule is true.

d. Next, select the target node. Click the Select Target button and from the Select Target window select
the target node. You can choose from the following nodes:

e Queue

e  Workflow

e Department

e Completion

e Auto-acknowledgement
e Branch

e Category
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e Modify object
e Service level
e User

e Filter (outbound workflow)
Likewise, you can create multiple rules.

e. If you have created more than one rule, use the Move Up and Move Down button to change the order
of rules.

f. Lastly, you can also select a target node if no rules are found true. Select the If no TRUE rule is
found, then route to this target option, and select the target node. Click the Select Target button and
from the Select Target window select the target node.

a Branch Rule Configuration -- We... @

MName*: ‘Branch

L new rules below; ) This rule is glways true.
processing ends when a TRUE rule _
is found. @) This rule is TRUE under the following conditions:
Rule Name Specify the condition for the rule.
‘ P Object Attribute Operator Value Boolean
Rule One i & hd | | N B
Activity ' Activity Type == ~ Email ~ OR ~

If the rule is TRUE, route to this target; | Completion 1 E

[/ no TRUE rule is found, route to this target: I:l D

Configure the branch node

3. Click the OK button to close the window.

Once you have configured the rules in the branch node, the branch node and target nodes are automatically
connected by arrows. Green arrows are added pointing to targets for true conditions. And, a red arrow is
added pointing to the target for activities when no true rule is found. These arrows cannot be added or
removed manually.
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Sample
Workflows

» Inbound: Processing Inquiries at a Phone Company
» Outbound: Reviewing Outgoing Emails From Trainee Agents

» Alarm: Monitoring Activities About to be Due in One Hour



Inbound: Processing Inquiries at a Phone Company

This workflow demonstrates how to manage emails coming into a phone company. First, an auto-
acknowledgement is sent to customers and a service level is set for the emails. Then, data is automatically
extracted from emails and it is saved as part of the case and customer attributes. Then, the workflow starts
routing activities. First, emails about landline services are routed to the landline service queue. Emails about
mobile services are routed to the mobile service queue. Computer generated emails and emails about any other
topic are routed to their respective queues.

Before creating any workflow, you need to create some objects which are then used in the workflow. For this
workflow, you need to create the following objects:

O Aliases
O  Three service levels named - 8 hours SLA, 24 hours SLA, and 48 hours SLA

O Four queues, with the following names - Landline service, Mobile service, Computer generated email -
no reply needed, Unknown

O An auto-acknowledgment article. Set the article macro as auto_ack_mobi Le.

O One custom case attribute, with the name “Tracking number”. For details on creating and adding the
attributes in the screens, see Enterprise Chat and Email Administrator’s Guide.

2\ Important: Nodes are not necessarily configured in the order in which they appear in the

> workflow. For example, before configuring the Branch node, you need to first configure the nodes
that need to be used in the rules in the Branch node. To help you better understand the workflow,
the nodes in the sample workflow figure are numbered in the order in which they are to be
configured.

Validate

Genera Diagram

g% eee & @G- O-

9 1 [%IS

2 3 3
I—:! @ . = Landline service

Start Auto-Acknowledgement | Assign SLA Set field Distribute: N 6

Mobile service

%7

Computer generated email - no reply required

%8

Unlknown

Sample workflow for processing inquiries at a phone company

To create the workflow:
1. In the Start node, select aliases.

2. In the Create object node (named as Auto-acknowledgement), create the following rules:
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Landline service: Check if the subject of an email contains “Landline service”. If the condition is met,
create a new email activity with the following attributes:

i. Set the subject using the macro “activity_subject”.

ii. Set the “from” and “to” email addresses.

iii. Set the content using the “auto_ack_landline” article macro.

iv. Set the case and customer as “current”.

v. Set the activity substatus as “Ready for outbound workflow”.

Mame* : |Auto-acknowledgement |

Create new rules below; all

Condition | True

rules will be processed, Falee
Rule Name Specify the objects to create when this ruleis TRUE.
Object Type Object Subtype
~ | [
Landline service Activity ~ Email-General ~
A Specify the default values for objects that are created.
Name Type Value
Activity Priority Constant ~ ~
Due date Constant v e}
Due date time Constant ~
Subject * Macro ~  activity_subject
Description Constant ~
To email address * Macro v email_address l
From email address * = Constant ~ landlineservice@company.com
Coentent Macro ~ auto_ack_landline
Case* Constant ~ Current W
Customer* Constant ~  Current ~
Activity Substatus * Constant ~ Ready for outbound workflow ~~

Create an auto-acknowledgement

Mobile service: Check if the subject of the email contains “Mobile service”. If the condition is met,

create a new email activity with the following attributes:

i. Set the subject using the macro “activity_subject”.

ii. Set the “from” and “to” email addresses.

iii. Set the content using the “auto_ack_mobile” article macro.

iv. Set the case and customer as “current”.
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v. Set the activity substatus as “Ready for outbound workflow”.

Mame* : |Auto-acknowledgement |

Create new rules below; all Condition ﬁ False

rules will be processed.

Rule Name Specify the objects to create when this rule is TRUE.

| el Object Type Object Subtype

 Mobile service o] hd vl

Landline service Activity ~ Email-General ~
Specify the default values for objects that are created.
Name Type Value

¥ Activity Priority Constant ~ ~

Due date Constant \/ =
Due date time Constant ~
Subject * Macro ~  activity_subject d
Description Constant ~
To email address * Macro ~  email_address d
From email address* = Constant ~  mobileservice@company.com
Content Macro v auto_ack_mobile o
Case” Constant ~  Current ~
Customer * Constant ~  Current i
Activity Substatus * Constant ~ | Ready for outbound workflow

Create a new email

Connect the Start node with this node.
3. In the Service Level node (named as Assign SLA), configure the following rules.

a. Landline service SLA: Check if the subject of the email contains “Landline service”. If the condition is
met, set the activity service level as ‘“24 hours SLA”.

Mame” ;| Assign SLA ‘

Create new rules below; processing

() This rule is always true.
ends when a TRUE rule is found.

his rule is TRUE under the following conditions:

Rule Name
| = Specify the condition for the rule.
=
# | Object Attribute Operator Value Boolean
Mobile service SLA
Landline service SLA
Email ~ | Subject ~  Contains ~  landline.. AND ~
If the rule is TRUE, then set activity service
level: 24 hours SLA “
¥ the rule is TRUE, then set case service level: <Selects v
[+]1f no TRUE rule is found, then set activity service level: 48 hours SLA ~
[¥] 1 no TRUE rule is found, then set case service level: <Select> e

Set an SLA
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b. Mobile service SLA: Check if the subject of the email contains “Mobile service”. If the condition is

met, set the activity service level as “8 hours SLA”.

Mame* :|Assign SLA |
Create new rules below; processing O This rule is always true,
ends when a TRUE rule is found. N
®) This rule is TRUE under the following conditions:
Rule Name
| | Specify the condition for the rule.
b
Object Attribute Operator Value Boolean
Mahile service SLA
Landline service SLA o
Email ~ | Subject ~ Contains ~ Mobilese.. AND
If the rule is TRUE, then set activity service
level: 8 Hours SLA '
If the rule is TRUE, then set case service level: <Selects v
[¥17 no TRUE rule is found, then set activity service level: |48 hours SLA ~
[ ¥ no TRUE rule is found, then set case service level: «Select> ~
Set an SLA

c. If none of the rules configured in this node are true, set the activity service level as “48 hours SLA”.

Connect the Create object node (named as Auto-acknowledgement) with this node.
In the Modify object node (named as Set Fields), configure the following rules.

a. Set tracking number: Configure the following conditions for the rule.

e Email content contains “Tracking number:”, OR
e Email content contains “Rebate ID:”, AND

e Case type is “New”

Name” ;|SEtF|eIds |

Create new rules below; all

p Condition = True  False
rules will be processed.

Rule Name () This rule is always true.

| | (®) This rule is TRUE under the following conditions:

Set tracking number Object Attribute Operator  Value Boolean
Set customer name ) ~ ~ v| | v [
=
Email ~  Content ~  Contai.. ~ Tracking.. OR ~
Email ~  Content v Contai.. “ RebateID: AND ~
Activity ~~ Case Type == ~ Mew ~ AND ~

Configure conditions for the rule
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If the conditions are met, set the value in the “Tracking number” field (custom field) using the pattern
“Tracking number:”

MName" : |Set Fields
e new rules below; all Condition ﬁ False
rules will be processed.
Rule Name Specify the objects to maodify when this rule is TRUE.
| [« Object
| Set tracking number | =
Set custorner name T “
Specify the values for objects that are modified,
- Name Type Value
Description Constant ~
Due date Constant ~ =
Due date time Constant ~
Owner Constant ~ [eee]
Severity Constant ~ e
Solution Description  Pattern ~ Tracking number:

Set the tracking number

b. Set customer name: Configure the following conditions for the rule.
e Email content contains “First name:”, AND
e Email content contains “Last name:”, AND

e Case type is “New”

Name*:

Set Fields |

Create new rules below; all
rules will be processed.

Rule Name O This rule is always true.

‘ _‘JJ ®) This rule is TRUE under the following conditions:

Condition True  False

Settndingnumber || Oject  Adtrise  Opeator  Vake  Bookean

Set cust =l

Seautomername v v vl | v|e
Email v Content ~ | Contai..  Firstna.. ~AND ~
Email v Content ~ Contai.. v Llastna. @ AND ~
Activity v Case Type | == ~ New v AND ~

Configure conditions for the rule
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If the conditions are met, set the value in the “First name” and “Last name” fields using the patterns
“First name:” and “Last name:” respectively.

MName* : | Set Fields

Create new rules below; all
rules will be processed.

Rule Name

Set customer name

Condition | True | False
Specify the objects to modify when this rule is TRUE.
Object

> =
Customer-Individual p
Specify the values for objects that are modified.
Name Type Value
Date of birth Constant v =
Employment status Constant ' ~
First name Pattern ~  First name:
Gender Constant ~ ~
Job title Constant w
Last name Pattern ~  Last name:
Marital status Constant ~ ~
Middle name Constant w

Set the customer name

Connect the Service Level node (named as Assign SLA) with this node.

In the Queue node (named as Landline service), select the “Landline service” queue.

In the Queue node (named as Mobile service), select the “Mobile service” queue.

In the Queue node (named as Computer generated email - no reply needed), select the “Computer generate
email - no reply needed” queue.

In the Queue node (named as Unknown), select the “Unknown” queue.

In the Branch node (named as Distribute emails), create the following rules. In this node, we will use the
nodes configured in steps 5-8.

a. Landline service emails: Configure following conditions for the rule:

e To email address is “landlineservice @company.com”, AND

e Email content does not contain “auto-ack®, AND

If the conditions are met, route the activity to the “Landline service” queue.

MName* : | Distribute emails

Create new rules below;
processing ends when a TRUE
rule is found.

) This rule is always true.

®) This rule is TRUE under the following conditions:

Rule Name Specify the condition for the rule.
‘ = Object Attribute Operator Value Boolean
Landline service emails i i i | | M=
Mobile service emails v Email ~ | Toemail addr.. ~ == ~  landline... AND ~
No reply needed Email ~  Content ~ Motcont.. “~ auto-ack AND w

If the rule is TRUE, route to this target: EI

[+]1f no TRUE rule is found, route to this target: |I|

Configure conditions for the rule
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b. Mobile service emails: Configure the following conditions for the rule:
e The To email address is “mobileservice @company.com”, AND
e Email content does not contain “auto-ack®, AND

If the conditions are met, route the activity to the “Mobile service” queue.

Name* :|D|str|bute emails |

Create new rules below:
processing ends when a TRUE
rule is found.

I This ruleis glways true,
® This rule is TRUE under the following conditions:
Rule Name Specify the condition for the rule.

| P Object Attribute Operator Value Boolean
[ ~ e ‘ | | [

Landline service emails i

- Email ~ Toemail addr.. ~ == ~  mobiles.. AND ~

Email ~  Content ~ MNotcont.. v auto-ack AND

Mo reply needed

If the rule is TRUE, route to this target: E
IFnﬂTRUEru\E\sfnund,mutetnth\starget: E|

Configure conditions for the rule

c. No reply needed: Configure following conditions for the rule:
e Email content contains “auto-ack®, AND

If the conditions are met, route the activity to the “Computer generate email - no reply needed” queue.

Name* :|D|stnbute emails |

Create new rules below; O This rule is always true,

processing ends when a TRUE -

rule is found. (® This rule is TRUE under the following conditions:
Rule Name Specify the condition for the rule.

| -_'_IJ v Object Attribute Operator Value Boolean
vl vl v|@=

Landline service emails

e

Email ~ Content v Contains v auto-reply AND ~

If the rule is TRUE, route to this target: |I|
[¥11f no TRUE rule is found, route to this target: E

Configure conditions for the rule

d. If none of the rules configured in this node are true, route the activity to the “Unknown” queue.

The Distribute emails node is automatically connected to the queue nodes used in the various conditions.
Connect the Modify object node (named as Set Fields) with the Branch node (named as Distribute emails).

Outbound: Reviewing Outgoing Emails From Trainee
Agents

This workflow routes all outbound emails created by users in the user group Trainee, that have the word Urgent
in the subject, to a Supervision queue. Supervisors can then pull the emails from the queue and accept or reject

the response after reviewing it.
Before creating any workflow, you need to create some objects which are then used in the workflow. For this

workflow, you need to create the following objects:
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» A user group named Trainees.

» A Supervision queue imported from the MRD, from which supervisors can pull activities for review.

Important: Nodes are not necessarily configured in the order in which they appear in the

% workflow. For example, before configuring the Branch node, you need to first configure the nodes
that need to be used in the rules in the Branch node. To help you better understand the workflow,
the nodes in the sample workflow figure are numbered in the order in which they are to be
configured.

Properties: Review trainee agents

| ” e | | Validate | | Audit |

Generzl | Diagram

FESe 8- ENEN -@

-8 &

Start Review Urgent Superyision Queue

Sample outbound email review workflow

To create the workflow:
1. In the Start node, select the “Trainees” user group.
2. In the Queue node (named as Supervision), select the “Supervision” queue.

3. Inthe Select Queue window, select the Before option to route the responses to the Supervision queue before
the email has been sent out of the application.

s ™
a Select Queue g
Name Description
E'E] Default exception queue System provided queue for exceptions

[ Ece_Email MRD_Email_s5
EB ECE_Email_MRD_Service Supervisory Queue for MRD ECE_Email_...

E'ﬂ Supervision Queue Supervisory Queue for MRD ECE_Outbou...

Route to target before or after the email has been sent out of the application: Before

0K Cancel Help

Select the option to route responses to the queue before the email is sent

4. Click OK.
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5. In the Branch node (named as Review ‘Urgent’), check the activity subject for the word “Urgent”. If the
condition is met, route the activity to the “Supervision” queue. This node is automatically connected to the
Queue node. Connect the Start node with the Branch node.

Name‘:‘Revlew'Urgent‘ ‘

Create new rules below;

. O This rule is always true,
processing ends when a TRUE

rule is found. (®) This rule is TRUE under the following conditions:

Rule Name Specify the condition for the rule.
‘ ‘_'_"J Object Attribute Operator Value Boolean

Condition hd hd V‘ ‘ ~| e
el e o [ e e <

If the rule is TRUE, route to this target: |I|
[J1 no TRUE rule is found, route to this target: I:l E

Configure the branch rule

Alarm: Monitoring Activities About to be Due in One
Hour

Create a workflow to check for activities that are about to be due in an hour, and notify the supervisor of the
same.

Genersl  Diagram

(4% + (B8 (09"
—0

Start One-hour before overdue

Sample workflow for monitoring activities that are about to be due in an hour

To create the workflow:
1. In the Start node, select the queues to be monitored and set the schedule.
2. In the Alarm node (named as One hour before overdue), do the following.

a. In the Condition tab, set the following conditions:
i. Activity is going to be due in an hour, AND

ii. Activity status is not “Completed”.
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3.

: Name :|One hour before overdue

Condition = True

This rule is TRUE under the following conditions:

Object Attribute Operator Value Boolean

~ ~ | ~ | | ~ | =
Activity ~  Hourstill due vio== w1 AND ~
Activity  ~ Activity Status R ERE ~  Completed ~ AND ~

Set the conditions

1. Set the To email addresses.

ii. Set the subject as “There are activities due in one hour”.

iii. Create the content of the email.

Nama:|0ne hour befare overdue |

Condition | True

Specify the objects to create or modify when this rule is TRUE.

Action Object
e hd R

Send ~  MNotification ~
Please specify the notification message to be sent.

To: agent@company.com |
Subject : There are activities due in one hour

Layout Source
wo o X M@ I-FF-F-B 7 U A% = = = iz
iz E S| E

These are activities in the system that are due in one hour, Please investigate.

Thanks,

Set the notification

Connect the Start node with the Alarm node.

In the True tab, create a notification to be sent to supervisors, if the conditions are met.
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Appendix A: Predefined
Delivery Exceptions

This appendix contains a list of predefined delivery exception phrases available in the system.

Phrases Checked in Email Addresses

The following 16 phrases are checked in email addresses.

Name Phrase Failure

-MaiSer- -MaiSer- Temporary
auto-sender auto-sender Permanent
Autoresponder Autoresponder Permanent
badaddress badaddress Temporary
ccmail_agent ccmail_agent Temporary
Mail-Gateway Mail-Gateway Temporary
Mail_master Mail_master Temporary
Mailer Mailer Temporary
mail-daemon mail-daemon Temporary
mdaemon mdaemon Temporary
postadm postadm Temporary
postmast postmast Temporary
postmaster postmaster Temporary
supervisor supervisor Permanent
unknown unknown Temporary




The following 112 phrases are checked in the subject of the email.

Phrases Checked in the Subject of Emails

Name Phrase Failure

Abwesenheitsnotiz Abwesenheitsnotiz Permanent
Address Unavailable Address Unavailable Temporary
Admin Admin Permanent
Adressénderung Adressénderung Permanent
Auto answer Auto answer Permanent
Auto response Auto response Permanent
Auto-response Auto-response Permanent
Automated response Automated response Permanent
Automated Omnigate Message Automated Omnigate Message Permanent
Automatic reply Automatic reply Permanent
Automatic response Automatic response Permanent
Automaticka odpoved Automaticka odpoved Permanent
AUTOMATICKA ODPOVID AUTOMATICKA ODPOVID Permanent
Automatisch antwoord Automatisch antwoord Permanent
Automatisk_svar Automatisk_svar Permanent
Automatsvar Automatsvar Permanent
AutoResp AutoResp Permanent
Autoresponse Autoresponse Permanent
Autosvar Autosvar Permanent
away from my email away from my email Permanent
away from the office away from the office Permanent
bad-style address bad-style address Temporary
Bevestiging Ontvangen Bevestiging Ontvangen Permanent
bounced message bounced message Permanent
Conversion fail Conversion fail Permanent
could not send message could not send message Permanent
Delivery Confirmation Delivery Confirmation Permanent
Delivery Error Delivery Error Temporary
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Name Phrase Failure

Delivery Failed Delivery Failed Temporary
Delivery Failure Delivery Failure Temporary
Delivery notification Delivery natification Temporary
Delivery Problem Notification Delivery Problem Notification Permanent
Delivery Report Delivery Report Temporary
Delivery Returned Delivery Returned Temporary
Delivery Status Notification Delivery Status Notification Temporary
Delivery-Report Delivery-Report Permanent
Details of my business trips Details of my business trips Permanent
Dikuji za maila Dikuji za maila Permanent
E-mail Received! E-mail Received! Permanent
E-mail Unavailable E-mail Unavailable Permanent
Error Response Error Response Temporary
Error sending mail Error sending mail Temporary
Extended Absence Response Extended Absence Response Permanent
Failed mail Failed mail Temporary
failed message delivery failed message delivery Permanent
failure notice failure notice Temporary
lhre Mail Ihre Mail Permanent
Inaccessible e-mail address Inaccessible e-mail address Temporary
INBOUND MESSAGE ERR INBOUND MESSAGE ERR Permanent
Invalid mailbox Invalid mailbox Temporary
Invalid user Invalid user Temporary
Keep more of what you make! Keep more of what you make! Permanent
Mail Did Not Get Through Mail Did Not Get Through Temporary
Mail error Mail error Temporary
Mail failed Mail failed Temporary
Mail failure Mail failure Temporary
Mail recipient has left Enter-Net Mail recipient has left Enter-Net Permanent
Maternity Leave Maternity Leave Permanent
message failed message failed Permanent
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Name Phrase Failure

message not sent message not sent Permanent
message rejected message rejected Permanent
message was not sent message was not sent Permanent
NDN: NDN: Temporary
No interest!! No interest!! Permanent
No such user No such user Temporary
Non-Delivery Non-Delivery Temporary
Non-existing employee Non-existing employee Permanent
Nondeliverable Nondeliverable Temporary
Not a WORLDPATH client Not a WORLDPATH client Permanent
Non deliverable Non deliverable Temporary
Not delivered Not delivered Temporary
not_a_jono_addy not_a_jono_addy Permanent
Odpoved na zpravu Odpoved na zpravu Permanent
Ontvangstbevestiging Ontvangstbevestiging Permanent
Out of email contact Out of email contact Permanent
Out of office Out of office Permanent
Out of the office Out of the office Permanent
ponse_automatique ponse_automatique Permanent
problem delivering your mail problem delivering your mail Permanent
Response from Administrator Response from Administrator Permanent
Response from bdbad Response from bdbad Permanent
Response from rlozano Response from rlozano Permanent
Resposta Automatica Resposta Automatica Permanent
Return message Return message Permanent
Returned Mail Returned Mail Permanent
Returned to Sender Returned to Sender Permanent
Réponse automatique Réponse automatique Permanent
Service Message Service Message Temporary
SMS error response SMS error response Temporary
SMS message SMS message Permanent
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Name Phrase Failure

system system Permanent
Thanks for writing ER! Thanks for writing ER! Permanent
Thanks for your e-mail message!! Thanks for your e-mail message!! Permanent
Troubles delivering the message Troubles delivering the message Permanent
Unable to deliver mail Unable to deliver mail Temporary
Undeliverable Undeliverable Temporary
unknown address unknown address Temporary
unknown domain unknown domain Temporary
unknown recipient unknown recipient Temporary
User Not at VISTA.COM Domain User Not at VISTA.COM Domain Permanent
user not found user not found Temporary
user unknown user unknown Temporary
vacation vacation Permanent
Warning - delayed mail Warning - delayed mail Permanent
X.400 Inter-Personal Notification X.400 Inter-Personal Notification Temporary
Your Message To Juno Your Message To Juno Permanent
Your message was received Your message was received Permanent
ZAZ Reply ZAZ Reply Temporary
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Appendix B: Reference
Information

» Objects Available for Setting Conditions in Rule Nodes

» Objects Available for Setting Conditions in the Alarm Node



This chapter lists the objects available for setting conditions in various workflow nodes.

Objects Available for Setting Conditions in Rule

Nodes

7\ Important: When selecting an operator, keep in mind that “==" is for an exact value while
% “match” is used for basic expressions.

Activity

Attributes Values Operators
Activity mode Inbound, Outbound, None ==, I=
Activity priority 1to7 ==, Iz, <, >, <=, >=
Activity subtype Email - General, Email - Webform, Email - ==, I=

Secure, Email - Permanently undeliverable,

Email - Temporary undeliverable, Email - Reply,

Email - Forward, Email - Compose, Email -

Auto acknowledgement, Email - Group reply,

Email - Redirect, Email - Undispatch, Email -

Supervisory accept, Email - Supervisory reject,

Email - Supervisory reattempt, Email -

Notification, Email - Transcript, Phone -

General, Email - Reviewable
Activity type Email ==.I=
Case type None, Existing, New ===
Contact person ID — == =, <, >, <=, >=
Contact point ID - ===, <, >, <=, >=
Customer ID — ==, 1=, <, >, <=, >=
Description — Contains, Not contains, Matches, Not

matches, Begins with, Not begins with

Language Afrikaans, Albanian, Arabic, Bengali, Bulgarian, | ==, |=

Croatian, Czech, Danish, Dutch, English,
Estonian, Finnish, French, German, Greek,
Gujarati, Hebrew, Hindi, Hungarian,
Indonesian, Italian, Japan, Kannada, Korean,
Latvian, Lithuanian, Macedonian, Malayalam,
Marathi, Nepali, Norwegian, Persian, Polish,
Portuguese, Punjabi, Romanian, Russian,
Simplified Chinese, Slovak, Slovene, Somali,
Spanish, Swabhili, Swedish, Tagalog, Tamil,
Telugu, Thai, Traditional Chinese, Turkish,
Ukrainian, Urdu, Viethamese
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Attributes

Last action reason

Values

Assigned by system, Forwarded, Redirected,

Replied, Save draft, Assigned for supervision,

Rejected, Waiting for approval, Save draft to
supervise, Sent

Operators

Subject - Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
Case
Attributes Values Operators
Description - Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
Severity Urgent, High, Medium, Low ==, I=

Solution description

Contains, Not contains, Matches, Not
matches, Begins with, Not begins with

Subject

Contains, Not contains, Matches, Not
matches, Begins with, Not begins with

Customer - Common

Attributes

Values

Operators

Entitlements

Contains, Not contains, Matches, Not
matches, Begins with, Not begins with

How referred

Website, Customer, Partner, Reseller

Industry

Level

Finance, Health care, Telecom

Gold, Platinum, Premium, Silver, Standard

Marketing Segment

Contains, Not contains, Matches, Not
matches, Begins with, Not begins with

Preferred agent User names ==, =
Customer - Group
Attributes Values Operators

Customer name

Contains, Not contains, Matches, Not
matches, Begins with, Not begins with

Group type

Association, Club, Household, Joint account,
Membership, other

Appendix B: Reference Information 237




Attributes Values Operators

No. of members - ==, I=, <, >, <=, >=

Region Asia Pacific, Europe, United States ==, =
Customer - Individual

Attributes Values Operators

Date of birth ==, l=, <, >, <=, >=

Employment status

First name

Gender

Job title

Last name

Marital status

Date

Part time, Full time, Temporary, Contract, Intern,

Unemployed

Male, Female

Married, Single, Separated, Divorced, Widowed

Contains, Not contains, Matches, Not
matches, Begins with, Not begins with

Contains, Not contains, Matches, Not

matches, Begins with, Not begins with

Contains, Not contains, Matches, Not

matches, Begins with, Not begins with

Middle name

Contains, Not contains, Matches, Not
matches, Begins with, Not begins with

Customer - Organization

Attributes

Values

Operators

Customer name

Contains, Not contains, Matches, Not
matches, Begins with, Not begins with

No. of employees

==, =, <, >, <=, >=

Region

Sector type

Asia Pacific, Europe, United States
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Email

Attributes Values Operators
Bcc email address - Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
cc email address - Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
Content — Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
Content type .htm, .txt ==, =
From email address — Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
Header — Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
Reply to email address - Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
Subject - Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
To email address — Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
To or cc email address — Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
Queue

Available only in outbound workflows and alarm workflows.

Attributes Values Operators

Queue name - Contains, Not contains, Matches, Not
matches, Begins with, Not begins with

User

Available only in outbound workflows and general workflows.

Attributes Values Operators

First name — Contains, Not contains, Matches, Not
matches, Begins with, Not begins with

Last name — Contains, Not contains, Matches, Not
matches, Begins with, Not begins with
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Attributes Values Operators

Manager Manager names ==, 1=

User name — Contains, Not contains, Matches, Not
matches, Begins with, Not begins with

Objects Available for Setting Conditions in the Alarm
Node

Case

Attributes Values Operators

Age days - ==, I=, <, >, <=, >=
Age hours - ==, l=, <, >, <=, >=
Age minutes - ==, I=, <, >, <=, >=
Case status Closed, Open, Ready for closure ==, I=

Count — ==, I=, <, >, <=, >=
Count over due - ==, 1=, <, >, <=, >=
Days after due — ==, I=, <, >, <=, >=
Days till due - ==, =, <, >, <=, >=
Hours after due — ==, Iz, <, >, <=, >=
Hours till due - ==, =, <, >, <=, >=
Minutes after due - ==, =, <, >, <=, >=
Minutes till due - ==, I=, <, >, <=, >=
Percentage - ==, =, <, >, <=, >=
Percentage over due - ==, I=, <, >, <=, >=
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Activity

Attributes Values Operators
Activity status Assigned, Assignment, Completed, New, Pre- ==, =

completion, preworkflow, workflow
Activity substatus Assigned - New, Assigned - Pending, Assigned | ==, I=

- Wrap up, Assigned - Error, Assigned - In

progress, Assigned - Ready for internal

assignment, Assigned - Ready for external

assignment, Assignment - Error, Assignment -

In progress, Assignment - Scheduled,
Age days - ==, 1=, <, >, <=, >=
Age hours - ==, I=, <, >, <=, >=
Age minutes - ==, |z, <, >, <=, >=
Count — ==, l=, <, >, <=, >=
Count over due - ==, Iz, <, >, <=, >=
Days after due - ==, |z, <, >, <=, >=
Days till due — ==, =, <, >, <=, >=
Hours after due - ==, l=, <, >, <=, >=
Hours till due - ==, |z, <, >, <=, >=
Last action reason Assigned by system, Forwarded, Redirected, ==, =

Replied, Save draft, Assigned for supervision,

Rejected, Waiting for approval, Save draft to

supervise, Sent
Minutes after due - ==, I=, <, >, <=, >=
Minutes till due - ==, |z, <, >, <=, >=
Percentage — ==, I, <, >, <=, >=
Percentage over due - ==, |z, <, >, <=, >=
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Appendix C: Kiwi
Chat Template Sets

» About Kiwi Template Sets

» Creating Template Set Folders

» Changing General Settings

» Changing Header and Footer Colors
» Changing Color of Buttons

» Changing the Size of Chat Window
» Configuring Login Page Parameters
» Adding New Fields

» Enabling Anonymous Chats

» Enabling Auto-Login



Configuring Kiwi Templates for Customer SSO
Configuring Alternative Engagement Options
Configuring Off-the-Record Options

Setting Maximum Length for Chat Messages
Disabling Rich Text Editor

Hiding Emoticons

Changing Agent and Customer Images
Changing Chat Bubble Colors

Changing Sound Alert

Configuring Widgets

Configuring Survey Questions

Turning Off Surveys

Changing the Off Hours Message

Changing Chat Transcript Options

Deleting Template Sets
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This chapter will assist you in understanding how to update and edit Kiwi template sets. Kiwi template sets from
prior versions of the application are supported and can be edited. Kiwi template sets are not included in new
installs of ECE 12.0.

For template sets for callback activities, see “Callback Template Sets” on page 101. For information about
editing Aqua chat template sets, see “Aqua Chat Template Sets” on page 72.

About Kiwi Template Sets

244

An entry point can be mapped to multiple template sets and multiple entry points can use the same template set.
The template set, Kiwi is supported from previous versions of the application, but is not included in new
installations, is shipped with the application and can readily be mapped to any number of entry points.

The Aqua template set should be used for new chat configurations. For more information, see “Aqua Chat
Template Sets” on page 72.

@ Important: The system supplied templates should not be deleted.

The template sets are managed from the web server.

What Makes up a Kiwi Template?

A template consists of a set of pages that are designed to work together. Typically, a chat template has the
following pages:

» A pre chat form

» The chat area

» Post chat survey form

» The off-hours page

» The alternative help options page.

All these pages can be customized to meet your business needs.
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Pre chat form

Customers fill up this form to start a chat.

LZ7 Live Chat

by Cisco

Name
Email
Phone number

Your question

N : START CHAT
Powered by Clsco

Pre chat form

Chat Area

Agent and customer exchange chat messages in the chat area.

LJ7 Live Chat

by Cisco
Hi. | need help. 1
John- B:17 AM

“You are now chatting with ariel

1 HiJohn. How can | help you, today?

ariel * 5:20 AM
I'm looking for the perfect gift 1
John - 2:21 AM
B I U @ 800 characters left

The chat area
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Post Chat Survey

Customer is presented a survey form at the end of the chat.

Save Transcript Print Transcript

Help us improve your chat experience by taking a small
survey,

How would you rate the quality of the answers you
received?

What about the speed with which we answered your
questions?

How would you rate your overall chat experience?

Additional Comments:

Poweread by Cisco m

Post chat survey form

Off Hours Page

An off-hours page is displayed to customers, typically when the customer tries to chat during business off hours.

Thank you for your inquiry. Our service hours are 9am-
Spm PST, Monday-Friday.

If you are trying within the service hours and still getting
this message, please try again after some time.

The off hours page
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Do I need to create new templates or just use the default ones?

The template set, Cisco Kiwi, is shipped with the application. You must always create a copy of the default
template set and customize it to look like your website.

You can choose to use one template set for all your chat entry points for a consistent look and feel. Alternatively,
you can use different templates, so that the look and feel of each one is targeted towards a specific audience.

How easy are the templates to modify?

The templates are easy to modify. All the properties of the templates sets are modified using the files available
on the web server. It is possible to make a number of layout and wording changes as well as branding changes to
match them with the look and feel of your website.

Some important things to note:

» You must have a good knowledge of the HTML and CSS languages to make changes in the HTML and CSS
files.

» Always create a backup copy of the files before making any changes.

The following table describes the files that can be changed. All the files are available on the web server at
Cisco_tHome\eService\templates\chat\ TMW&_NW

Use To

\Properties\chat_/ocale.properties | » Update the text displayed on the chat pages.

\eGainLiveConfig.js Change the fields displayed on the login page.

Enable anonymous chats.

Enable auto login.

Show emoticons.

Configure the height of the chat window.

Configure the maximum length allowed for customer messages.
Configure sound alert for chat messages.

>
>
>
4
4
>
>
» Hide rich text editor.

v

css\ transcript.css, Configure the look and feel of the chat pages, the chat typing area, and the text
mailtranscript.css editor toolbar.

\chat\less\chat-main.less

\chat.html » Change the layout of the chat page.
Images folders: » Change the images used.
T e Name\images Note: The size of the custom images should match the size of the defaultimages.
= However, if you are changing the size of the chat windows, you can adjust the
4 . A X
TW&—NW\ templates\chat) images size to match the new windows.

img
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Creating Template Set Folders

You need access to the web server to perform this task.

o\ Important: Anytime you update or create new templates, you must copy the templates files on all
% web servers in your installation.

To create a new template set:
1. On the web server, browse to Cisco_tHome\eService\templates\chat.
2. Create a copy of the Kiwi folder and rename the folder.

3. The new template set is created. You can now edit the files in the template folder to configure your template
settings and to customize the look of your templates. Except for the following files, all the files can be
changed.

O connection.js
O session.js

O messenger.js
O audio.js

O transcript.js
O blank.html

O v11l.version

O Allfile in the Libs folder
After creating the template set, some of the things that you can do are:
» Configure the login page parameters (page 252)
» Enable anonymous chats (page 256)
» Hide the emoticons option (page 275)
» Set the maximum length of chat messages (page 263)
» Configure widgets (page 271)
» Configure the survey questions (page 272)

» Change the off hours message (page 274)

Changing General Settings

To change the general properties for templates:

1. Open the
Cisco_tome\eService\templates\chat\ 7emplate Folder\properties\chat_locale.properties
file in a text editor.

2. Edit the values for the following properties:
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Q

Q

Q

Q

Q

Q

L10ON_DOCUMENT_TITLE: Change the title of the chat window. The default value is Live Collaboration
by Cisco.
L10ON_BROWSER_CLOSE_MESSAGE: Change the message displayed to the customer when he closes the

chat window during a chat session.

L10ON_CLOSE_MESSAGE: Change the message displayed to the agent when the customer closes the chat
session.

L1ON_NEW_MESSAGE: Change the text that is displayed in the task bar and the title window of chat
when the agent sends a new message to the customer.

L1ON_START_CHAT_BUTTON: Change the text of the button for starting chat. The default value is Start
Chat.

L10N_SUBMIT: Change the text of the button for sending chat messages. The default value is Send.

L1ON_WINDOW_CLOSE_BUTTON: Change the text of the button for closing the chat window. The default
value is Close window.

Save the changes.

Clear the browser cache and access the chat link to test the changes.

Changing Header and Footer Colors

This section talks about changing the header and footer of all pages in the Chat Customer Console, that is, the
Login page, the Chat page, and the Survey page.

To change the header and footer colors:

1.

Open the Co':cof/—fom\eService\templates\chat\TW{atefFolo{er\chat\less\chat—main. less
file in a text editor.

To change the header color, locate the #eg-chat-header class and in the .wrap class change the value
of the background property.

To change the footer color, locate the .submit-section class and change the value of the background
property.

Save the changes.

Clear the browser cache and access the chat link to test the changes.
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Changing Color of Buttons

This section talks about changing the colors for Start Chat, Send, and Close buttons.

125 Live Chat

by Cisco

Hi. | need help.

John - 2:36 AM

*fou are now chatting with srie!

Hi John. How can | help you?

ariel - 8:38 AM

I'm looking far the perfect gift.

John - 2:38 AM

B I U & 800 characters left

Cisco m

Out-of-the-box color of buttons

To change button colors:

1. Open the Cisco_ttome\eService\templates\chat\ Zemplate Folder\chat\less\chat-main.less
file in a text editor.

2. Locate the . kiwiSubmit class and change the value of the .gradientBackground property.

3. Save the changes.
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4. Clear the browser cache and access the chat link to test the changes.

PURPLE nile  *

VAR L B

Hi. | need help.

You are now chatting with ariel

HiJohn. How can | help you, today?

aried * 2:20 AM

I'm looking for the perfect gift

U@ 800 characters left

Custom color of buttons

Changing the Size of Chat Window

This section talks about defining the size of the chat window.

To change the size of the chat window:

1.

Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig.js fileina
text editor.

Edit the values for the following properties:

o

Q

Q

chatWindowWidth: Set the width of the chat window. The width for the login, chat, survey, and thank
you pages are the same. The default value is 419 pixels.

chatWindowHeight: Set the height of the chat window. The default value is 678 pixels.
chatLoginWindowHeight: Set the height of the login page. The default value is 623 pixels.
chatSurveyWindowHeight: Set the height of the survey page. The default value is 615 pixels.
chatThanksWindowHeight: Set the height of the thank you page. The default value is 450 pixels.

chatWindowWidthWithWidget: Set the width of the chat window when widgets are displayed on the
login page and during the chat session. The default value is 830 pixels.

minWidthForShowingSidebar: Set the minimum width for showing the widget. The default value is
796 pixels.

Save the changes.
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4. Clear the browser cache and access the chat link to test the changes.

Configuring Login Page Parameters

Build the web form which customers must fill in to initiate a chat. The system uses the customer’s contact details
(for example, email address, phone number, and so on) to identify existing customers and add the chat session to
their customer records automatically. It also creates customer record for new customers.

You can:
» Change the text of the options
» Remove fields
» Change the order of fields

» Change the primary key

Name

Email
Phone number

Your question

X START CHAT
Cisco

Out-of-the-box login page

To configure the login page:

1. Open the Cisco_ttome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig. js fileina
text editor.

2. Locate the LoginParameters property, and do the following.

a. To remove an existing field, select the code for the field and delete it from the file. For example, to
remove the phone number from the login page, delete the following lines:

{
paramName : 'L10ON_PHONE_NUMBER_PROMPT',
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3.

objectName : 'casemgmt::phone_number_data’',

attributeName : 'phone_number',
primaryKey : '0',

required : '0',

minLength : '0',

maxLength : '13',

fieldType : '1',

validationString : ''
3,

@ Important: Do not remove a field that is set as the primary key.

b. To change the order of the fields, remove the code for the field you want to move and paste it at the
new location. Make sure to copy the complete set of lines for a field and move them to the new
location.

c. To change the required fields, locate the attribute which you want to change and do the following:

i. For the attribute, locate the property required and change the value to 1 to make it a required
field, or change the value to 0 to make it an optional field.

If you are setting a field as required, you must set the minimum length allowed for the field.

ii. In the attribute section, locate the property minLength and set a minimum length for the field. You
can also set the maximum length by configuring the maxLength setting.

d. By default, the email address is set as the primary key for the login page. You can choose to change the
primary key to phone number. No other field can be set as the primary key. Also, note that only one
field can be set as the primary key. To change the primary key, do the following:

@ Important: Only the customer phone number or email address can be set as the primary key.

i. Locate the section for email address by searching for attributeName : 'email_address'.In
this section, locate the primaryKey property and set the value to 0.

ii. Next, locate the section for phone number by searching for attributeName
"phone_number'. In this section, locate the primaryKey property and set the value to 1.

Also, the attribute that is set as the primary key needs to be marked as a required field.

iii. In the phone number section, locate the property required and change the value to 1.

Open the Cisco_ Home\eServi ce\templ.ates\TW@_Polder\properties\chat_LocaZa.proper‘t'ies
file in a text editor.

a. You can change the error message for the fields displayed on the login page. Locate the following
properties and provide new labels for the fields:

e ERROR_NAME: Change the error message of the name field.

e ERROR_EMAIL: Change the error message of the email field.

e ERROR_PHONE: Change the error message of the phone field.

e ERROR_SUBJECT: Change the error message of the question field.
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b. You can also change the text of the fields displayed on the login page. Locate the following properties
and provide new labels for the fields.

e L10ON_NAME_PROMPT: Change the label of the name field.

e L10ON_EMAIL_PROMPT: Change the label of the email field.

e L10N_PHONE_NUMBER_PROMPT: Change the label of the phone number field.
e L10ON_YOUR_QUESTION_PROMPT: Change the label of the text field.

e L10ON_CHARACTER_COUNT: Change the text of the message displayed to indicate the character
count for the test box. Make sure you do not delete {0} from the message.

e L10N_MESSAGE_LENGTH_ERROR: Change the message displayed when the message of the
customer exceeds the allowed message length. As part of the message, if you want to display the
allowed length and the number of characters the user has typed, make sure you retain
(MESSAGE_LENGTH) and (MAX_LENGTH) in the new message.

4. Save the changes.

5. Clear the browser cache and access the chat link to test the changes.

Adding New Fields

Along with full name, email address, and phone number, you can use custom attributes on the login page.

Custom attributes created for the following objects can be added to the login screen. For details about creating
these attributes, see the Enterprise Chat and Email Administrator’s Guide.

o Customer Data
o Contact Point Data
O Activity Data

The following table lists the fields that can be added to the login page. It also lists the attribute names and object
names for each field. You will need this information to add new fields to the login screen.

For Object Name Attribute Name

Full Name casemgmt:individual_customer_data | full_name

Email Address casemgmt::email_address_contact_ email_address

point_data

Phone Number casemgmt::phone_number_data phone_number

Subject, Custom casemgmt::activity_data subject

attributes added to If the custom attributes added to the object has two words,

activity data replace the space with underscore (). For example, if the attribute
created is More details, the attribute name will be
more_details.
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For Object Name Attribute Name

Custom attributes casemgmt::customer_data If the custom attributes added to the object has two words,

added to customer replace the space with underscore (). For example, if the attribute

data created is Family name, the attribute name will be
family_name.

Custom attributes casemgmt::contact_point_data If the custom attributes added to the object has two words,

added to contact replace the space with underscore (_). For example, if the attribute

point data created is Mobile number, the attribute name will be
mobile_number.

To add new fields:

1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig.js fileina
text editor and do the following:

a. Locate the LoginParameters property, and copy a section for one of the existing parameters and
paste it where you want to add the custom field. Edit the following properties.

paramName: Create a parameter name using the format L10N_Aame_PROMPT.
objectName: Provide the object name. See the table on page 254 for details about the object name
you need to provide.

attributeName: Provide the attribute name. See the table on page 254 for details about the
attribute name you need to provide.

primaryKey: Set the value as 0.

required: If you want to set the field as required set the value as 0. To make the field mandatory,
set the value 1.

minLength: Set the minimum required characters for the field. If a field is not required, set the
minimum length as 0.

maxLength: Set the maximum allowed characters for the field. The value should not be set more
than the value set while creating the custom attribute.

fieldType: Set the field type.

e For single line text fields, set the value as 1.

® For multi-line text fields, set the value as 2.

e For dropdown fields, set the value as 3.

e For multi-select dropdown list, set the value as 4.

validationString: Provide the expression against which the information provided by the
customer is to be checked. For example, for phone number you can give an expression like,
As*\(2\s*\d{33\s*\)?2\s*x[-.12\s*x\d{3}\s*x[-.1?\sx\d{4}\s*$. And, for email you
can use the expression like, AL0-9a-zA-Z\.\-\_J+\a[0-9a-zA-Z\.\-1+$ - this expression
refers to the format X@Y. Z (john@mycompany.com). For fields that require an integer value, you
need to atleast set the validation string as \\d+8$.

b. Save the changes.

2. Openthe Cisco_tome\eService\templates\ Zemplate Folder\properties\chat_locale.properties
file in a text editor and do the following:

a. Add the following line in the property file: L10N_~ane_PROMPT = " Digplay Mmefor the attribute"

Where: L10N_ANaue_PROMPT should match the value set in paramName in step 1 on page 255.
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b. Save the changes.

3. Clear the browser cache and access the chat link to test the changes. The login page should show the new
fields.

PURPLE nife  *

Name

Platinum -

Your Question

Custom login form

Enabling Anonymous Chats

Anonymous chats allow customers to chat with agents without providing any personal details, like name, email
address, phone number, and so on. When the customer clicks the chat link or button, he is not displayed the login

page.

To enable anonymous chats:

1. Open the Cisco_ttome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig. js fileina
text editor.

2. Locate the LoginParameters property and delete all the parameters between the square brackets. The
property will look like: LoginParameters : L[]

3. Save the changes.

4. Clear the browser cache and access the chat link to test the changes. The chat should start without showing
the login page.
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Enabling Auto-Login

When the chat link is provided in an authenticated section of the website, the auto-login feature can be used to
automatically login the customer for chat. When the customer clicks the chat link or button, he is not displayed
the login page.

@ Important: A template where auto-login is enabled should not be used for regular chats.

To enable auto-login for chats:

1.

Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig.js fileina
text editor.

Locate the autoLogin property and set the value to 1 to enable auto-login.
Save the changes.

Change the entry point code so that the customer information collected at the time of login on the website is
passed on to the ECE application when the customer initiates a chat session. For details, see Step 13 on
page 132.

Configuring Kiwi Templates for Customer SSO

Chat entry points can be configured to transfer customer context information from the company website to the
application through SAML. To learn more about Secure Chat for customers, see Enterprise Chat and Email
Administrator’s Guide.

To configure chat templates for customer single sign-on:

1.

On the web server, navigate to Cisco Home\web\templates\chat\ Temp%ate_Nam\ and open
eGainLiveConfig.js.

Enable autoLogin by setting the value of the autoLogin parameter to 1.

Configure the attributes that will be transferred to the application along with the chat creation request. You
can do this by configuring the LoginParameters property for each of the attribute as described in
“Configuring Login Page Parameters” on page 252.

If any of the attributes will be transferred to the application in the SAML assertion, specify the following
additional properties for the attribute in LoginParameters:

O eGainAttributeName: Name of the attribute in the SAML assertion.

O secureAttribute: Set the value to 1 to indicate that this attribute will be transferred in the SAML
assertion. For example:

eGainAttributeName : 'account_number',
secureAttribute : '1',

paramName : 'L10ON_NAME_PROMPT',
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objectName : 'casemgmt::individual_customer_data',
attributeName : 'full_name',

primaryKey : '0',

required : '1',

minLength = '1',

maxLength : '120°',

fieldType : '1',

validationString : ''

}

If secureAttribute is missing or is set to 0, the application does not look for and extract information for that
attribute from SAML assertion. Similarly, if secureAttribute is set to 1 for an attribute, but either
eGainAttributeName is not provided, or an attribute with the given name is missing from SAML assertion,
chat creation request will be denied.

Configuring Alternative Engagement Options

258

Out-of-the-box templates come with three alternative engagement options for the chat window. These options are
displayed to customers while they are waiting in queue (new chats or transferred chats) to be serviced by an
agent. Once an agent joins the chat, the options are removed from the chat window. You can display these
options as soon as the customer starts the chat, or after a delay. To enable these options for a queue, see
“Queues” on page 47.

» Give us acall

» Send us an email

» Visit our FAQ page
These options have placeholder links. You must update these links before using this feature. You can also:
» Update the text.

» Remove options.
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» Add new options.

Hi. | need help.

John - 8:36 AM

(® Your estimated wait time is 1 minute >

Sarry, all aur chat agents are currently busy.
Would you like to try one of these options instead?

. ?
Give us a Visit our
(1] FAQ page
B I U & 800 characters left

B m

Out-of-the-box options

To update links on the page:

1. Open the Cisco_ttome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig.js fileina
text editor.

2. In the file, search for altEngagementOptions and in this section set the following properties:

O Search for text: ’L10N_ALT_ENGMT_TEXT1' and for the URL parameter provide the link for the
callback page.

O Search for text: 'L10ON_ALT_ENGMT_TEXT2' and for the URL parameter provide the email address
which customers can use to send emails. Make sure you do not delete the mailto: text.

O Search for text: 'L1ON_ALT_ENGMT_TEXT3' and for the URL parameter provide the link to the FAQ

page on your website.

3. Clear the browser cache and access the chat link to test the changes.

To update the text on the page:

1. Open the

Cisco_HomeNeServi ce\templates\chat\TW&_F()W\properties\chat_Locale.propert'ies
file in a text editor and do the following:

O Locate the L1ON_ALT_ENGMT_MESSAGE property and change the value of this property to the new
message you want to display for the alternative engagement options.

o Similarly, locate the L1ON_ALT_ENGMT_TEXT1, L1ON_ALT_ENGMT_TEXT2, and
L10ON_ALT_ENGMT_TEXT3 properties and update the text for each of the options, that is, Give us a call,
Send us an email, and Visit our FAQ page.
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2. Save the changes.

3. Clear the browser cache and access the chat link to test the changes.

PURPLE nile  *

) AR L B
Hi. | need help.

John - 2:17 A

(® Your estimated wait time is 1 minute -

Sorry, all our chat agents are currently busy.
Would you like to try one of these options instead?

[ —]

Send us an
emalil

B I U @& 800 characters left

Customized text and options

To update the background colors and buttons for the options:

1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig.js fileina
text editor.

2. In the file search for altEngagementOptions and in this section locate the option for which you want to
change the background color and images. Change the following properties:

O Search for bgcolor and set the new background color for the section.
O  Search for image and provide the name of the new image.

O Search for hoverImage and provide the name of the new hover image for the button.

3. Place the new images at the following location:
Cisco_tome\eService\templates\chat\ 7emplate Folder\chat\img

4. Clear the browser cache and access the chat link to test the changes.

To remove an option:

1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig.js fileina
text editor.

2. In the file search for altEngagementOptions and from this section delete the code lines for the help
option you do not want to display. For example, to remove the Send us an Email option, delete the
following lines of code:

{
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text:'L10ON_ALT_ENGMT_TEXT2',
image:'chat/img/icon_email.png',
hoverImage:'chat/img/mail_hover.png',
bgcolor:'#f27935"',
url:'mailto:supportacompany.com'

Y,

3. Clear the browser cache and access the chat link to test the changes.

To add new options:

1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig.js fileina
text editor.

2. In the file locate the altEngagementOptions property, and copy a section for one of the existing help
options and paste it where you want the new section. Edit the following properties.

O text: Create a new parameter using the name as LION_ALT_ENGMT_Name
O image: Set the value as ’chat/c’mﬁ/écomfemax;épnﬁ;

O hoverImage: Set the value as W/W/thom[wzﬁ;

O bgcolor: Set the value as ’#727935;

O url: Provide the URL for the option.

3. Place the images to be used for the new section at the following location:
Cisco_Home\eService\templates\chat\ TWteﬁFolder\chat\img

4. Open the
Cisco_tome\eService\templates\chat\ 7emplate Folder\properties\chat_locale.properties
file in a text editor and do the following:

a. Add the following line in the property file: L1ON_ALT_ENGMT_AName=" Text for the section' Where
L10ON_ALT_ENGMT_Aame should match the value set in text in step 2.

b. Save the changes.

5. Clear the browser cache and access the chat link to test the changes.

Configuring Off-the-Record Options

When data masking is enabled, masking rules prevent agents and customers from sending sensitive information
like credit card numbers, social security numbers, and so on, during the chat session. The Off-the-record feature
allows agents and customers to exchange sensitive information as data masking rules do not apply to these
messages. Any information exchanged while off-record is not stored in the ECE system. Off-the-record
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conversation can be started and stopped only by customers. This feature is enabled while configuring data
masking for the chat channel. For details, see Cisco Enterprise Chat and Email Administrator’s Guide.

Hi. | need help.

John - 8:36 AM

‘ou are now chatting with ariel

HiJohn. How can | help you?

ariel - 8:38 AM

I'm looking for the perfect gift.
John - 2:38 AN

Your messages are now ofirecord and will nat be saved in the system

B I U @& 800 characters left

Ciseo m

Off the record messages

To change the text for various options:

1. Open the
Cisco_tome\eService\templates\chat\ 7emplate Folder\properties\chat_locale.properties
file in a text editor.

2. To change the text that appears when a customer goes on-record and off-record, locate the following
properties and change the values:

O LT1ON_OFF_RECORD_MESSAGE: The default value is Your messages are now off-record and

will not be saved in the system.

O LT1ON_ON_RECORD_MESSAGE: The default value is Your messages are now on record.

3. To change the text that appears when data is masked, change the value of the following property:

O LT1ON_SENSITIVE_DATA_MASKED: The default value is Don't worry. Your sensitive data

has been masked.

4. To change the text that appears in the chat transcript when messages have been removed due to masking,

change the value of the following property:

O L10ON_OFF_RECORD_MESSAGE_REMOVED: The default value is Message has been removed.

5. Save the changes.
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6. Clear the browser cache and access the chat link to test the changes.

PURPLE nife  *

You are now chatting with ariel

Hi John. How can | help you, today?

ariel - 2:20 A

I'm looking for the perfect gift

John- 821 AM

B I U @@ 800 characters left

Customized messages

Setting Maximum Length for Chat Messages

To set the maximum length for chat messages:

1.

Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig.js fileina
text editor.

Locate the maxMessageSize property and change the value of the property to the number of characters you
want to allow for each chat message. By default the value is set to 800. This setting is also used to control
the message length in the Additional Comments field in the survey form. The maximum value can be set to
2000.

Save the changes.

Clear the browser cache and access the chat link to test the changes.
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Disabling Rich Text Editor

By default the chat typing area of the Chat Customer Console has a rich text editor. You can enable the plain text
editor, if you do not want customers to use the rich text editor.

LJ7 Live Chat

by Cisco

Hi. | need help.

John - 8:09 AM

G) Your estimated wait time is 1 minute

B I U & 800 characters left

Ciseo m

Out-of-the-box rich text editor toolbar

To disable the rich text editor:

1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig.js fileina
text editor.

2. Locate the useTextEd1itor property and set the value to 1 to enable the plain text editor. The default value
is 0, which means that the rich text editor is enabled.

3. Save the changes.
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4. Clear the browser cache and access the chat link to test the changes.

PURPLE nile  x

w4 AA L =
Hi. | need help.
John- E:17 AM
You are now chatting with ariel

HiJohn. How can | help you, today?

aried - 3:20 Al

I'm looking for the perfect gift

John - 8:21 Al

Disable the rich text editor
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Hiding Emoticons

The chat typing area toolbar of the customer console has a Smiley button that can be used to add emoticons in
the chat messages. You can hide the button if you do not want customers to use it.

775 Live Chat

by Cisco

Hi. | need help.

John - 2:05 AM

G) Your estimated wait time is 1 minute

B I U e 800 characters left

Cisco m

The Emoticons button

To hide emoticons:

1. Open the Cisco_ttome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig. js fileina
text editor.

2. Locate the showSmileyTool property and change the value of the property to false to hide the
emoticons.

3. Save the changes.
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4. Clear the browser cache and access the chat link to test the changes.

PURPLE nile  x
= ¢ AlA & B8
Hi. | need help.
John - 17 AM

You are now chatting with sriel

Hi John. How can | help you, today?

ariel - 8:20 A

I'm looking for the perfect gift

John- 8:21 &

B I U 800 characters left

Hide the Emoticons button

Changing Agent and Customer Images

The Chat Customer Console contains a static agent and customer image, which is displayed next to each chat

message in the chat area. You can replace the out-of-the-box images with

custom images.
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Before you begin, get the new images that you want to use. The height of the new images should be 28 pixels
and the width should be 26 pixels.

Hi. | need help. Q

John - 2:36 AM

*fou are now chatting with srie!

O Hi John. How can | help you?

ariel - 8:38 AM

I'm looking far the perfect gift.

I U @ 800 characters left

Cisco m

Out-of-the-box customer and agent images

To change the customer image:

1.

S

Place the new image in the Cisco_ Home\eServiceltemplates)\ Tmplate_Fo[dar\ chat\img folder.

Open the Co':co_Hom\eSer'V'ice\templates\Twrflate_Folder\chat\less\chat—ma‘in. less file in a
text editor.

Locate the &.customer class and in it locate the .author > &.typing class.
Change the value of the background-image property.
Save the changes.

Clear the browser cache and access the chat link to test the changes.

To change the agent image:

1.
2.

Place the new image in the Cisco_tome\eService\templates\chat\ 7emplate Folder\chat\img folder.

Open the Cisco_tome\eService\templates\ Template Folder\chat\less\chat-main.less fileina
text editor.

Locate the .eg-chat-message, .eg-chat-temporary-message class and in the .author and
&.typing classes change the value of the background-image property.

Save the changes.

Clear the browser cache and access the chat link to test the changes.

Enterprise Chat and Email Administrator’s Guide to Chat and Email Resources



Changing Chat Bubble Colors

Five different bubble colors are used to identify the messages sent by the customer and all agents in the chat
session. You can change the color of all these bubbles.

Hi. | need help.

You are now chatling with arie

HiJohn. How can | help you?

I'm looking for the perfect gift.

I U @ 800 characters left

Cisco m

Out-of-the-box bubble colors

To change the chat message bubble colors:

1.

Open the akco_Hom\eService\templates\chat\TW&_Fo[der\chat\Less\chat-main. less
file in a text editor.

To change the chat message bubble color for customers: Locate the &. customer class and in the .bubble
class change the value of the background property. Also, in the .arrow-wrap class change the value of
the border-Lleft property.

To change the chat message bubble color for the first agent: Locate the .eg-chat-message class and in
the .bubble class change the value of the background property. Next, locate the .eg-chat-message,
.eg-chat-temporary-message class and in the .arrow class change the value of the border-right
property.

To change the chat message bubble color for all other agents who can join the chat as supervisors: Locate
the &.agent1, &.agent2, and &.agent3 classes and in the .bubble class change the value of the
background property. In the .arrow class change the value of the border-right property.

Save the changes.
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6. Clear the browser cache and access the chat link to test the changes.

PURPLE nile  *

L AN L B

Hi. | need help.

John- Z:17 AM

¥ou sre now chatting with ariel

HiJohn. How can | help you, today?

aried - 3:20 Al

I'm looking for the perfect gift

John - 8:21 Al

B I U & 800 characters left

Customized bubble colors

Changing Sound Alert

A sound alert is played on the customer side when a new chat message comes. You can change this sound alert.

To change the sound alert:

1. Open the Cisco_ttome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig.js fileina
text editor.

2. Locate the chatsoundURL property and change the value of the property to the path of the new chat sound
file. Only .wav files are supported.

3. Save the changes.

4. Clear the browser cache and access the chat link to test the changes.
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Configuring Widgets

Widgets with useful information such as, frequently asked questions, can be added to the login page and to the
chat page.

To configure widgets:

1. Open the
Cisco_tome\eService\templates\chat\ 7emplate Folde\properties\chat_locale.properties
file in a text editor.

2. Configure the following settings:

O CONFIG_LOGIN_FORM_WIDGET_URL: Provide the URL of the widget you want to display on the login
page for chat.

O CONFIG_DIALOGUE_WIDGET_URL: Provide the URL of the widget you want to display during the chat
session.

3. Save the file.

4. Clear the browser cache and access the chat link to test the changes.
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Configuring Survey Questions

At the end of the chat session a survey form is presented to customers to measure the usefulness of the chat. The
survey form has three questions and a text box for providing additional comments. You can change the text of
these questions, however, you cannot add or remove questions from the survey form.

You can turn off the survey, if you do not wish to use it. For details, see “Turning Off Surveys” on page 273.

L7 Live Chat

by Cisco

I:l Save Transcript ﬁ Print Transcript

Help us improve your chat experience by taking a small
survey,

How would you rate the quality of the answers you
received?

what about the speed with which we answered your
guestions?

How would you rate your overall chat experience?

Additional Comments:

Cisco m

Out-of-the-box chat survey form

To change the text of survey questions:

1. Open the
Cisco_Home\eServi ce\templates\chat\Tmtf{ata_Fo[der\propert'ies\chat_Locale.proper‘t'ies
file in a text editor.

2. Locate the section for survey questions by searching for L10N_SURVEY_INTRO. In this section change the
following properties:
O L10N_SURVEY_INTRO: Change the text for presenting the survey form.

O L10N_SURVEY_Q1, L1TON_SURVEY_Q2, and L10ON_SURVEY_Q3: Change the text of the survey
questions.

O L10N_POOR,L10N_FAIR,L10N_GOOD, L1ON_VERY_GOOD, L10N_EXCELLENT: Change the text of the
tool tip for the stars shown on the survey form.

O L10ON_SURVEY_ADDITIONAL: Change the title of the text box.

O L10ON_SURVEY_VALIDATION_ERROR: Provide the message to be displayed when the text in the
comments box exceeds the allowed size.

O L10ON_THANKS: Change the message displayed to users after they have completed the survey.
O L10N_SUBMIT: Change the text of the button used for submitting the survey.
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Save the changes.

3. Clear the browser cache and access the chat link to test the survey form changes.

PURPLE nile  ~

Help us improve your chat experience by taking a small
survey,

ould you rate the quality of the answers you

what about the speed with which we answered your

guestions?

How would you rate your overall chat experience?

Additional Comments:

Customized chat survey form

Turning Off Surveys

You can turn off the survey if you do not wish to display a survey form at the end of chat sessions.

To turn off surveys:

1. Open the Cisco_tome\eService\templates\chat\ 7emplate Folder\eGainLiveConfig.js fileina
text editor.

2. In the file locate the turn0ffChatSurveyPage property and change its value to true. Save the changes.

3. Open the
Czkco_Home\eSer'vice\templates\chat\TempWa_Folder\pr‘oper‘t‘ies\chat_Lomle.pr‘oper‘t‘ies
file in a text editor.

4. In the file locate the L10N_THANKS_WITHOUT_SURVEY property and change the text to be displayed to
customers when they end the chat session. The default value is Thank you for chatting with us.

Save the changes.

5. Clear the browser cache and access the chat link to test the changes.
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Changing the Off Hours Message

An off hours message can be displayed to customers when agents are not available for handling chats.

L27 Live Chat

by Cisco

Thank you for your inquiry. Our service hours are 9am-
5pm PST, Monday-Friday.

If you are trying within the service hours and still getting
this message, please try again after some time.

Off hours message

To change the off hours message:

1. Open the

Cisco_tome\eService\templates\chat\ 7emplate Folder\properties\chat_locale.properties
file in a text editor.

2. Locate the property L10N_OFF_HOURS and change the message to be displayed during off hours.

3. Save the changes.
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4. Clear the browser cache and access the chat link to test the changes.

PURPLE nile  *

Thank you for your inquiry. Our service hours are Sam-
5pm PST, Monday-Friday.

If you are trying within the service hours and still getting
this message, please try again after some time.

Custom message

Changing Chat Transcript Options

During a chat session and at the end of a chat session, customers have access to the Print Transcript and Save
Transcript buttons. Customers can use these buttons to print or save the chat transcript for future reference.

You can change the tool tips for these buttons and you can add a header, footer, and title for the transcript
window. You cannot remove these buttons from the chat window.

To change the chat transcript options:

1. Open the

Cisco_tome\eService\templates\chat\ 7emplate Folder\properties\chat_locale.properties
file in a text editor.

2. Edit the values for the following properties:
O L1ON_SAVE_TRANSCRIPT_BUTTON: Change the tool tip of the Save Transcript button.
O LTON_PRINT_TRANSCRIPT_BUTTON: Change the tool tip of the Print Transcript button.
O L1ON_TRANSCRIPT_TITLE: Provide a title for the transcript page.
O TRANSCRIPT_HEADER_LIVE_CHAT: Provide the header for the transcript page.
O  L10ON_CUSTOMER: Do not change the value of this property.
O  L10N_AGENT: Do not change the value of this property.

3. Open the

Cisco_tome\eService\templates\chat\ 7emplate Folder\properties\messaging_locale.propert
ies file in a text editor.

4. Edit the value for the following property:
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O MAIL_HEADER_LIVE_CHAT: Change the header of the transcript emailed by the system.
5. Save the changes.

6. Clear the browser cache and access the chat link to test the changes.

Deleting Template Sets

@ Important: You must delete the templates files from all web servers in your installation.

To delete a template set:
1.  On the web server, browse to Cisco_tome\eService\templates\chat.

2. Delete the template folder that you do not want to use. If you are using these templates for any entry point,
make sure to update the HTML code on web pages with the new template sets you want to use.
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